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All Rights Reserved
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without written permission of BioTek Instruments, Inc.

Restrictions and Liabilities

Information in this document is subject to change and does not represent a commitment by
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Document Conventions

This icon identifies information that protects the safety of the
operator and the integrity of data.

Warning! AWarning indicates the potential for bodily harm and tells you how to
avoid the problem.

Caution A Caution indicates the potential for damage to the instrument and
tells you how to avoid the problem.

Note: Bold text is primarily used for emphasis.

This icon calls attention to important information.

This style calls attention to usage instructions and helpful facts. For example, "Refer to
Figure 2-3 when performing these steps" and "Part numbers are subject to change."

Topics that apply only to specific reader models are presented in this style. For
example, "Applies only to models equipped with injectors."

Intended Use Statement

Synergy H1 is an automated plate reader for measuring absorbance, fluorescence,
luminescence of liquid samples in microplates.

User Evaluation

The performance characteristics of the data reduction software have not been established with
any laboratory diagnostic assay. The user must evaluate this instrument and PC-based
software in conjunction with their specific assay(s). This evaluation must include the
confirmation that performance characteristics for the specific assay(s) are met.

BioTek Instruments, Inc.
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Quality Control

It is considered good laboratory practice to run laboratory samples according to instruc-
tions and specific recommendations included in the assay package insert for the test to be
conducted. Failure to conduct Quality Control checks could result in erroneous test data.

Repackaging and Shipping

If you need to ship the instrument to BioTek for service or repair, contact
Technical Support, and be sure to use the original packing materials.
Other forms of commercially available packaging are not recommended
and can void the warranty. If the original packing materials have been
damaged or lost, contact Technical Support for replacement packing.
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Warnings

Operate the instrument on a level, stable surface away from excessive
humidity.

Bright sunlight or strong incandescent light can reduce the linear performance
range of the instrument.

Measurement values may be affected by extraneous particles (such as dust) in
the microplate wells. A clean work area is necessary to ensure accurate
readings.

When operated in a safe environment according to the instructions in this
document, there are no known hazards associated with the instrument.
However, the operator should be aware of certain situations that could result
in serious injury; these vary depending on the instrument type. See Hazards
and Precautions.

Hazards

The following hazard warnings are provided to help avoid injury:

Warning! Power Rating. The instrument’s power supply or power cord
must be connected to a power receptacle that provides voltage and current
within the specified rating for the system. Use of an incompatible power
receptacle may produce electrical shock and fire hazards.

Warning! Electrical Grounding. Never use a plug adapter to connect
primary power to the external power supply. Use of an adapter disconnects
the utility ground, creating a severe shock hazard. Always connect the power
cord directly to an appropriate receptacle with a functional ground.

Warning! Service. Only qualified technical personnel should perform
service procedures on internal components.

Warning! Accessories. Only accessories that meet the manufacturer’s
specifications shall be used with the instrument.

Warning! The instrument with all available modules weighs up to 55 pounds
(24.95 kg). Use two people when lifting and carrying the instrument.

BioTek Instruments, Inc.
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Warning! Liquids. Avoid spilling liquids on the instrument; fluid seepage
into internal components creates a potential for shock hazard or instrument
damage. If a spill occurs while a program is running, abort the program and
turn the instrument off. Wipe up all spills immediately. Do not operate the
instrument if internal components have been exposed to fluid; contact
BioTek TAC.

Warning! Unspecified Use. Failure to operate the equipment according to
the guidelines and safeguards specified in this manual could result in a
hazardous condition.

Warning! Software Quality Control. The operator must follow the
manufacturer’s assay package insert when modifying software parameters
and establishing reading or dispensing methods. Failure to conduct
quality control checks could result in erroneous test data.

Warning! Reader Data Reduction Protocol. No limits are applied to the
raw measurement data. All information exported via computer control must
be thoroughly analyzed by the operator.

Warning! Internal Voltage. Always turn off the power switch and unplug
the power supply before cleaning the outer surface of the instrument.

Warning! Hot Surface. H1M2 models: The microplate carrier is hot when
the incubator is turned on and for a period of time after the incubator is
turned off. Do not touch the carrier or the inside surface of the door.

Warning! Potential Biohazards. Some assays or specimens may pose a
biohazard. This hazard is noted by the symbol shown here. Adequate safety
precautions should be taken as outlined in the assay’s package insert.
Always wear safety glasses and appropriate protective equipment, such as
chemically resistant rubber gloves and apron.

Warning! Pinch Hazard. Some areas of the dispense module can present
pinch hazards when the instrument is operating. The module is marked with
the symbol shown here. Keep hands and fingers clear of these areas when
the instrument is operating.

Precautions

The following precautions are provided to help avoid damage to the instrument.

Caution: Service. The instrument should be serviced by BioTek-authorized
personnel. Only qualified technical personnel should perform troubleshooting
and service procedures on internal components.

Synergy H1 Operator's Manual
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Caution: Spare Parts. Only approved spare parts should be used for
maintenance. The use of unapproved spare parts and accessories may result
in a loss of warranty and potentially impair instrument performance or cause
damage to the instrument.

Caution: Environmental Conditions. Do not expose the instrument to
temperature extremes. For proper operation, temperatures near the
instrument should remain within the range listed in the Specifications
chapter. Performance may be adversely affected if temperatures fluctuate
above or below this range.

Caution: Sodium Hypochlorite. Do not expose any part of the instrument
to the recommended diluted sodium hypochlorite solution (bleach) for more
than 20 minutes. Prolonged contact may damage the instrument surfaces. Be
certain to rinse and thoroughly wipe all surfaces.

Caution: Power Supply. Use only the power supply shipped with the
instrument, and operate it within the range of line voltages listed on it.

Caution: Disposal. Dispose of the instrument according to Directive
2012/19/EU, “on waste electrical and electronic equipment (WEEE),” or local
ordinances.

Caution: Warranty. Failure to follow maintenance procedures may void the
warranty.

Caution: Shipping Hardware. All shipping hardware (e.g., carrier shipping
screw, filter reader shipping bracket) must be removed before operating the
instrument and reinstalled before repackaging the instrument for shipment.

Caution: Electromagnetic Environment. Per EN 61326-2-6 it is the user’s
responsibility to ensure that a compatible electromagnetic environment for
this instrument is provided and maintained in order that the device will
perform as intended.

Caution: Electromagnetic Compatibility. Do not use this device in close
proximity to sources of strong electromagnetic radiation (e.g., unshielded
intentional RF sources), because these may interfere with the proper
operation.

BioTek Instruments, Inc.
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CE Mark

Based on the testing described below and information
contained herein, this instrument bears the CE mark.

See the Declaration of Conformity for more specific information.

Directive 2014/30/EU: Electromagnetic Compatibility

Emissions—Class A

The system has been type-tested by an independent, accredited testing laboratory and
found to meet the requirements of EN 61326-1: Class A for Radiated Emissions and Line
Conducted Emissions.

Verification of compliance was conducted to the limits and methods of EN 55011 –
(CISPR 11) Class A. In a domestic environment it may cause radio interference, in which
case, you may need to take measures to mitigate the interference.

Immunity

The system has been type-tested by an independent, accredited testing laboratory and
found to meet the requirements of EN 61326-1 and EN 61326-2-6 for Immunity.
Verification of compliance was conducted to the limits and methods of the following:

EN 61000-4-2, Electrostatic Discharge
EN 61000-4-3, Radiated EM Fields
EN 61000-4-4, Electrical Fast Transient/Burst
EN 61000-4-5, Surge Immunity
EN 61000-4-6, Conducted Disturbances from RFI
EN 61000-4-11, Voltage Dips, Short Interruptions and Variations

Directive 2014/35/EU Low Voltage (Safety)

The system has been type-tested by an independent testing laboratory and was found to
meet the requirements of this Directive. Verification of compliance was conducted to the
limits and methods of the following:

EN 61010-1, “Safety requirement for electrical equipment for measurement, control and
laboratory use. Part 1, General requirements.”

EN 61010-2-010, “Particular requirements for laboratory equipment for the heating of
materials.”
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2011/65/EU (with exemptions) and (EU) 2015/863 – RoHS
Directives

IEC 08000, “Hazardous substance process management.”

Directive 2012/19/EU: Waste Electrical and Electronic Equipment

Disposal Notice: Dispose of the instrument according to the Directive, “on waste
electrical and electronic equipment (WEEE)” or local ordinances.

Directive 98/79/EC: In Vitro Diagnostics (if labeled for this use)

Product registration with competent authorities.

Traceability to the U.S. National Institute of Standards and Technology (NIST).

EN 61010-2-101, “Particular requirements for in vitro diagnostic (IVD) medical
equipment.”

Electromagnetic Interference and Susceptibility

USA FCC CLASS A

RADIO AND TELEVISION INTERFERENCE

NOTE: This equipment has been tested and found to comply with the limits for a Class A
digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide
reasonable protection against harmful interference when the equipment is operated in a
commercial environment. This equipment generates, uses, and can radiate radio
frequency energy and, if not installed and used in accordance with the instruction
manual, may cause harmful interference to radio communications. Operation of this
equipment in a residential area is likely to cause harmful interference, in which case the
user will be required to correct the interference at their own expense.

In order to maintain compliance with FCC regulations shielded cables must be used with
this equipment. Operation with non-approved equipment or unshielded cables is likely to
result in interference to radio and television reception.

Canadian Department of Communications Class A

This digital apparatus does not exceed Class A limits for radio emissions from digital
apparatus set out in the Radio Interference Regulations of the Canadian Department of
Communications.

BioTek Instruments, Inc.

xx | Preface



Le present appareil numerique n'émet pas de bruits radioélectriques depassant les
limites applicables aux appareils numérique de la Class A prescrites dans le Réglement
sur le brouillage radioélectrique édicté par le ministère des Communications du Canada.

User Safety

This device has been type-tested by an independent laboratory and found to meet the
requirements of the following:

l Underwriters Laboratories UL 61010-1, “Safety requirements for electrical equipment
for measurement, control and laboratory use; Part 1: General requirements.”

l Canadian Standards Association CAN/CSA C22.2 No. 61010-1, “Safety requirements
for electrical equipment for measurement, control and laboratory use; Part 1:
General requirements.”

l EN 61010 Standards, see CE Mark starting on page xix.
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Symbols

Direct current

Courant continu

Gleichstrom

Corriente continua

Corrente continua

Caution (refer to accompanying
documents)

Attention (voir documents
d’accompagnement)

Achtung siehe Begleitpapiere

Atención (vease los documentos
incluidos)

Attenzione, consultare la doc
annessa

Warning, hot surface

Attention, surface chaude

Warnen, heiße Oberfläche

Precaución, superficie
caliente

Attenzione, superficie calda

Warning, risk of crushing or pinching

Attention, risque d’écrasement et
pincement

Warnen, Gefahr des Zerquetschens
und Klemmen

Precaución, riesgo del
machacamiento y sejeción

Attenzione, rischio di schiacciare ed
intrappolarsi

In vitro diagnostic medical
device

Dispositif médical de
diagnostic in vitro

Medizinisches In-Vitro-
Diagnostikum

Dispositivo médico de
diagnóstico in vitro

Dispositivo medico
diagnostico in vitro

Warning, potential biohazards

Attention, risques biologiques
potentiels

Warnung! Moegliche biologische
Giftstoffe

Atención, riesgos biológicos

Attenzione, rischio biologico
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Consult instructions for use

Consulter la notice d’emploi

Gebrauchsanweisung
beachten

Consultar las instrucciones
de uso

Consultare le istruzioni per
uso

Separate collection for electrical and
electronic equipment

Les équipements électriques et
électroniques font l’objet d’une
collecte sélective

Getrennte Sammlung von Elektro-
und Elektronikgeräten

Recogida selectiva de aparatos
eléctricos y electrónicos

Raccolta separata delle
apparecchiature elettriche ed
elettroniche
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Chapter 1

Introduction
This chapter introduces the Synergy H1 Multi-Mode Reader, describes its
key features, lists its package contents, and provides contact
information for technical assistance.

Product Description 2
Package Contents & Accessories 4
Optional Accessories 5

Materials for Conducting Liquid Tests 6
Technical Support 7

Technical Assistance Center (TAC) 7



Product Description

The Synergy H1 is a hybrid multi-mode microplate reader. Depending on the model,
detection modes include fluorescence intensity (FI), fluorescence polarization (FP), time-
resolved fluorescence (TRF), luminescence, and UV-visible absorbance. The instrument is
modular, and upgrade options are available; contact BioTek Customer Care for more
information.

The monochromator-based system comes in two varieties, fixed bandpass (M models) and
variable bandpass (M2 models) for monochromator-based fluorescence measurements. To
access the variable bandpass feature, the instrument must be connected to the PC running
the Gen5 application and the reader must be turned on.

The reader is computer-controlled using Gen5 software for all operations, including data
reduction and analysis. The Synergy H1 is robot accessible and compatible with the
BioStack Microplate Stacker. Gen5 supports OLE automation to facilitate integration into an
automated system.

The Synergy H1 can perform reads using a filter cube or a monochromator*. The filter-
based system can perform fluorescence and luminescence reads. Filter fluorescence uses a
xenon flash light source, along with interference filters and dichroic mirrors for wavelength
specificity and a photomultiplier tube (PMT) detector. To run a fluorescence polarization
protocol, the filter cube must contain polarizing filters. Luminescence is measured through
an empty filter position in the filter cube; filters can be used if light filtering is necessary.

The monochromator-based system, which has both top and bottom probes, is used for
absorbance, fluorescence, and luminescence. Absorbance measurements are made using
the reader’s monochromator optics. The xenon lamp allows for both UV and visible light
measurements. The monochromator provides wavelength selection from 230–999 nm in 1-
nm increments. Available read methods are endpoint, area scan, spectral scanning, and
pathlength correction. For luminescence reads, the Synergy H1 has a direct-to-PMT
channel (no filtering, white light only). You can also use the monochromator optics for
luminescence spectral scanning.

The Synergy H1 has top and bottom incubation from 4°C over ambient to 45°C (70°C for
H1M2 models), controlled via a software-adjustable gradient. Internal plate shaking, with
both linear and orbital modes, is supported to ensure that reagents are thoroughly mixed
prior to reading. The Synergy H1 supports the reading of 6-, 12-, 24-, 48-, 96-, and 384-
well microplates with 128 x 86 mm geometry as well as the Take3 and Take3 Trio Micro-
Volume Plate.

i Use of microplates other than those listed here can result in positioning errors during
program execution.

Models with injectors support dual-reagent dispensing to 6-, 12-, 24-, 48-, 96-, and 384-
well microplates. An external dispense module pumps fluid from the supply bottles to the
two injectors located inside the instrument. Models that support the gas controller can
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control the CO2 or O2 concentrations in the reading chamber for CO2- or O2-sensitive
assays.

* This dual light path capability in the H1 MF model is protected by U.S. patent number
8,218,141.

Synergy H1 Operator's Manual
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Package Contents & Accessories

Package contents and part numbers are subject to change.

Item Part #

Synergy H1 Operator's Manual (on USB flash drive) 8041000

Power supply 02395 (150W 24VDC)

02285 (250W 24VDC_

Power cord set (specific to installation environment):

Europe (Schuko)

USA/International

United Kingdom

Australia/New Zealand

75010

75011

75012

75013

USB cable 75108

Models with injectors, an external dispense module
with the following accessories:

Injector assembly

Inlet tubes (2) from supply bottles to syringe drives

250-µL syringes (2)

Syringe thumbscrews (2)

Priming plate

Injector tip priming trough

Dispense module communication cable

Dispense module front cover

Dispense module box

Supply bottles (2, 30 mL)

Supply bottle holders (2)

Straps to secure bottles in the holders (6)

Injector tip cleaning stylus and storage bag

8040541

7082121

7083000

19511

8042202

8042068

75107

8042197

8040534

7122609

8042193

7212035

2872304

Models with the gas controller ("G") module (packaged separately),
one of the following:

Gas controller unit, CO2/O2 control, and shipping accessories

Gas controller unit, CO2 control, and shipping accessories

1210500, 1210010

1210504, 1210009
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Optional Accessories

Availability and part numbers are subject to change.

Item Part #

Absorbance Test Plate (400-800 nm) 7260522

Absorbance Test Plate (340 nm)* 7260551

Luminometer Reference Microplate (includes microplate
carrier adapter PN 8042263 for Synergy H1)

8030015

Fluorescence Test Plate** 1400501

Take3 Micro-Volume Plate TAKE3

Take3 Trio Micro-Volume Plate TAKE3TRIO

PCR Tube Adapter Plates 6002072, 6002076

BioCell Adapter Plate 7270512

BioCell Quartz Vessel 7272051

Gas-ready upgrade kit contact BioTek Sales

Synergy H1 Product Qualification and Maintenance
(IQ/OQ/PQ) package

8040528

Additional bandpass filters, empty filter cubes, plugs, retainer clips, and mirrors are
available for purchase.

The Synergy H1 is compatible with the BioStack Microplate Stacker. The BioStack
rapidly and systematically transfers a stack of microplates to and from the instrument’s
microplate carrier.

* The diagnostics feature in Gen5 versions 2.08 and higher is compatible with the 340 nm
Absorbance Test Plate PN 7260551. If you are using an earlier Gen5 version, the test
plate's instruction sheet explains how to manually conduct the tests and analyze results.

** Requires Gen5 version 2.06 or higher.
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Materials for Conducting Liquid Tests

Manufacturer part numbers are subject to change.

Item Part Number

Absorbance Liquid Tests

BioTek Wetting Agent Solution PN 7773002

BioTek QC Check Solution #1 (25 mL) PN 7120779

BioTek QC Check Solution #1 (125 mL) PN 7120782

Phosphate-Buffered Saline (PBS) tablets, pH 7.2-7.6 Sigma #P4417

β-NADH Powder (β-Nicotinamide Adenine Dinucleotide,
reduced form)

PN 98233 or
Sigma #N6785-10VL

Fluorescence Liquid Tests

Test Kits

Kit with microplates and test solutions for conducting
Corners/Sensitivity/Linearity (FI) tests using Sodium
Fluorescein and Methylumbelliferone, and Time-
Resolved Fluorescence (TRF) tests using Europium

PN 7160010 (contains
7160013, 7160012, and
7160011 described below)

Kit for FI tests using Sodium Fluorescein PN 7160013

Kit for FI tests using Methylumbelliferone PN 7160012

Kit for TRF tests using Europium PN 7160011

Kit for Fluorescence Polarization (FP) test PN 7160014 or Invitrogen
#P3088

Individual Materials

Sodium Fluorescein Powder, 1-mg vial PN 98155

Methylumbelliferone, 10-mg vial PN 98156

Carbonate-Bicarbonate Buffer (CBB) capsules Sigma #3041

Phosphate-Buffered Saline (PBS) tablets, pH 7.2-7.6 Sigma #P4417

Sodium Borate, pH 9.18 Fisher Scientific #159532,
or equivalent

Injection System Tests

Green Test Dye PN 7773003
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Technical Support

See Contact Information on page x.

Technical Assistance Center (TAC)

Please be ready with the following information:

l Your name and company, email address, daytime phone or fax number

l The product name, model, and serial number

l The onboard software part number and basecode version (available through Gen5 by
selecting System > Instrument Control > Information)

l Gen5 software version information (Help > About Gen5)

l For troubleshooting assistance or instruments needing repair, the specific steps that
led to the problem and any error codes that were reported (see also Error Codes
starting on page 153)

Before shipping an instrument for service or repair, contact Technical Support.
Package the instrument according to the instructions in Repackaging and
Shipping Instructions starting on page 24.
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Chapter 2

Installation
This chapter includes instructions for unpacking and setting up the
Synergy H1 and, as applicable, the gas controller and external dispense
module. Instructions are also included for preparing the reader and
dispense module for shipment.

Important Information 9
1: Unpack and Inspect the Synergy H1 11
2: Select an Appropriate Location 11
3: Remove the Shipping Hardware 12
4: Install the Power Supply 13
5: Install the Gas Controller 13
6: Unpack and Inspect the Dispense Module 14
7: Install the Dispense Module 15
8: Connect the Host Computer 18
9: Install Gen5 Software 19
10: Turn on the Reader 19
11: Establish Communication 19
12: Verify/Set Dispenser Calibration Values 20
13: Run a System Test 21
14: Test the Injection System 22
Operational/Performance Qualification 23
Repackaging and Shipping Instructions 24

Important Information

This chapter contains installation and setup tasks for a Synergy H1 model
equipped with all of the available modules. Your model may be different;
for example, it may not have injection capability. Perform the tasks in the
order presented, skipping those that do not apply to your reader’s
configuration.

Materials: You will need a Phillips screwdriver (supplied with the
instrument) to perform some of the steps in this chapter.



Remove the shipping hardware before turning on the instrument.

Reinstall the shipping hardware before repackaging the instrument for
shipment.
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1: Unpack and Inspect the Synergy H1

The Synergy H1 with all available modules weighs up to 55 pounds
(24.95 kg). Use two people when lifting and carrying the instrument.

Save all packaging materials. If you need to ship the reader for repair or
replacement, you must use the original materials. Using other forms of
commercially available packaging, or failing to follow the repackaging
instructions, may void the warranty. Improper packaging the results in
damage to the reader may lead to additional charges.

During the unpacking process, inspect the packaging, reader, and
accessories for shipping damage. If the reader is damaged, notify the
carrier and your BioTek representative. Keep the shipping boxes and the
packaging materials for the carrier’s inspection.

1. Open the shipping box. Remove the instrument and place it on a level, stable surface.

2. Place the packaging materials back into the shipping box for reuse if the instrument
needs to be shipped again.

2: Select an Appropriate Location

Install the reader on a level, stable surface in an area where temperatures between 18°C
(64°F) and 40°C (104°F) can be maintained. Leave at least six inches of space between the
instrument’s rear panel and any other object. This space ensures proper air flow in and out
of the instrument.

The reader is sensitive to extreme environmental conditions. Avoid the following:

l Excessive humidity. Condensation directly on the sensitive electronic circuits can
cause the instrument to fail internal self-checks. The humidity must be in the range
of 10–85%, non-condensing.

l Excessive light. Bright light may affect the reader’s optics and readings, reducing
its linear range.

l Dust. Readings may be affected by extraneous particles (such as dust) in the
microplate wells. A clean work area is necessary to ensure accurate readings.

If you will be installing the BioStack for operation with the Synergy H1, you may wish to
seat the instruments in their aligning plates now. Refer to the BioStack Operator’s
Manual for more information.
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3: Remove the Shipping Hardware

Remove all shipping hardware before turning on the reader.

1. Locate the shipping hardware, as shown in the photos below.

2. Pull down the microplate carrier access door. Using a screwdriver, remove the carrier
shipping bracket.

3. If the instrument is equipped with the filter module: Open the top access door and
use a screwdriver to remove the filter reader shipping bracket.

4. Store the shipping hardware with the original packaging for reuse in case you need to
ship the instrument.

Figure 2-1: Carrier shipping bracket (left), and filter reader
shipping bracket
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4: Install the Power Supply

Power Rating. The instrument must be connected to a power
receptacle that provides voltage and current within the specified rating
for the system. Use of an incompatible power receptacle may produce
electrical shock and fire hazards.

Electrical Grounding. Never use a plug adapter to connect primary
power to the instrument. Use of an adapter disconnects the utility
ground, creating a severe shock hazard. Always connect the system
power cord directly to an appropriate receptacle with a functional
ground.

Warning. The instrument must be OFF before connecting the power
supply. If the external power supply shorts out, unplug it and wait five
minutes, then plug it back in.

1. Plug the power supply's cord into the power inlet on the rear of the reader.

2. Connect the power cord to the power supply.

3. Plug the power cord into an appropriate power receptacle.

5: Install the Gas Controller

Applies only to models compatible with the BioTek gas controller module

If you purchased a gas controller for use with the Synergy H1, you may wish to install it
now. Refer to the Gas Controller User Guide for complete instructions.
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6: Unpack and Inspect the Dispense Module

Applies only to models equipped with injectors

Save all packaging materials. If you need to ship the dispense module for
repair or replacement, you must use the original materials. Using other
forms of commercially available packaging, or failing to follow the
repackaging instructions, may void your warranty.

During the unpacking process, inspect the packaging, module, and
accessories for shipping damage. If the dispense module is damaged,
notify the carrier and your BioTek representative. Keep the shipping
boxes and the packaging materials for the carrier’s inspection.

Refer to Figure 2-9 and Figure 2-10 starting on page 28.

1. Open the shipping box. Remove the accessories box and the foam insert that
contains the injector tubing and bottle holders.

2. Lift out the module and place it on a level surface.

3. Open the accessories box and remove its contents. Refer to Package Contents
& Accessories on page 4 for the expected items.

4. Place all packaging materials into the shipping box for reuse if the dispense module
needs to be shipped.
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7: Install the Dispense Module

Applies only to models equipped with injectors

1. Place the dispense module on top of the reader or, if equipped, on top of the gas
controller module.

i Do not place the dispense module next to the reader.

Figure 2-2: Dispense module on top of the reader (shown without
the gas controller)

2. Open the bag containing the injector tubes and tips. Remove the clear shrouds from
the tubes.

3. Remove the two inlet tubes from their canisters.

4. Identify the two syringe valves on the dispense module (see Figure 2-4 on page 17).
Each is labeled with a left-pointing arrow.

iWhen installing the tubes, do not use any tools. Finger-tighten only!

5. Screw the fitting of one inlet tube into the right side of the Syringe 1 valve.

6. Screw one end of one outlet tube into the left side of the Syringe 1 valve.

7. Repeat these steps to attach the inlet and outlet tubing for Syringe 2.
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It is critical that each tubing set is correctly connected from the
syringe valve, through the light shield, to the injector tip
holder. Otherwise, injected fluid may miss the intended
well.

8. Remove the tubing feed-through cover from the top of the reader (2 screws). Store
the cover and screws with the shipping hardware in case the reader needs to be
shipped again.

9. Thread the injector tip holder, with outlet tubing connected to both ports, through the
hole in the top of the reader.

10. Open the reader's top access door, and, holding the injector tip holder by the tab,
insert the injector tips into the appropriate holes inside the reader.

A magnet helps guide the tips into place and secures them in the reader.

Figure 2-3: Injector tip holder in its socket

11. Seat the light shield in the reader's cover and finger-tighten the thumbscrews to
secure it.
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1 Inlet tubes

2 Syringe valves

3 Outlet tubes

4 Light shield

5 Injector tip holder

Figure 2-4: Dispense module components

12. Remove the two syringes from their protective boxes. They are identical and
interchangeable. Each syringe should already be assembled in one piece, but if for
some reason there are two separate pieces, assemble them now: insert the white tip
of the syringe plunger into the barrel of the syringe and gently push it all the way into
the barrel.

13. Install the syringes, referring to Figure 2-5 on page 18:
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l Hold the syringe vertically with the threaded end at the top.

l Screw the top of the syringe into the bottom of the syringe valve. Finger-tighten
only.

l Carefully pull down the bottom of the syringe until it rests inside the hole in the
bracket.

l Pass a thumbscrew up through this hole and thread it into the bottom of the
syringe. Hold the syringe to prevent it from rotating while tightening the
thumbscrew. Finger-tighten only.

Figure 2-5: Syringe installation

14. Locate the dispense module cable. Plug one end into the port on the left side of the
dispense module. Plug the other end into the “Dispenser Port” on the rear of the
reader.

15. Locate the injector tip-cleaning stylus, packaged in a small cylinder. Attach the
cylinder to the back of the dispense module for storage.

8: Connect the Host Computer

The Synergy H1 is equipped with a USB communication port, located on the back of the
reader. Connect one end of the supplied communication cable to the USB port on the
reader and the other end to an appropriate port on the host computer.
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9: Install Gen5 Software

The Synergy H1 is controlled by Gen5 software running on a host
computer. There is a certain sequence of events that must be followed to
ensure that the software is properly installed and configured. Please
follow the instructions provided in the Gen5 Getting Started Guide to
install the software.

10: Turn on the Reader

1. If Gen5 is open, close it now.

2. The power switch is located on the lower-left corner of the front panel; turn on the
Synergy H1. The reader performs a System Test. When the test is completed, the
reader extends the microplate carrier.

The carrier eject button, located next to the reader’s power switch, can be used to
extend/retract the microplate carrier.

11: Establish Communication

If using the USB cable, refer to the instructions that shipped with the USB drivers on the
Gen5 software media to install the necessary drivers.

1. Start Gen5 and log in if prompted.

2. From the main screen select System > Instrument Configuration.

3. Click Add Reader and select Synergy H1. Click OK.

4. Perform one of the following steps, as applicable:

l Select Plug & Play. (A reader must be connected to the computer and turned on
to appear in the Available Plug & Play Readers list.)

l Select Com Port and select the computer’s COM port to which the reader is
connected. (If using the USB cable, the information can be found via the Windows
Control Panel, under Ports in the Hardware/Device Manager area of System
Properties.)

5. Click Test Comm. Gen5 attempts to communicate with the reader. If the
communication attempt is successful, return to Gen5’s main screen.

If the communication attempt is not successful, try the following:
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l Is the reader connected to the power supply and turned on?

l Is the communication cable firmly attached to both the reader and the computer?

l Did you select the correct Reader Type in Gen5?

l Try a different Com port.

l Did you install the USB driver software?

l If you remain unable to get Gen5 and the reader to communicate with each other,
contact BioTek’s Technical Assistance Center.

12: Verify/Set Dispenser Calibration Values

Applies only to models equipped with injectors

Confirm that the reader is configured with calibration values for the dispense module.

i The calibration values for both dispensers (#1 and #2) are printed on labels affixed to
the rear of the dispense module. Each label lists six target calibration values (e.g., 200,
80, 40) with their actual measured values (e.g., 199.3, 79.7, 39.9). Gen5 should display
themeasured calibration values.

1. If you have not already done so, turn on the instrument and establish communication
with Gen5.

2. In Gen5, go to System > Instrument Configuration, select the Synergy H1, and
click View/Modify.

3. Click Setup and select the Dispenser 1 tab.

4. Click Get Volumes.

5. Compare the Calibration Volumes in the dialog with the Syringe #1 values on the rear
panel of the dispense module.

If the values match, skip to step 6.

If there is a mismatch:

l Press CTRL+SHIFT+M to enter maintenance mode for the Dispenser 1 window.

l Enter the syringe calibration values from the corresponding label on the rear of the
dispense module.

l Click Send Volumes and then Get Volumes to verify that the entered values
were sent to the reader.

6. Select the Dispenser 2 tab and repeat steps 4–5 for Dispenser 2.
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13: Run a System Test

Running a System Test will confirm that the reader is set up and operating properly, or will
provide an error code if a problem is detected.

1. Turn on the incubator:

l In Gen5, select System > Instrument Control > Synergy H1.

l Click the Pre-Heating tab. Enter a Requested temperature of at least 37°C and
then click On.

Wait until the incubator temperature reaches the set point before continuing.

2. Select System > Diagnostics > Run System Test. Select your reader if prompted
and click OK.

3. When the test is complete, a dialog requesting additional information appears. Enter
the information and click OK.

If a message appears stating that the reader has a pending system test report,
view the report and then repeat steps 2 and 3.

4. The results report appears and should contain the text “SYSTEM TEST PASS”.

l If required, print the report and store it with your installation records. Note: Gen5
stores results in its database; you can print a report at any time.

If an error code is returned, refer to Error Codes starting on page 153. If the
problem is something you can fix, do so now and run another System Test. If
the problem is something you cannot fix, or if the test continues to fail, contact
Technical Support.

5. Turn off the incubator.

Models with injectors: Keep Gen5 open and proceed to the next section.

All other models: The installation and setup process is complete. Close Gen5 and proceed
to Operational/Performance Qualification on page 23.
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14: Test the Injection System

Applies only to models equipped with injectors

1. If necessary, press the carrier eject button to eject the microplate carrier.

2. Place the tip priming trough in its pocket in the carrier.

3. Place the priming plate on the carrier.

Figure 2-6: Priming trough and plate installed on the carrier

4. Fill the two reagent bottles with distilled or deionized water. Place the bottles in their
holders, and place the holders directly in front of the syringes. Insert the inlet tubes
into the bottles.

5. In Gen5, select System > Instrument Control > Synergy H1 and click the Prime
tab.

6. With Dispenser set to 1, set the Volume to 5000 µL and click Prime. The syringe
should move down and up repeatedly, drawing fluid from the bottle and pumping it
through the tubing and into the priming plate. Examine the fittings; no leaks should
be detected. If leaks are detected, tighten all fittings and repeat the prime. If leaks
are still detected, contact BioTek’s Technical Assistance Center.

7. When finished, set the Volume to 2000 µL and click Purge to clear the fluid lines.

8. Set the Dispenser to 2 and repeat steps 6 and 7.

9. Remove and empty the priming plate.
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Operational/Performance Qualification

Your Synergy H1 was fully tested prior to shipment and should operate properly following
the successful completion of the installation and setup procedures described in this
chapter.

If you suspect that problems occurred during shipment, if you received the reader back
following service or repair, or if regulatory requirements dictate that
Operational/Performance Qualification is necessary, turn to Instrument Qualification
Procedures starting on page 113 to learn about BioTek’s recommended OQ/PQ
procedures for the Synergy H1.

A Product Qualification & Maintenance (IQ/OQ/PQ) package for the Synergy H1 is
available for purchase (PN 8040528).
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Repackaging and Shipping Instructions

If the equipment has been exposed to potentially hazardous material,
decontaminate it to minimize the risk to all who come in contact with the
reader during shipping, handling, and servicing. Decontamination prior
to shipping is required by the U.S. Department of Transportation
regulations. See page 68 for decontamination instructions for the reader
and dispense module.

Remove the microplate and tip prime trough (if equipped) from the
carrier before shipment. Spilled fluids can contaminate the optics and
damage the instrument.

The Synergy H1 with all available modules weighs up to 55 pounds
(24.95 kg). Use two people when lifting and carrying the instrument.

The instrument’s packaging design is subject to change. If the
instructions in this section do not apply to the packaging materials you
are using, please contact Technical Support.

Replace the shipping hardware before repackaging the reader. Order part
number 8040015 if you need a carrier shipping bracket and/or filter
reader shipping bracket.

When preparing to ship the Synergy H1 and/or the dispense module, be
sure to use the original packaging materials. Other forms of
commercially available packaging are not recommended and can void
the warranty.

The shipping materials are designed to be used no more than five times.
If the original materials have been damaged, lost, or used more than five
times, order replacements.

Refer to the Gas Controller User Guide for the decontamination procedure and packing
instructions for the gas controller module.

1. Contact Technical Support for instructions.

2. Decontaminate the reader and, if attached, the dispense module, according to the
instructions provided in Decontamination starting on page 68.

3. If you will also be shipping the dispense module, perform the steps described on page
26.

If you are not shipping the dispense module, disconnect it from the reader now.

4. If applicable, remove the tip priming trough from the microplate carrier.

5. Retract the microplate carrier. Turn off and unplug the reader.
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6. Install the carrier shipping bracket and, if applicable, the filter reader shipping
bracket. See Figure 2-1 on page 12.

7. Place the accessories in the accessories box and then seal the box with tape.

Figure 2-7: Repacking the Synergy H1 accessories box

8. Place the instrument in a plastic bag.

9. Place the instrument in the shipping box with foam corners.

10. Place the accessories box in the shipping box. Seal the box with tape.
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Figure 2-8: Repacking the instrument and accessories box

Prepare the Dispense Module for Shipment

Refer to the illustrations on the next two pages when performing these steps.
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1. If you have not already done so, contact Technical Support for shipping instructions
before returning equipment for service.

2. Decontaminate the module according to the instructions starting on page 68. Be sure
to purge the dispense module of all fluid when finished.

3. With the reader on, start Gen5 and select System > Instrument Control >
Synergy H1.

4. Perform this step twice, once per dispenser: Click the Prime tab (or Dispenser tab,
if using Gen5 v2.05 or lower) and set the number (1 or 2). ClickMaintenance. The
syringe bracket lowers. Remove the thumbscrew from underneath the bracket.
Carefully unscrew the top of the syringe from the syringe valve. Lift out the syringe
and store it in its original box.

5. Fully detach the dispense module from the reader. Set the module aside for the
moment.

6. Remove the tip priming trough and store it in the dispenser accessories bag.

7. Remove the two inlet tubes from the syringe valves and store them in their plastic
canisters.

8. Remove the two outlet tubes from the syringe valves. Attach the clear plastic shrouds
to the fittings of the outlet tubes. Place the tubes in a plastic bag.

9. Remove the front cover from the dispenser.

10. Insert the bottom foam end cap in the dispenser module accessories shipping box
and place the accessories in the insert.

11. Insert the bottom foam end cap in the shipping box, and place the dispense module
inside the end cap.

12. Insert the foam insert that holds the reagent bottle holders and injector tubing into
the shipping box and place the bottle holders and tubing in it.

13. Slide the dispenser accessories box into the shipping box.

14. Insert the top foam end cap. Close and seal the outer box with tape.
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Figure 2-9: Packing the dispense module accessories
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Figure 2-10: Packing the dispense module
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Chapter 3

Getting Started
This chapter describes some of the Synergy H1's external and internal
components, and provides an introduction to using Gen5 software to
control the instrument and, if equipped, dispense module.
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Modular Design

The Synergy H1 is a multi-mode microplate reader, with a design that allows you to initially
purchase only the capabilities you need and then upgrade later as your requirements
expand.

Gen5 software is used to control the reader. If the reader is connected and turned on, Gen5
will present you with only those options that apply to your reader model. For example, if
your model is not equipped with injectors, Gen5 will not provide the option to add a
Dispense step to your assay protocol.

The instrument's part number indicates its capabilities:

Absorbance

Filter Fluor.
and Filter
Luminescence

Fixed
BP Mono
Fluor. and
Broadband
Lum.

Variable BP
Mono
Fluor. and
Broadband
Lum.

Dispense
Ready

Gas
Ready Maximum

Incubation
Temperature

H1F x x 45°C

H1FG x x x 45°C

H1M x x x 45°C

H1MF x x x x 45°C

H1MFG x x x x x 45°C

H1MG x x x x 45°C

SH1F x x 45°C

SH1FG x x x 45°C

SH1M x x x 45°C

SH1MF x x x x 45°C

SH1MFG x x x x x 45°C

SH1MG x x x x 45°C

SH1M2 x x x 70°C

SH1M2F x x x x 70°C

SH1M2G x x x x 70°C

SH1M2FG x x x x x 70°C
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External Components

Figure 3-1: Synergy H1, front view
1 Entry for the dispense outlet tubes and injectors (if equipped)

2 The reader's back panel contains the communication and dispense module ports and
the input for the power supply

3 The tubing for the gas controller module is in the bottom tray of the reader (if
equipped)

4 Power switch and microplate carrier eject button
5 Light-blocking microplate carrier access door
6 Access door for the filter cube and internal components
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Internal Components

As discussed on page 32, not all Synergy H1 models contain these components.

Component Description

Filter Cube The filter cube can contain excitation and emission filters, mirrors,
and polarizing filters. Preconfigured cubes are available, or you can
change the filters and mirrors yourself. See Filter Cube on page 34.

Injection
System

The syringes may require replacement over time. The tubing and
injectors require cleaning at regular intervals. Applies to models
with injectors and an external dispense module. See Injection
System on page 34.

Filter Cube

Most Synergy H1 models are equipped with a filter cube that contains excitation and
emission filters, mirrors, and, if required, polarizing filters.

Excitation and emission filters are used for obtaining fluorescence and luminescence
measurements. The excitation filter selects the band of light to which the sample will be
exposed. The emission filter selects the band of light with the maximum fluorescence signal
of the sample, to be measured by the photomultiplier tube (PMT).

For filter-based, top-reading fluorescence analysis, the Synergy H1 uses mirrors to direct
the excitation and emission light paths. Mirrors are required for fluorescence polarization
(FP) measurements to direct light to the sample, because fibers cannot carry polarized
light. Mirrors also provide increased gain/sensitivity for fluorescence intensity (FI) and
time-resolved fluorescence (TRF) measurements. The filter cube stores up to two mirrors
and there are two possible mirror types:

l A 50%mirror is a glass slide with silver dots. It works with any wavelength in the
range of 200 to 850 nm.

l A dichroicmirror is wavelength-specific: It requires the excitation and emission
filters to fall within specific ranges. Dichroic mirrors provide better sensitivity than
50% mirrors, but they are dye-specific.

Filters and mirrors are stored in the filter cube as described in Filter Cube Overview starting
on page 46. If you run different types of fluorescence or luminescence assays, you can
replace the entire filter cube with a different one; this is the recommended option.
Alternatively, you can install different filters or mirrors in the cube.

The reader is delivered with a filter cube installed, and the reader’s
onboard software is configured with the filter and mirror values and
their locations in that filter cube. When Gen5 communicates with the
reader, it requests this information and stores the values in a Filter Cube
table.
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It is critical that the values in Gen5 and onboard the reader
exactly match the contents of the installed filter cube. If you
exchange the filter cube or modify its contents, youmust update
Gen5’s Filter Cube table and send the new information to the reader;
see instructions on page 38.

The filter cube is accessed through a hinged door in the front of the
instrument. Do not open the door to access the filter cube during
instrument operation! Doing so may result in invalid data.

Learn more about exchanging and modifying filter cubes in the Filters and
Mirrors chapter.

Injection System

The tubing and injectors should be cleaned at least every three months. See Clean the
Dispense Tubes and Injectors on page 65 for instructions.

Inspect the injection system daily for leaks, preferably immediately after priming and
whenever plumbing changes have been made.

If a syringe is leaking, it may need to be replaced. See Dispense Module, Syringe
Replacement on page 73 for instructions.

Dispense Module

The dispense module sits on top of the reader and pumps fluid from the reagent bottles
to injectors located inside the instrument. Fluid is injected into one well at a time. The
injectors support plate types from 6- to 384-well plates.
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Figure 3-2: Dispense module components

1 Two 250-µL syringes draw fluid from the supply bottles.

2 Inlet tubes transport fluid from the supply bottles to the syringes. These tubes
are short pieces of opaque PTFE (Teflon) tubing connected to stainless-steel
probes on one end and threaded fittings on the other end.

3 Valves switch the syringe flow from the inlet tubes to the outlet tubes.

4 Outlet tubes transport fluid from the syringes into the instrument, through the
tubing ports on the reader's top cover. The outlet tubes are opaque PTFE tubes
with threaded fittings on each end.

Avoid continuous contact with harsh chemicals. Rinse the fluid path with
deionized water after contact with any strong acid, base, or solvent.

For information on the materials used in the injection system, refer to
Injection System - Chemical Compatibility Technical Note on the
USB flash drive supplied with the Synergy H1.
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Priming the Injection System

Before running a Dispense assay, use Gen5 to prime the system with the reagent or
dispensing fluid. An additional tip prime can be performed at the start of the assay and,
sometimes, just before each dispense to a well. The tip prime compensates for any fluid
loss at the injector tip due to evaporation since the last dispense. All priming activities
are controlled using Gen5 (see Dispense Module Control on page 40).

If the injection system is not adequately primed, air bubbles can get
trapped in the system and affect injection volumes. Air bubbles in the
system can also result in fluid spraying or scattering inside the reader.

Both types of primes require a fluid reservoir to be present on the microplate carrier.
See the photo in Test the Injection System on page 22.

l The priming plate is placed on the microplate carrier for a Prime operation (to
prime the dispense system with fluid).

l The tip priming trough is placed in the rear pocket of the carrier, and is used for
performing the Tip Prime before dispensing. The trough holds up to 1.5 mL of
liquid and must be periodically emptied and cleaned by the user.

Do not perform tip priming when using tall plates. Generally, plates with
fewer than 96 wells are too tall for error-free tip priming; and, tip priming
is rarely required for these larger-volume plates.

The priming plate should be empty before priming, and it should contain
fluid after priming.
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Gen5 Software

Gen5 supports all Synergy H1 models. Use Gen5 to control the reader, the dispense module
(if equipped), and the BioStack (if equipped); perform data reduction and analysis on the
measurement values; print or export results; and more. This section provides brief
instructions for working with Gen5 to create protocols and experiments and read plates.
Refer to the Gen5 Getting Started Guide and the Help system for more information.

Define the Filter Cube in Gen5 and on the Reader

As described on page 34, most Synergy H1 models are delivered with a filter cube installed,
and the reader’s onboard software is configured with the filter and mirror values and their
locations in that filter cube. When Gen5 communicates with the reader, it “asks” for this
information and then stores the values in a Filter Cube table.

Important! It is critical that the values in Gen5 and the reader's
software exactly match the contents of the installed filter cube.

If you exchange or modify the filter cube, you must update the Gen5 Filter Cube table and
send the information to the reader:

1. From the Gen5 main view, select System > Instrument Configuration. Highlight
the Synergy H1, click View/Modify and then click Setup.

2. If this is a new filter cube, enter a unique name to identify the cube and then enter a
name for Filter Set 1.

3. If applicable, check the Fluorescence Polarization Cube box.

4. Define/modify settings for the excitation and emission filters:

l Select Band Pass, Long Pass, or Short Pass, as appropriate for each filter type.

Band Pass a standard interference filter with a defined central
wavelength and bandwidth

Long Pass cutoff filter that transmits longer wavelengths and block
shorter wavelengths

Short Pass cutoff filter that transmits shorter wavelengths and block
longer wavelengths

l Select PLUG to indicate the presence of a plug.

l Select HOLE to indicate an empty location.

5. Select the mirror type and enter the excitation and emission ranges. (Note that the
"M" value on the filter cube label is the cut-off (nm). Refer to the mirror information
table on page 50.)
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i If 'Fluorescence Polarization Cube' is checked, only Filter Set 1 is required for
definition. The filters and mirrors of Filter Set 2 must be identical to those of
Filter Set 1 for FP.

6. Define Filter Set 2, if necessary.

7. Click Send Values to transfer the information to the reader.

8. When finished, click Close.

Protocols and Experiments

In Gen5, a protocol contains instructions for controlling the reader and (optionally) for
analyzing data retrieved from the reader. At a minimum, a protocol must specify the
procedure for the assay you wish to run. After creating a protocol, create an experiment
that references the protocol. You’ll run the experiment to read plates and analyze the data.

These instructions briefly describe how to create a protocol in Gen5. See the Gen5 Help
system for complete instructions.

1. In the Gen5 Task Manager, select the Protocols icon and click Create New.

2. Open the Procedure dialog (double-click Procedure in the menu tree).

3. Select an appropriate Plate Type.

Gen5 stores measurements and other characteristics for individual plate
types in a database. It is essential that you select (or define) the plate
type to match the assay plate. Otherwise, results may be invalid. See
the "Plate Type Database" topic in the Gen5 Help for instructions.

4. Add steps to the procedure to shake or heat the plate, dispense fluid, read the plate,
and more.

5. Click Validate to verify that the attached reader supports the defined steps, and
then close the Procedure dialog.

6. Optionally, perform any of these steps to analyze and report the results:

l Open the Plate Layout dialog and assign blanks, samples, controls, and/or
standards to the plate.

l Open the Data Reduction dialog to add data reduction steps. Categories include
Transformations, Well Analysis, Curve Analysis, and Qualitative Analysis.

l Create a report or export template via the Report/Export Builders.

7. Select File > Save and give the protocol an identifying name.

These instructions briefly describe how to create an experiment and then read a plate in
Gen5. See the Gen5 Help system for complete instructions.

Synergy H1 Operator's Manual

Gen5 Software | 39



1. In the Gen5 Task Manager, select the Experiments icon and click Create using an
existing protocol.

2. Select the desired protocol and click OK.

3. Select a plate in the menu tree and select Plate > Read Plate # or click the Read
New icon.

4. When the read is complete, measurement values appear in Gen5.

5. Select File > Save and give the experiment an identifying name.

Dispense Module Control

Applies only to models equipped with injectors

Gen5 is used to perform several dispense functions, such as initialize, dispense, prime, and
purge. The Prime and Purge functions are introduced here; refer to the Gen5 Help system
for additional information.

Prime

Before running an experiment with a Dispense step, prime the system with the fluid to
be used.

1. Place the priming plate on the carrier.

2. Fill the supply bottle with a sufficient volume of the fluid to be used for the prime
and the assay. Insert the appropriate inlet tube into the bottle.

3. Select System > Instrument Control > Synergy H1 and click the Prime tab.

4. Select the Dispenser number (1 or 2) associated with the supply bottle.

5. Enter the Volume to be used for the prime. The minimum recommended prime
volume is 2000 μL.

6. Select a prime Rate, in μL/second.

7. Click Prime to start the process. When finished, carefully remove the priming
plate from the carrier and empty it.

If the priming plate is empty, the prime volume was too low.

Purge

To conserve reagent, Gen5 provides the option to purge fluid from the system back into
the supply bottle.

1. Select System > Instrument Control > Synergy H1 and click the Prime tab.

2. Select the Dispenser number (1 or 2) associated with the supply bottle.

3. Enter the desired purge Volume in μL (e.g., 2000).
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4. Select a prime Rate in µL/secon.

5. Click Purge to start the process.

Plate Shaking Options

The Synergy H1 supports multiple plate shaking options, as described below. Shaking is
controlled using Gen5 by adding a Shake step to a protocol's procedure.

Figure 3-3: Gen5 Shake Step options

Mode Speed Amplitude
(in 1-mm steps)

Frequency

Linear - 1 mm to 6 mm 18 Hz to 6 Hz

Orbital Slow 1 mm to 6 mm 10 Hz to 3 Hz

Orbital Fast 1 mm to 6 mm 14 Hz to 5 Hz

Double Orbital Slow 1 mm to 6 mm ~10 Hz to ~3 Hz

Double Orbital Fast 1 mm to 6 mm ~14 Hz to ~5 Hz

Note: Frequency is based on the Amplitude selected
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Recommendations for Optimum Performance

General

Microplates should be clean and free from dust or bottom scratches. Use new
microplates from sealed packages. Do not allow dust to settle on the surface of the
solution; use microplate covers or seals when not reading the plate. Filter solutions to
remove particulates that could cause erroneous readings.

Before preparing your microplates, make sure the reader is on and communicating with
Gen5. You may want to run a System Test if the reader has not been turned off/on in a
few days. Design your Gen5 protocol in advance as well, to ensure that the intended
reading parameters are used and to avoid any last-minute corrections.

Although the Synergy H1 supports standard flat, U-bottom, and V-bottom microplates,
the reader achieves optimum performance with flat-bottomed wells when running in
Absorbance mode. See Specifications starting on page 147 for more information on
the supported plates.

Non-uniformity in the optical density of the well bottoms can cause loss of accuracy,
especially with U- and V-bottom polyvinyl microplates. Check for this by reading an
empty microplate. Dual wavelength readings can eliminate this problem, or bring the
variation in density readings to within acceptable limits for most measurements.

Inaccuracy in pipetting has a large effect on measurements, especially if smaller
volumes of liquid are used. For best results in most cases, use at least 100 µL per well in
a 96-well plate, 25 µL in a 384-well plate, and 5 µL in a 1536-well plate (if supported).

Pipetting solution into 384- [and greater] well plates often traps air bubbles in the wells,
which may result in inaccurate readings. A dual-wavelength reading method usually
eliminates these inaccuracies. For best results, however, remove the air bubbles by
degassing the plate in a vacuum chamber or spinning the plate in a centrifuge before
reading.

The inclination of the meniscus can cause loss of accuracy in some solutions, especially
with small volumes. Shake the microplate before reading to help bring it within
acceptable limits. Use Tween 20, if possible (or some other wetting agent) to normalize
the meniscus for absorbance measurements. Some solutions develop menisci over a
period of several minutes. This effect varies with the brand of microplate and the
solution composition. As the center of the meniscus drops and shortens the light path,
the density readings change. The meniscus shape will stabilize over time.

Use of liquids with concentrations of acids, corrosives, or solvents of 3% and greater can
begin attacking the materials inside the instrument’s chamber. Running multiple plates
with concentrations <3% in long kinetics may also have a destructive effect. If the
experiment is incubated, deterioration of chamber components will be accelerated.
When in doubt about the use of acids, corrosives, or solvents; please contact Technical
Support.
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It is the user’s responsibility to understand the volumetric limits of the plate type in use
as it applies to the assay being run.

Luminescence Measurements

For highly sensitive Luminescence assays using white plates, add a Delay step to your
Procedure to “dark adapt” the plates in the reading chamber before taking
measurements.

Monochromator-Based Fluorescence Systems

Although Time-Resolved Fluorescence can be performed with the monochromator, the
filter-based fluorescence system is more sensitive for TRF and is the better choice.

Models with Injectors

To keep the dispense system in top condition, flush and purge the fluid lines with
deionized (DI) water every day or upon completion of an assay run, whichever is more
frequent. Some reagents may crystallize or harden after use, clogging the fluid
passageways. Flushing the tubing at the end of each day, letting the DI water soak, and
then purging the lines at the beginning of each day ensures optimal performance of the
dispense system. See the Maintenance chapter for more information.

When dispensing volumes less than or equal to 20 µL/well, we recommend specifying a
tip prime volume that is equal to the dispense volume. For dispense volumes greater
than 20 µL/well, we recommend a tip prime volume of 20 µL.

To avoid spillage and possible contamination of the instrument, empty the tip prime
trough frequently and do not exceed the total fluid volume of the plate well when
dispensing.

Incubation and Partial Plates

When performing a partial plate read that includes an incubation step, the following
recommendations can reduce the effects of evaporation of your samples:

l Use microplate lids.

l Fill unused wells with liquid.

l Cluster your sample wells rather than spacing them throughout the plate.

l Place your sample wells in the center of the plate. This placement may lead to less
evaporation than if you place the samples in wells on the edge of the plate.
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Kinetic Assays Using the Continuous Shake Feature

This recommendation applies only to Synergy H1 basecode software versions
lower than 2.00.

A Gen5 experiment that specifies the following parameters may not run successfully on the
Synergy H1: Continuous Shake, Kinetic Interval greater than 15 minutes

When the experiment is initiated, plate shaking will begin, but shaking may stop
prematurely with no error message.

One suggested workaround is to shorten the kinetic interval. For example, if your desired
experiment is 25 kinetic reads with 60-minute intervals, use 100 kinetic reads with 15-
minute intervals.

Another suggestion is to perform multiple Shake steps and then a Read step with the
Discontinuous Kinetic Procedure feature enabled. For example, if your desired experiment
looks like this:

do this (example assumes the Read step takes one minute):
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Chapter 4

Filters and Mirrors
The Getting Started chapter provided an overview of the filters and
mirrors installed in some Synergy H1 models. This chapter provides
more detailed information on working with these components.

Filter Cube Overview 46
Removing a Filter Cube 48
Installing a Filter Cube 48
Configuring the System for Luminescence Measurements 49
About the Gen5 Optics Library 49

Handling Filters and Mirrors 51
Change a Filter or Mirror 51
Clean the Filters and Mirrors 54



Filter Cube Overview

Most Synergy H1 models are equipped with a filter cube that contains excitation filters,
emission filters, and mirrors for use when taking fluorescence and luminescence
measurements. Each filter cube contains two filter sets, each of which contains one
excitation filter, one emission filter, and one mirror. The filter cube is accessed through a
hinged door in the front of the instrument. Each filter has an ID label for recording the
cube's contents.

Figure 4-1: Synergy H1 filter cube

You can easily exchange one filter cube with another to meet varying assay requirements.
If you regularly need to use different filters or mirrors, consider purchasing additional filter
cubes.

Use the Gen5 Optics Library to identify and manage the contents of multiple
filter cubes; see About the Gen5 Optics Library on page 49.

The default filter cube configuration is shown below; any changes are reflected in the sales
order. Verify that the filter cube contains the filters and mirrors that you ordered.

Position 1 Position 2

Excitation 360/40 nm 485/20 nm

Emission 460/40 nm 528/20 nm

Mirror 400 nm 510 nm

Filters are not specific to either excitation or emission. Filter direction within the filter cube
is important, and as illustrated in Figure 4-2, the direction differs depending on the filter's
placement in the cube (EX or EM). Each filter has its central wavelength and bandpass
values printed on its side, with an arrow to indicate the proper direction of light through the
filter.
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Figure 4-2: Proper orientation of the EX (left) and EM (right)
filters in the filter cube

The filter cube can hold up to two half-size, or one full-size, dichroic or 50% mirror. The
mirror positions are labeled “1”and “2” to coordinate with EX1/EM1 and EX2/EM2.

Mirror direction is also important. The mirror label should be in the lower-right corner of the
mirror and readable (see Figure 4-3 on the next page). If the mirror is positioned
incorrectly, your measurement data may be inaccurate.

For Synergy H1 models with FP capability, the cube is equipped with up to four polarizers of
the following types:

l Excitation polarizer (visible-range or UV-range)

l Emission polarizer, parallel to the excitation polarizer

l Emission polarizer, perpendicular to the excitation polarizer

Two types of excitation (EX) polarizers are available: visible-range (400 nm and above, the
default) or UV-range (300 nm and above, available from BioTek). The polarizers, if used,
are placed below the excitation filters and above the emission filters. The polarizer filters
are keyed to fit in the correct alignment in the filter cube.
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Figure 4-3: Two half-size mirrors positioned in the filter cube,
with their labels in the lower-right corners

Removing a Filter Cube

Do not open the access door on the front of the instrument during
operation. Doing so may affect measurements.

1. Lift up the hinged door on the front of the reader.

2. Grasp the filter cube and slide it to the right to remove it from its chamber.

Installing a Filter Cube

1. Ensure that all filters, plugs, and mirrors are inserted properly in the filter cube (see
Figure 4-2 and Figure 4-3).

2. Open the front access door and locate the filter cube chamber.

3. With the filter cube properly oriented (the non-labeled side entering the chamber),
gently slide the cube into the chamber. You will feel a magnet engage the cube. See
the photos on the next page.

48 | Chapter 4: Filters and Mirrors

BioTek Instruments, Inc.



..

Figure 4-4: Filter cube sliding into the chamber (left) and
properly seated (right)

Configuring the System for Luminescence Measurements

If your tests require that the light emitted from the samples remain
unfiltered, the Emission filter position in the filter cube should be empty.
As discussed on page 38, if you make any changes to the filter cube, you
must update the Gen5 Filter Cube table; select HOLE next to Emission to
indicate the empty location.

About the Gen5 Optics Library

Gen5 provides an option to create a "library" of the filter cubes used with your assays.
You'll define a name and characteristics for each cube, reference the desired cube by name
in a protocol, and then update the reader's internal software to match the currently-
installed filter cube by selecting System > Optics Library > Set Reader. You can also
enable a Read Plate Prompt option to alert users at run-time if they attempt to run an
experiment that calls for filters/mirrors not currently installed. Brief instructions for adding
a filter cube to the library are provided below; refer to the Gen5 help system to learn more.

Adding a Filter Cube to the Gen5 Optics Library

1. From the Gen5 main view, select System > Optics Library > Filter Cubes.

2. Click Add and enter a name for the filter cube. This name will become available for
selection in the protocol/experiment procedure.

3. If applicable, check the Fluorescence Polarization Cube box.

4. Enter a name for Filter Set 1.

5. Define the excitation and emission filters:
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l Select Band Pass, Long Pass, or Short Pass and enter the wavelength and
bandwidth.

l Select Plug to indicate the presence of a plug.

l Select Hole to indicate an empty location.

6. Select the mirror type and enter the excitation and emission ranges. Note that the
“M” value on the filter cube label is the cut-off (nm).

Cut-off (nm) Excitation Range Emission Range

50% 200-850 200-850

320 260-305 335-750

365 290-350 380-800

400 320-390 410-800

435 385-425 445-610

455 400-450 460-710

510 440-505 515-640

525 475-520 530-670

545 512-535 555-578

550 415-540 560-850

555 541-550 560-595

570 515-565 575-735

595 540-590 600-770

635 640-780 400-630

660 580-655 665-850

i If 'Fluorescence Polarization Cube' is checked, only Filter Set 1 is
available for definition. The filters and mirrors of Filter Set 2 must be
identical to those of Filter Set 1 for fluorescence polarization.

7. Define Filter Set 2, if necessary.

8. Click OK to return to the Filter Cubes dialog. Click the Help button to learn about the
Read Plate Prompt options.
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Handling Filters and Mirrors

Filters and mirrors are stored in a filter cube as described in the overview section starting
on page 46. If you run different types of fluorescence and luminescence assays, you can
replace the entire filter cube with a different one; this is the BioTek-recommended option.
Alternatively, you can install different filters or mirrors in the cube; this section describes
how to do this.

Change a Filter or Mirror

Important! After changing the contents of a filter cube, be sure to
update Gen5 with the new filter and mirror configuration and then send
the information to the reader. It is critical that the Gen5 Filter Cube
table reflect the actual location and characteristics of the filters and
mirrors in the installed filter cube. See instructions on page 38.

Gather the following tools:

l 7/64" hex key

l Lens paper

l Cotton swab

l Linen or cloth gloves

To remove a filter, plug, or mirror:

i Handle with care. The mirrors are seated on a shelf in the bottom of the cube and are
not secured in place.

1. Remove the filter cube as instructed on page 48.

2. Set the cube on a flat work surface (do not hold it in your hand). When you remove
the filter cube's top in step 4, the mirrors will fall out if the cube is not on a stable, flat
surface.

3. Using a 7/64" hex key, remove the screw and washer located between the two
emission filter positions (shown in Figure 4-5).
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Figure 4-5: Removing the screw located between the EM1 and
EM2 positions

4. Carefully lift the top off the filter cube.

Figure 4-6: Filter cube with the top removed (left), exposing the
mirrors (right)

Caution: Do not touch the mirrors with your bare fingers. Wear gloves
to reduce the risk of damaging the mirrors or polarizing filters. If you
accidentally touch a mirror or polarizing filter with your bare fingers, see
Maintenance starting on page 55 for cleaning instructions.

Caution:When removing or replacing a filter or C-clip filter retainer, do
not use a sharp tool. Use several layers of lens paper and your finger or
a cotton swab to remove and replace filters and clips. Using a sharp
instrument, such as a flat screwdriver, will scratch the filter surface and
make it unusable.

5. The top of the cube contains the emission filters. To remove a filter:
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a. Prepare a multi-layered cushion of lens paper.

b. Using your finger covered with the lens paper, gently push against the filter and its
retainer until they pop out.

6. The bottom of the cube contains the mirrors and excitation filters. Remove the
mirrors before removing the filters:

a. Make note of the mirror placement and label orientation (refer to Figure 4-3 on
page 48).

b. Wearing linen or cloth gloves, carefully grasp the mirror by its edges, lift it out of
the cube, and store it properly.

7. To remove an excitation filter, use a cotton swab to gently push against the filter, the
aperture, and the C-clip retainer until they pop out.

To replace a filter, plug, or mirror:

1. To replace a filter or plug:

a. Orient the filter as shown in Figure 4-2 on page 47, observing the arrow on its side
which indicates the light direction. Drop the filter or plug into the desired location.

b. Make note of the filter position number (EX1/EX2 or EM1/EM2).

c. Using your fingers, squeeze the sides of the C-clip retainer, and then insert it into
the top of the hole containing the new filter. Cover your finger with several layers
of lens paper, and then push down on all sides of the retainer until it sits flush
against the filter.

d. Gently wipe both sides of the filter with lens paper.

2. To replace a mirror, hold the mirror by its edges, turn it so that its label is face-up and
readable (see Figure 4-3 on page 48), and place it on the shelf in the filter cube.

3. Place the filter cube top over the bottom and then replace the screw and washer.

4. When finished, install the filter cube in the reader.

Important! If you changed the contents of the filter cube, update Gen5
with the new configuration and then send the information to the reader.
It is critical that the Gen5 Filter Cube table reflect the actual location and
characteristics of the filters and mirrors in the installed filter cube. See
instructions on page 38.
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Clean the Filters and Mirrors

Instructions are provided underMaintenance starting on page 55.
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Chapter 5

Maintenance
This chapter provides instructions for maintaining the Synergy H1 and
external dispense module (if used) in top condition, to ensure that they
continue to perform to specification.

Overview 56
Recommended Maintenance Schedule 57
Warnings and Precautions 58
Clean Exposed Surfaces 59
Inspect/Clean Excitation and Emission Filters 60
Inspect/Clean Mirrors 61
Flush/Purge Fluid Path 63
Run a Dispense Protocol (Optional) 64
Empty/Clean the Tip Priming Trough 65
Clean the Priming Plate 65
Clean the Dispense Tubes and Injectors 65



Overview

A general maintenance regimen for the Synergy H1 includes periodically cleaning all
exposed surfaces and inspecting/cleaning the excitation and emission filters and mirrors (if
equipped). For models with the external dispense module, additional tasks include
flushing/purging the fluid path and cleaning the tip prime trough, priming plate, supply
bottles, internal dispense tubing, and injector heads.

Daily Cleaning for the Dispense Module

To ensure accurate performance and a long life for the dispense module and injectors, flush
and purge the fluid lines with deionized (DI) water every day or after completing an assay
run, whichever is more frequent. Some reagents may crystallize or harden and then clog
the fluid passageways. Take special care when using molecules that are active at very low
concentrations (e.g., enzymes, inhibitors). Remove any residual reagent in the dispense
lines using a suitable cleaning solution (review the reagent’s package insert for specific
recommendations).

Flushing the tubing at the end of each day, letting the DI water soak overnight, and then
purging the lines at the beginning of each day ensures optimal performance of the dispense
system. Perform a visual inspection of the dispense accuracy before running an assay
protocol that includes dispense steps.

It is also recommended to flush the module with DI water before conducting the
decontamination procedure described in the As-Needed Maintenance chapter.

Models with injectors: Accumulated algae, fungi, or mold may require
decontamination. See the As-Needed Maintenance chapter for
instructions.
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Recommended Maintenance Schedule

The table below contains the recommended maintenance tasks for Synergy H1 and the
frequency with which each task should be performed.

The risk and performance factors associated with your assays may
require that some or all of the maintenance procedures be performed
more frequently than shown here.

Task Daily Quarterly As Needed

All models:

Clean exposed surfaces ü

Inspect/clean excitation and emission filters (if
equipped)

ü

Inspect/clean mirrors (if equipped) annually

Decontaminate the instrument before shipment or storage

Models with injectors and an external dispense module:

Flush/purge the fluid path ü

(Optional) Run a Dispense protocol ü

Empty/clean tip prime trough ü

Clean priming plate ü

Clean dispense tubes and injectors ü ü
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Warnings and Precautions

Warning! Internal Voltage. Turn off and unplug the instrument for
all maintenance and repair operations.

Warning!Wear protective gloves when handling contaminated
instruments. Gloved hands should be considered contaminated at all
times; keep gloved hands away from eyes, mouth, nose, and ears.

Warning! Mucous membranes are considered prime entry routes for
infectious agents. Wear eye protection and a surgical mask when there
is a possibility of aerosol contamination. Intact skin is generally
considered an effective barrier against infectious organisms; however,
small abrasions and cuts may not always be visible. Wear protective
gloves when handling contaminated instruments.

Caution! The buildup of deposits left by the evaporation of spilled
fluids within the read chamber can impact measurements. Be sure to
keep System Test records before and after maintenance so that
changes can be noted.

Warning! The instrument with all available modules weighs up to 55
pounds (24.95 kg) depending on the model. Use two people when
lifting and carrying the instrument.

Important! Do not immerse the instrument, spray it with liquid, or use
a dripping-wet cloth on it. Do not allow water or other cleaning
solution to run into the interior of the instrument. If this happens,
contact Technical Support.

Important! Do not apply lubricants to the microplate carrier or carrier
track. Lubricant attracts dust and other particles, which may obstruct
the carrier path and cause errors.
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Clean Exposed Surfaces

Exposed surfaces may be cleaned (not decontaminated) with a cloth moistened (not
soaked) with water or water and a mild detergent.

You will need:

l Deionized or distilled water

l Clean, lint-free cotton cloths or paper towels

l Mild detergent (optional)

Procedure:

1. Important! Turn off and unplug the instrument.

2. Wet a cloth or paper towel with water, or with water and mild detergent, and then
thoroughly wring it out so that liquid does not drip from it.

3. Wipe the plate carrier and all exposed surfaces of the instrument.

4. Wipe all exposed surfaces of the dispense module (if used).

5. Wipe all exposed surfaces of the gas controller module (if used).

6. If detergent was used, wipe all surfaces with a cloth moistened (not soaked) with
water.

7. Use a clean, dry cloth to dry all wet surfaces.

Models with injectors: If the tip priming trough overflows or other spills occur inside
the instrument, wipe the carrier and the surface beneath the carrier with a dry cotton
cloth. The internal chamber and probes are not customer-accessible. If overflow is
significant, contact Technical Support.
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Inspect/Clean Excitation and Emission Filters

Applies only to models with fluorescence and/or luminescence capability

BioTek recommends inspecting the filters for dust and other debris every three months. To
clean them, you will need:

l Isopropyl, ethyl, or methyl alcohol

l 100% pure cotton balls or high-quality lens-cleaning tissue

l Cloth gloves

l Magnifying glass

Do not touch the filters with your bare fingers.

1. Turn off and unplug the instrument.

2. Open the access door on the front of the instrument. Slide the filter cube out of its
compartment.

The Filters and Mirrors chapter contains illustrations for identifying the filters
and their unique characteristics. It also contains instructions for replacing
filters, if necessary.

3. Inspect the glass filters for speckled surfaces or a “halo” effect. This may indicate
deterioration due to moisture exposure over a long period of time. If you have any
concerns about the quality of the filters, contact your BioTek representative.

4. Using cotton balls or lens-cleaning tissue moistened with a small amount of high-
quality alcohol, clean each filter by lightly stroking its surface in one direction. Ensure
that the filters remain in their current locations.

5. Use a magnifying glass to inspect the surface; remove any loose threads left by the
cotton ball.

6. Replace the filter cube and close the access door.
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Inspect/Clean Mirrors

Applies only to models with fluorescence and/or luminescence capability

BioTek recommends inspecting/cleaning the mirrors and polarizing filters (if equipped)
annually, especially if the filter cube has been opened or changed.

The mirrors (especially the dichroic) and polarizing filters can be easily
damaged. Perform the cleaning steps only when necessary and always
handle the mirror and filters carefully.

These optical elements are delicate and must be carefully handled. The glass and anti-
reflective (AR) coated surfaces will be damaged by any contact, especially by abrasive
particles. In most cases, it is best to leave minor debris on the surface. If
performance indicators or obvious defects in the mirrors or filters suggest cleaning them,
however, here are some guidelines:

l Use of oil-free dry air or nitrogen under moderate pressure is the best method for
removing excessive debris from an optical surface. If the contamination is not
dislodged by the flow of gas, please follow the cleaning instructions below.

l The purpose of the cleaning solvent is only to dissolve any adhesive contamination
that is holding debris on the surface. The towel needs to absorb both the excessive
solvent and entrap the debris so that it can be removed from the surface. Surface
coatings on dichroics are typically less hard than the substrate. It is reasonable to
expect that any cleaning will degrade the surface at an atomic level. Consideration
should be given as to whether the contamination in question is more significant to the
application than the damage that may result from cleaning the surface. In many
cases, the AR coatings that are provided to give maximum light transmission amplify
the appearance of contamination on the surface.

Materials

7/64" hex key

Linen or cloth gloves

Anhydrous reagent-grade ethanol

Kimwipes

Magnifying glass

100% pure cotton balls (for the polarizing filters)
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Procedure

1. Turn off and unplug the reader.

2. Lift up the hinged door on the front of the reader. Grasp the filter cube and slide it to
the right to remove it from its chamber.

i Handle with care. The mirrors are seated on a shelf in the bottom of the cube
and are not secured in place.

The Filters and Mirrors chapter shows how to remove and open the filter
cube. It also contains instructions for replacing its contents, if necessary.

3. Set the cube on a flat work surface (do not hold it in your hand). After you remove
the filter cube's top in step 4, the mirrors will fall out if the cube is not on a stable, flat
surface.

4. Using a 7/64" hex key, remove the screw and washer located between the two
emission filter positions (shown in Figure 4-5 on page 52). Carefully lift the top off the
filter cube.

5. Wearing linen or cloth gloves, grasp the mirror by its edges and lift it out of the cube.

6. Wet an absorbent towel (such as a Kimwipe, not lens paper) with anhydrous reagent-
grade ethanol. Wear gloves and use enough toweling so that solvents do not dissolve
oils from your hands that can seep through the toweling onto the coated surface.

7. Drag the trailing edge of the ethanol-soaked Kimwipe across the surface of the
mirror, moving in a single direction. A minimal amount of pressure can be applied
while wiping. However, too much pressure will damage the mirror.

8. Use the magnifying glass to inspect the surface; if debris is still visible, repeat with a
new Kimwipe.

9. To replace the mirror, hold it by its edges, turn it so that its label is face-up and
readable, and place it on the shelf in the filter cube. See Figure 4-3 on page 48.

10. Place the filter cube top back onto the cube and replace the screw and washer.

11. Reinstall the filter cube in the reader.
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Flush/Purge Fluid Path

Applies only to models equipped with injectors

At the end of each day that the dispense module is in use, flush the fluid path using the
Gen5 priming utility. Leave the fluid to soak overnight or over a weekend, and then purge
the fluid before using the instrument again.

This flushing and purging routine is also recommended before disconnecting the outlet
tubes from the reader, and before decontamination to remove any assay residue prior to
applying isopropyl alcohol or sodium hypochlorite.

i If using Gen5 version 2.05 or earlier, the Prime and Purge options are found under
the Dispenser tab in the Reader Control dialog.

To flush the fluid path:

1. Fill two supply bottles with deionized or distilled water. Insert the supply (inlet) tubes
into the bottles.

2. Place the priming plate on the carrier.

3. Select System > Instrument Control > Synergy H1.

4. Click the Prime tab and select Dispenser 1.

5. Set the Volume to 5000 µL. Keep the default prime rate.

6. Click Prime to start the process. When the process is complete, carefully remove the
priming plate from the carrier and empty it.

7. Repeat the process for Dispenser 2.

Leave the water in the system overnight or until the instrument will be used again.
Purge the fluid from the system (see below) and then prime with the dispense
reagent before running an assay.

To purge the fluid from the system:

1. Place the inlet tubes in empty supply bottles or a beaker.

2. Select System > Instrument Control > Synergy H1.

3. Click the Prime tab and select Dispenser 1.

4. Set the Volume to 2000 µL.

5. Click Purge to start the process.

6. When the purge is complete, repeat the process for Dispenser 2.

After purging the system, you may wish to run a quick Dispense protocol to visually
verify the dispense accuracy (see the next section) or the more thorough Dispense
Accuracy and Precision Tests (see Injection System Tests starting on page 141).
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Run a Dispense Protocol (Optional)

Applies only to models equipped with injectors

After flushing/purging the system (described on page 63) and before running an assay that
requires dispense, take a moment to visually inspect the dispense accuracy.

Use a DI H2O–Tween solution to visually inspect the dispense accuracy
following maintenance: e.g., add 1 mL Tween 20 to 1000 mL of deionized
water.

1. Create a new protocol in Gen5. Select a Plate Type that matches the plate you are
using.

2. Add a Dispense step with the following parameters:

l Select Dispenser 1

l Set Tip Priming to "Before this dispense step" and Volume to 10 µL

l Set the Dispense Volume to 100 µL (or an amount to match your assay protocol)

l Adjust the Rate to support the dispensing volume

3. Add another Dispense step with the same parameters, selecting Dispenser 2.

4. Add a quick Read step with parameters relevant to your reader model (this is
necessary because Gen5 requires that a Read step follow the Dispense step).

5. Save the protocol with an identifying name, such as “Dispense Observation.”

6. Fill the supply bottles with the DI H2O–Tween solution mentioned above.

7. Create and run an experiment based on the Dispense Observation protocol.

8. When the experiment is complete, visually assess the fluid level in the wells. Well
volumes should appear evenly distributed across the plate.

If the well volume appears to be unevenly distributed, clean the internal dispense
tubes and injectors as described in Clean the Dispense Tubes and Injectors starting
on page 65 and run the protocol again.
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Empty/Clean the Tip Priming Trough

Applies only to models equipped with injectors

The tip priming trough is a removable cup located in the rear pocket of the microplate
carrier, used for performing the tip prime. The trough holds about 1.5 mL of liquid and must
be periodically emptied and cleaned.

1. Extend the microplate carrier and carefully remove the tip priming trough from its
pocket in the left rear of the carrier.

2. Wash the trough in hot, soapy water. Use a small brush to clean in the corners.

3. Rinse the trough thoroughly and allow it to dry completely.

4. Replace the trough in the microplate carrier.

At the start of an experiment that requires dispensing, Gen5 prompts the user to empty
the tip prime trough.

Clean the Priming Plate

Applies only to models equipped with injectors

Clean the priming plate regularly to prevent bacteria growth and residue buildup. Wash the
plate in hot, soapy water, using a small brush to clean in the corners. Rinse thoroughly and
allow it to dry completely.

Clean the Dispense Tubes and Injectors

Applies only to models equipped with injectors

The dispense tubes and injectors require routine cleaning, at least quarterly and possibly
more frequently depending on the type of fluids dispensed.

Required Materials

Protective gloves and safety glasses

Mild detergent

Clean, lint-free cotton cloths

Deionized or distilled water

Stylus (affixed to the rear of the dispense module or reader) (PN 2872304)
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Remove the Dispense Tubes and Injector Tip Holder

See Figure 2-3 on page 16 for the location of the injector tip holder.

1. Purge the dispense lines of all fluid; see the instructions under on page 40.

2. Open the door on the front of the reader.

3. Grasp the injector tip holder by the tab and pull it up out of its socket.

4. Using your fingers, remove the thumbscrews securing the light shield to the top of
the reader and slide the shield up the outlets tubes.

5. Slide the injector tip holder through the hole in the top of the reader.

6. Turn each tube’s thumbscrew counterclockwise and gently pull the tube from its
injector tip.

7. On the dispense module, turn each outlet tube’s thumbscrew counterclockwise to
disconnect it from the syringe drive.

Caution! Do not bend the injector tips! A bent tip may not
dispense accurately.

Clean the Dispense Tubes and Injectors

As discussed on page 56, some reagents can crystallize and clog the tubing and injectors.
Daily flushing and purging can help to prevent this, but more rigorous cleaning may be
necessary if reagent has dried in the tubing or injectors.

To clean the dispense tubes, soak them in hot, soapy water to soften and dissolve any
hardened particles. Flush each tube by holding it vertically under a stream of water.

To clean the injectors:

l Gently insert the stylus into each injector tip to clear any blockages. (The stylus is
stored in a cylinder affixed to the rear of the dispense module.)

l Stream water through the pipe to be sure it is clean. If the water does not stream
out, try soaking in hot, soapy water and then reinserting the stylus.
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Chapter 6

As-Needed Maintenance
This chapter contains maintenance and component-replacement
procedures that need to be performed only occasionally.

Decontamination 68
Required Materials 68
Procedure for Models without the Dispense Module 69
Procedure for Models with the Dispense Module 70

Dispense Module, Syringe Replacement 73
Syringe Maintenance Position 73
Replace the Syringe 74



Decontamination

Any laboratory instrument that has been used for research or clinical analysis is considered
a biohazard and requires decontamination prior to handling or disposal.

Decontamination minimizes the risk to all who come into contact with the instrument
during shipping, handling, and servicing. Decontamination is required by the U.S.
Department of Transportation regulations.

Persons performing the decontamination process must be familiar with the basic setup and
operation of the instrument.

BioTek Instruments, Inc., recommends the use of the following
decontamination solutions and methods based on our knowledge of the
instrument and recommendations of the Centers for Disease Control and
Prevention (CDC). Neither BioTek nor the CDC assumes any liability for
the adequacy of these solutions and methods. Each laboratory must
ensure that decontamination procedures are adequate for the biohazards
they handle.

Wear prophylactic gloves when handling contaminated instruments.
Gloved hands should be considered contaminated at all times; keep
gloved hands away from eyes, mouth, and nose. Eating and drinking
while decontaminating instruments is not advised.

Mucous membranes are considered prime entry routes for infectious
agents. Wear eye protection and a surgical mask when there is a
possibility of aerosol contamination. Intact skin is generally considered
an effective barrier against infectious organisms; however, small
abrasions and cuts may not always be visible. Wear protective gloves
when performing the decontamination procedure.

Required Materials

For all Synergy H1 models:

l Sodium hypochlorite (NaClO, or bleach)

l 70% isopropyl alcohol (as an alternative to bleach)

l Deionized or distilled water

l Safety glasses

l Surgical mask

l Protective gloves
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l Lab coat

l Biohazard trash bags

l 125-mL beakers

l Clean, lint-free cotton cloths or paper towels

Additional materials for models with the dispense module:

l Screwdriver

l Small brush for cleaning the tip priming trough and priming plate

l (Optional) Mild detergent

Procedure for Models without the Dispense Module

The sodium hypochlorite (bleach) solution is caustic; wear gloves and
eye protection when handling the solution.

Do not immerse the instrument, spray it with liquid, or use a dripping-
wet cloth. Do not allow the cleaning solution to run into the
interior of the instrument. If this happens, contact the BioTek
Service Department.

Turn off and unplug the instrument for all decontamination and cleaning
operations.

1. Turn off and unplug the instrument.

2. Prepare an aqueous solution of 0.50% sodium hypochlorite (bleach). If the effects of
bleach are a concern, 70% isopropyl alcohol may be used.

Check the percent NaClO of the bleach you are using. Commercial bleach is
typically 10.0% NaClO; prepare a 1:20 dilution. Household bleach is typically
5.0% NaClO; prepare a 1:10 dilution.

3. Wet a cloth or paper towel with the bleach solution or alcohol, and then thoroughly
wring it out so that liquid does not drip from it.

4. Open the plate carrier door, and slide out the plate carrier.

5. Wipe the plate carrier and all exposed surfaces of the instrument.

6. Wait 20 minutes. Moisten a cloth with deionized (DI) or distilled water and wipe all
surfaces of the instrument that have been cleaned with the bleach solution or alcohol.

7. Use a clean, dry cloth to dry all wet surfaces.

8. Reassemble the instrument as necessary.

9. Discard the used gloves and cloths using a biohazard trash bag and an approved
biohazard container.
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Procedure for Models with the Dispense Module

Perform the Routine Procedure below when the equipment is functioning normally. If
you are unable to perform a prime due to a system failure, perform the Alternate
Procedure described on page 72.

i If using Gen5 version 2.05 or earlier, the Prime and Purge options are found under
the Dispenser tab in the Reader Control dialog.

Routine Procedure

If disinfecting with sodium hypochlorite (bleach), flush repeatedly with
deionized water to remove the bleach. After disinfecting with sodium
hypochlorite, perform the rinse procedure provided on page 71.

If disinfecting with alcohol, do not immediately prime with deionized
water, because the drying effect of the alcohol is an important aspect of
its disinfectant properties.

Clean Exposed Surfaces

1. Turn off and unplug the instrument.

2. Prepare an aqueous solution of 0.50% sodium hypochlorite (bleach). If the effects
of bleach are a concern, 70% isopropyl alcohol may be used.

Check the percent NaClO of the bleach you are using. Commercial bleach is
typically 10.0% NaClO; prepare a 1:20 dilution. Household bleach is
typically 5.0% NaClO; prepare a 1:10 dilution.

3. Open the plate carrier door and slide out the plate carrier.

4. Wet a cloth or paper towel with the bleach solution or alcohol, and then
thoroughly wring it out so that liquid does not drip from it.

5. Wipe the plate carrier and the exposed surfaces of the external dispense module.

6. Wait 20 minutes. Moisten a cloth with deionized (DI) or distilled water and wipe all
surfaces that have been cleaned with the bleach solution or alcohol.

7. Use a clean, dry cloth to dry all wet surfaces.

8. Reassemble the instrument as necessary.

9. If the dispense module is installed, purge any fluid (see Flush/Purge Fluid Path on
page 63) and detach the outlet tubes from the instrument. If it is not installed,
attach only the dispense module’s communication cable to the instrument.
Remove the supply bottles and their holders.

10. Perform the decontamination procedures described below.
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Decontaminate the Fluid Lines

1. Place a beaker with 20 mL of 0.5% sodium hypochlorite solution or 70% isopropyl
alcohol near SYRINGE 1 on the dispense module.

2. Place the SYRINGE 1 inlet tube in the beaker.

3. If you have not already done so, detach the dispense module’s outlet tubes from
the instrument. Place the ends of the outlet tubes in an empty beaker and set the
beaker next to the dispense module.

4. Launch Gen5, select System > Instrument Control, and click the Prime tab.

5. Select Dispenser 1, enter a Volume of 5000 µL, and keep the default dispense
Rate.

6. Place the priming plate on the carrier.

7. Run two prime cycles, for a total of 10,000 µL.

8. Wait at least 20 minutes to allow the solution to disinfect the tubing.

9. Remove the inlet tube from the beaker of disinfectant solution.

10. From the Reader Control dialog, change the Volume to 1000 µL.

11. Run one prime cycle, to flush the disinfectant out of the fluid lines.

12. Empty the beaker containing the outlet tubes. Put the tubes back in the empty
beaker.

13. If sodium hypochlorite (bleach) was used, perform the next procedure, Rinse the
Fluid Lines.

Otherwise (or after performing the Rinse procedure), repeat steps 1–13 for
SYRINGE 2/Dispenser 2.

Rinse the Fluid Lines

Perform this procedure only if decontamination was performed using sodium
hypochlorite.

1. Place a beaker containing at least 30 mL of deionized water on the dispense
module.

2. Place the SYRINGE 1 or 2 inlet tube in the beaker.

3. If you have not already done so, place the outlet tubes in an empty beaker.

4. From the Reader Control dialog, select Dispenser 1 or 2, set the Volume to 5000
µL, and keep the default dispense Rate.

5. Run five prime cycles, for a total of 25,000 µL.

6. Pause for 10 minutes and then run one prime cycle with 5000 µL. This delay will
allow any residual sodium hypochlorite to diffuse into the solution and be flushed
out with the next prime.

7. Empty the beaker containing the outlet tubes.

8. Wipe all surfaces with deionized water.
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9. Discard the used gloves and cloths using a biohazard trash bag and an approved
biohazard container.

Clean the Tubing and Injectors

Perform the procedures under Clean the Dispense Tubes and Injectors on page 65.

Decontaminate the Tip Priming Trough and Priming Plate

1. Remove the tip priming trough from the instrument’s microplate carrier.

2. Wash the tip priming trough and priming plate in hot, soapy water. Use a small
brush or cloth to clean the corners of the trough and plate.

3. To decontaminate, soak the trough and plate in a container of 0.5% sodium
hypochlorite or 70% isopropyl alcohol for at least 20 minutes.

o If decontaminating in a bleach solution, thoroughly rinse the trough and plate
with DI water.

o If decontaminating with alcohol, let the trough and plate air dry.

4. Discard the used gloves and cloths using a biohazard trash bag and an approved
biohazard container.

Alternate Procedure

If you are unable to prime the system due to an equipment failure, decontaminate the
instrument and the dispense module as follows:

1. Perform the procedures under Clean the Dispense Tubes and Injectors on page 65.

2. Prepare an aqueous solution of 0.50% sodium hypochlorite (bleach). If the effects
of bleach are a concern, 70% isopropyl alcohol may be used.

Check the percent NaClO of the bleach you are using. Commercial bleach is
typically 10.0% NaClO; prepare a 1:20 dilution. Household bleach is
typically 5.0% NaClO; prepare a 1:10 dilution.

3. Slide the microplate carrier out of the instrument.

4. Wet a cloth or paper towel with the bleach solution or alcohol, and then
thoroughly wring it out so that liquid does not drip from it.

5. Use the cloth to wipe:

o All exterior surfaces of the instrument

o All surfaces of the plate carrier

o The exposed surfaces of the dispense module, including the syringe valves

6. Remove the tubing and the syringes from the dispense module and soak them in
the bleach or alcohol solution. Wait for 20 minutes.
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To remove a syringe: In Gen5, click System > Instrument Control >
Synergy H1. On the Prime tab, select a dispenser and clickMaintenance.
The syringe bracket will move to its furthest-from-home position. Remove
the metal thumbscrew from underneath the bracket. Unscrew the top of the
syringe from the bottom of the syringe drive. Gently remove the syringe.

7. Moisten a cloth with DI or distilled water and wipe all surfaces that have been
cleaned with the bleach solution or alcohol.

8. Rinse all tubing and the syringes with DI water.

9. Use a clean, dry cloth to dry all surfaces on the instrument and the dispense
module.

10. Reassemble the dispense module as necessary.

11. Discard the used gloves and cloths using a biohazard trash bag and an approved
biohazard container.

Dispense Module, Syringe Replacement

Refer to theMaintenance chapter for cleaning procedures you must perform regularly and
also in the case of poor performance (for example, when the Dispense Accuracy and
Precision tests fail). If cleaning the injection system does not eliminate performance
problems, or if a syringe is leaking, perform these instructions to replace a faulty syringe.
Contact Technical Support to order replacement syringes.

To change a syringe, first use Gen5 to put the syringe in its maintenance position.

Syringe Maintenance Position

Do not change the syringe position or calibrate the dispensers unless
instructed to do so as part of installation, upgrade, or maintenance.

Gen5 provides access to syringe setup functions for maintenance and calibration purposes.
When a syringe needs to be installed or replaced, it must first be moved to its “maintenance
position.”

1. In Gen5, select System > Instrument Control > Synergy H1 and click the Prime
tab (or Dispenser tab, if using Gen5 v2.05 or lower).

2. Select the appropriate Dispenser number (1 or 2) associated with the syringe.

3. ClickMaintenance. The syringe plunger will move to its furthest-from-home
position. The syringe can then be disconnected from the drive bracket and unscrewed
from the valve.
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Replace the Syringe

Refer to Figure 2-5 on page 18.

After using Gen5 to move the syringe into its maintenance position:

1. Using your fingers, unscrew the bottom thumbscrew that secures the syringe,
underneath the bracket. Retain this bottom thumbscrew; it is needed for the
replacement syringe.

2. Unscrew the top thumbscrew to disengage the syringe from the valve.

3. Remove the new syringe from its protective box.

4. Hold the syringe vertically with the threaded end at the top. Screw the top of the
syringe into the bottom of the syringe valve. Finger-tighten only.

5. Carefully pull down the bottom of the syringe until it rests inside the hole in the
bracket.

6. Pass the thumbscrew (used to hold the old syringe) up through this hole and thread it
into the bottom of the syringe. Hold the syringe from rotating while tightening the
thumbscrew. Finger-tighten only.

7. In Gen5, select System > Instrument Control > Synergy H1.

8. Click the Prime tab and click Initialize.
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Chapter 7

Instrument Qualification Process
This chapter describes the tests that BioTek Instruments, Inc. has
developed for complete qualification of all models of the Synergy H1.
This chapter introduces the various test methods, describes the
materials and relevant Gen5 protocols used to execute the tests,
explains how to analyze test results, and provides troubleshooting tips
in the event of a failure.

Instrument Qualification Procedures starting on page 113 contains
the actual step-by-step test procedures.

Instrument System Test 76
Plate Shaker Test 76
Absorbance Testing 77
Luminescence Testing 85
Fluorescence Testing 89
Injection System Testing 108



Instrument System Test

Each time the Synergy H1 is turned on, it automatically performs a series of tests on the
reader’s motors, lamp(s), the PMT, and various sub-systems. The duration of this “system
test” depends on the reader model and can take a few minutes to complete. If all tests
pass, the microplate carrier will eject and the LED on the power switch will remain on and
constant. The reader is then ready for use.

If any test results do not meet the internally coded Failure Mode Effects Analysis (FMEA)
criteria established by BioTek, the reader will beep repeatedly and the LED on the power
switch will flash. If this occurs, press the carrier eject button to stop the beeping. If
necessary, initiate another system test using Gen5 to try to retrieve an error code from the
reader.

Refer to Error Codes starting on page 153 for information on error codes and
troubleshooting tips.

Refer to Sample Reports on page 163 to see a sample System Test Report for Synergy
H1.

Plate Shaker Test

This test verifies that the multi-speed plate shaker is operating properly. The test involves
creating and running a protocol with shaking enabled for a duration of 30 seconds. The
sound of the carrier shaking is all that needs to be confirmed to verify that the plate shaker
is operating properly.
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Absorbance Testing

For models with absorbance capability, BioTek developed a series of tests for the
absorbance system using a combination of solid state Absorbance Test Plates and liquid
plates. The test plates and the materials used for creating the liquid plates are available for
purchase from BioTek.

To qualify the absorbance system for the Synergy H1, you should perform:

l Absorbance Liquid Test 1 and Absorbance Plate Test (using PN 7260522) or

l Absorbance Liquid Test 2

Optionally, to qualify operation in the UV range, you should also perform:

l Absorbance Liquid Test 3 or Absorbance Plate Test at 340 nm (using PN 7260551)

BioTek Absorbance Test Plates

Absorbance Test Plate PN 7260522 uses NIST-traceable neutral density filters to confirm
absorbance specifications in the visible range (400–800 nm). This test plate also contains
precision-machined holes to verify mechanical alignment, and a glass filter in position C6 to
test the wavelength accuracy of the monochromator-based absorbance system.
Absorbance Test Plate PN 7260551 uses NIST-traceable neutral density filters to confirm
absorbance specifications in the UV range (340 nm).

Every test plate comes with a Test Plate Calibration Certificate, containing a table with
Absorbance OD Standards for each filter at each wavelength supported by the plate. The
certificate for test plate PN 7260522 also contains Wavelength Accuracy Standards tables
with Expected Peak (nm) values with Test Ranges for the C6 glass filter.

Before the Absorbance Plate Test can be performed, the OD Standard values and Expected
Peak/Test Range combinations must be entered into Gen5. Enter and save these values
once initially, and then update them annually when the test plate is recertified by BioTek.

Test Methods

The Absorbance Plate Test is conducted using Gen5 software (System > Diagnostics
> Test Plates) to confirm wavelength accuracy ("Peak Absorbance"); mechanical
alignment; and optical density accuracy, linearity, and repeatability. When complete,
Gen5 generates a results report displaying Pass or Fail for each individual test.

l Peak Absorbance: The PN 7260522 test plate contains a glass filter in position C6
that is used to check the wavelength accuracy of the absorbance monochromator.
The filter is scanned across a specified wavelength range in 1-nm increments. The
wavelength(s) of maximum absorbance are compared to the expected peak
wavelength(s) supplied on the test plate’s data sheet. The accuracy of the
wavelength should be ± 3 nm (±2 nm instrument, ±1 nm filter allowance).

Synergy H1 Operator's Manual

Absorbance Testing | 77



l Alignment: The test plate has precisely machined holes to confirm mechanical
alignment. The amount of light that shines through these holes is an indication of
whether the microplate carrier is properly aligned with the absorbance optical path. A
reading of more than 0.015 OD for any of the designated alignment holes indicates
that the light is being “clipped” and the reader may be out of alignment.

l Accuracy: The test plate contains NIST-traceable neutral-density glass filters of
known OD values at one or more wavelengths. Actual measurements are compared
against the expected values provided in the test plate’s data sheet. Since there are
several filters with differing OD values, the accuracy across a range of ODs can be
established. Once it is proven that the reader is accurate at these OD values, the
reader is also considered to be linear. To further verify this, you can perform a linear
regression analysis on the test plate OD values in a program such as Microsoft Excel;
an R2 value of at least 0.9900 is expected.

l Repeatability: This test ensures the instrument meets its repeatability specification
by conducting repeated reads of each neutral-density filter on the test plate and
comparing the results.

Sample Test Report

Refer to Sample Reports on page 163 to see a sample Absorbance Plate Test Report for
Synergy H1.

Troubleshooting

If a test fails, try the troubleshooting tips below. If the test continues to fail, contact
Technical Support.

Important! Do not remove filters from the Absorbance Test Plate.
Do not use alcohol or other cleaning agents, and do not touch the
filters with your bare fingers.

If a higher-OD well reports "#N/A" for Min/Max Limit and Result,
the measured OD is beyond the specified range for Accuracy or
Repeatability used with this test, and therefore no pass/fail
determination is made. It does not indicate a test failure.

Peak Absorbance Test

l Check the filter in the C6 position to ensure it is clean. If needed, clean the filter with
lens paper. Do not remove the filter, and do not use alcohol or other cleaning agents.

l Verify that the Peak wavelength information entered for the plate in Gen5 matches
the information provided on the test plate's data sheet.

l Check the calibration due date on the test plate's label. If the test plate is overdue for
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recalibration, contact Technical Support to schedule service.

l Check the microplate carrier to ensure it is clear of debris.

Alignment Test

l Ensure that the test plate is properly seated in the microplate carrier.

l Check the four alignment holes (A1, A12, H1, H12) to ensure they are clear of debris.

l Check the microplate carrier to ensure it is clear of debris.

Accuracy Test

l Check the neutral-density filters to ensure they clean (positions C1, D4, E2, F5, G3,
H6). If needed, clean the filters with lens paper. Do not remove any filters, and do not
use alcohol or other cleaning agents.

l Verify that the wavelength/expected OD values entered for the plate in Gen5 match
the information provided on the test plate's data sheet.

l Check the calibration due date on the test plate's label. If the test plate is overdue for
recalibration, contact Technical Support to schedule service.

Repeatability Test

l Check the neutral-density filters to ensure there is no debris that may have shifted
between readings and caused changes.

l Check the microplate carrier to ensure it is clear of debris.

Absorbance Liquid Tests

BioTek Instruments, Inc. has developed a series of liquid test procedures for testing your
reader's absorbance system.

Test Methods

Absorbance Liquid Test 1 confirms repeatability and alignment of the reader when a
solution is used in the microplate. If these tests pass, then the lens placement and
optical system cleanliness are proven. For the Repeatability portion of this test, two
columns containing a color-absorbing solution are read five times at 405 nm. For each
well, an "allowed deviation" is determined based on its Mean OD and the reader's
repeatability specification. Each well's Standard Deviation must be less than its Allowed
Deviation to pass. To confirm the reader’s mechanical alignment, the plate is rotated
180 degrees in the carrier (e.g., A1 is now in the H12 position) and the same two
columns are read. The initial and new OD readings are compared, using the reader's
accuracy specification. If the two readings in the same well do not meet specification,
the reader may be out of alignment.
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If an Absorbance Test Plate is not available, Absorbance Liquid Test 2may be
conducted to test the instrument's alignment, repeatability, and accuracy by preparing a
series of solutions of varying OD values as described on page 122.

Absorbance Liquid Test 3 is an optional test offered for those sites that must have
proof of linearity at 340 nm. (Alternatively, the BioTek 340 nm Absorbance Test Plate
may be used; see page 77.) This test is optional since the Synergy H1 has good “front-
end” linearity throughout the specified wavelength range. While the absolute values of
the OD cannot be determined by this test, the results will indicate if there is adequate
repeatable absorbance and a linear slope. This method is dependent upon proper dye
dilution and a skilled pipetting technique. It is expected that the first dilution (mid-level
solution) will have an absorbance value near 75% of that of the stock (high-level)
solution, and that the second dilution (low-level solution) will have an absorbance value
near 50% of that of the stock solution.

Gen5 Protocol Parameters

The information in this section represents the recommended reading parameters for the
referenced Gen5 protocol(s). It is possible that your tests will require modifications to some
of these parameters, such as the Plate Type.

i The Plate Type setting in each Gen5 protocol should match the actual plate in use.

Synergy H1 Abs Test 1.prt

Parameter Setting

Plate Type 96 WELL PLATE

Shake Step Linear, 4 minutes, default frequency

Two Read Steps

Kinetic loop (one per Read step) Set a Run Time/Interval combination to read the
plate five times with minimal delay

Detection Method Absorbance

Read Type Endpoint

Optics Type Monochromators

Read wells First Read step: A1..H2
Second Read step: A11..H12

Wavelength 405 nm

Read Speed Normal

Delay after plate movement 100 msec

Plate Out,In step between loops Text "rotate the plate 180 degrees"

80 | Chapter 7: Instrument Qualification Process

BioTek Instruments, Inc.



Synergy H1 Abs Test 2.prt

Parameter Setting

Plate Type 96 WELL PLATE

Shake Step Linear, 4 minutes, default frequency

Two Read Steps

Kinetic loop (one per Read step) Set a Run Time/Interval combination to read the
plate five times with minimal delay

Detection Method Absorbance

Read Type Endpoint

Optics Type Monochromators

Step labels First Read step: "Normal"
Second Read step: "Turnaround"

Read wells Full plate

Wavelengths 2 (450 nm, 630 nm)

Read Speed Normal

Delay after plate movement 100 msec

Data Reduction Define two Delta OD transformations (450-630
nm), one per Read data set

Synergy H1 Abs Test 3.prt

Parameter Setting

Plate Type 96 WELL PLATE

Shake Step Linear, 30 seconds, default frequency

Kinetic loop Set a Run Time/Interval combination to read the
plate five times with minimal delay

Detection Method Absorbance

Read Type Endpoint

Optics Type Monochromators

Read wells A1..H6

Wavelength 340 nm

Read Speed Normal

Delay after plate movement 100 msec
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Results Analysis

The Absorbance Liquid Test procedures begin on page 120.

Absorbance specifications used with the liquid tests:

Accuracy:

± 1.0% ± 0.010 OD from 0.000 to 2.000 OD
± 3.0% ± 0.010 OD from 2.000 OD to 2.500 OD

Repeatability:

± 1.0% ± 0.005 OD from 0.000 to 2.000 OD
± 3.0% ± 0.005 OD from 2.000 OD to 2.500 OD

Absorbance Liquid Test 1

1. The plate is read five times in the “Normal” position at 405 nm. Calculate the Mean
OD and Standard Deviation of those five reads for each well in columns 1 and 2.

2. For each well in columns 1 and 2, calculate the Allowed Deviation using the
Repeatability specification for a 96-well plate (Mean OD x 0.010 + 0.005). For
each well, its Standard Deviation should be less than its Allowed Deviation.

Example: Five readings in well A1 of 0.802, 0.802, 0.799, 0.798, and 0.801 result
in a Mean of 0.8004 and a Standard Deviation of 0.0018. The Mean multiplied by
1.0% (0.8004 * 0.010) equals 0.008, and when added to 0.005 equals 0.013; this
is the Allowed Deviation for well A1. Since the Standard Deviation for well A1 is
less than 0.013, the well meets the test criteria.

3. The plate is read five times in the “Turnaround” position at 405 nm. Calculate the
Mean OD of those five reads for each well in columns 11 and 12.

4. Perform a mathematical comparison of the Mean values for each well in its Normal
and Turnaround positions (that is, compare A1 to H12, A2 to H11, B1 to G12,… H2
to A11). To pass the test, the differences in the compared Mean values must be
within the Accuracy specification for a 96-well microplate.

Example: If the Mean value for well A1 in the Normal position is 1.902 with a
specified accuracy of ±1.0% ±0.010 OD, then the expected range for the Mean of
the well in its Turnaround (H12) position is 1.873 to 1.931 OD. 1.902 x 0.010 +
0.010 = 0.029; 1.902 - 0.029 = 1.873; 1.902 + 0.029 = 1.931.

Absorbance Liquid Test 2

1. The plate is read five times at 450/630 nm ("Normal" position), resulting in five
sets of Delta OD data. Calculate results for Linearity:

o Calculate the mean absorbance for each well, and average the means for each
concentration.

o Perform a regression analysis on the data to determine if there is adequate
linearity. Since it is somewhat difficult to achieve high pipetting accuracy when
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conducting linear dilutions, an R2 value of at least 0.9900 is considered
adequate.

2. Calculate the results for Repeatability:

o Calculate the Mean and Standard Deviation for the five readings taken at each
concentration. Only one row of data needs to be analyzed.

o For each Mean below 2.000 OD, calculate the Allowed Deviation using the
Repeatability specification for a 96-well plate of ±1.0% ±0.005 OD. (If above
2.000 OD, apply the ±3.0% ±0.005 specification.)

o The Standard Deviation for each set of readings should be less than the Allowed
Deviation.

Example: Readings of 1.950, 1.948, 1.955, 1.952, and 1.950 will result in a
Mean of 1.951, and a Standard Deviation of 0.0026. The Mean (1.951)
multiplied by 1.0% (1.951 x 0.010) = 0.0195, which, when added to the 0.005
(0.0195 + 0.005) = 0.0245 OD, which is the Allowed Deviation. Since the
Standard Deviation is less than this value, the reader meets the test criteria.

3. After gathering data for the Linearity Test, the plate is read five more times with
the A1 well in the H12 position ("Turnaround" position). This results in values for
the four corner wells that can be used to assess alignment. Calculate results for
the Alignment Test:

o Calculate the means of the wells A1 and H1 in the Normal plate position (data
from Linearity Test) and in the Turnaround position.

o Compare the mean reading for well A1 to its mean reading when in the H12
position. Next, compare the mean values for the H1 well to the same well in the
A12 position. The difference in the values for any two corresponding wells
should be within the Accuracy specification for 96-well plates. If the four corner
wells are within the accuracy range, the reader is in alignment.

Example: If the mean of well A1 in the normal position is 1.902, where the
specified accuracy is ±1.0% ±0.010 OD, then the expected range for the mean
of the same well in the H12 position is 1.873 to 1.931 OD. (1.902 x 1.0% =
0.019 + 0.010 = 0.029, which is added to and subtracted from 1.902 for the
range.)

Absorbance Liquid Test 3

1. The plate is read five times at 340 nm. For each well, calculate the Mean OD and
Standard Deviation of the five readings.

2. For each Mean calculated in step 1, calculate the Allowed Deviation using the
Repeatability specification for a 96-well plate (Mean OD x 0.010 + 0.005). For
each well, its Standard Deviation should be less than its Allowed Deviation.

Example: Five readings in well A1 of 0.802, 0.802, 0.799, 0.798, and 0.801 result
in a Mean of 0.8004 and a Standard Deviation of 0.0018. The Mean multiplied by
1.0% (0.8004 * 0.010) equals 0.008, and when added to 0.005 equals 0.013; this
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is the Allowed Deviation for well A1. Since the Standard Deviation for well A1 is
less than 0.013, the well meets the test criteria.

3. Calculate results for Linearity:

o For each of the three test solutions, calculate the average Mean OD for the wells
containing that solution (mean of wells A1 to H2, A3 to H4, and A5 to H6).

o Perform a regression analysis on the data to determine if there is adequate
linearity. The three average Mean OD values are the “Y” values. The solution
concentrations are the “X” values (1.00, 0.75, 0.50). Since it is somewhat
difficult to achieve high pipetting accuracy when conducting linear dilutions, an
R2 value of at least 0.9900 is considered adequate.

Troubleshooting

If an absorbance liquid test fails, try the following. If a test continues to fail, contact
Technical Support.

l Check the microwells and plate carrier for debris that may have shifted and caused
changes.

l Ensure the microplate is properly seated in the carrier.

l As applicable, confirm that the plate was properly oriented in the "Normal" and
"Turnaround" positions.

l Liquid Test 1 can fail due to the meniscus effect, which can cause readings to
decrease over time. If you suspect this may be the case, include a shake step
between the read steps in the protocol.
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Luminescence Testing

For models with luminescence capability, the Harta Luminometer Reference Microplate can
be used to test the luminescence system. The test plate is LED-based and NIST-traceable.
Contact Technical Support to purchase a plate (PN 8030015; includes microplate carrier
adapters) or visit www.HartaInstruments.com to learn more.

Test Method

The Harta Luminometer Reference Microplate is used to determine a detection limit by
leveraging a known correlation of 35 photons per attomole of ATP. By using the NIST data
provided with the Harta plate in photons/s, a conversion factor of 0.02884 attomole/photon
is applied to determine an ATP concentration and subsequent limit of detection for the
instrument under test.

Gen5 Protocol Parameters

The information in this section represents the recommended reading parameters for the
referenced Gen5 protocol(s).

Synergy H1 F-LumTest_Harta.prt

Parameter Setting

Plate Type If present "8030015 Harta - w/o 8032028
adapter" otherwise "Costar 96 black opaque"

Delay Step 3 minutes

READ STEP 1

Detection Method Luminescence

Read Type Endpoint

Optics Type Filters

Step Label Reference well A2

Read well A2

Filter Set 1 (filter cube)

Excitation Plug

Emission Hole

Gain 135

Integration Time 0:10.00 MM:SS.ss

Delay After Plate Movement 350 msec

Dynamic Range Standard

Read Height 7.00 mm
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Parameter Setting

READ STEP 2

Detection Method Luminescence

Read Type Endpoint

Optics Type Filters

Step Label Background

Read wells D1–G4

Filter Set 1 (filter cube)

Excitation Plug

Emission Hole

Gain 135

Integration Time 0:10.00 MM:SS.ss

Delay After Plate Movement 350 msec

Dynamic Range Standard

Read Height 7.00 mm

READ STEP 3

Detection Method Luminescence

Read Type Endpoint

Optics Type Filters

Step Label Battery check

Read wells A7–A8

Filter Set 1 (filter cube)

Excitation Plug

Emission Hole

Gain 60

Integration Time 0:01.00 MM:SS.ss

Delay After Plate Movement 350 msec

Dynamic Range Extended

Read Height 10.00 mm
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Synergy H1 M-LumTest_Harta.prt

The same as the filter-based test, with these exceptions:

Parameter Setting

READ STEP 1

Optics Type Luminescence Fiber

Filter Set <none>

Gain 150

Read Height 1.00 mm

READ STEP 2

Optics Type Luminescence Fiber

Read wells F1-G12

Filter Set <none>

Gain 150

Read Height 1.00 mm

READ STEP 3

Optics Type Luminescence Fiber

Filter Set <none>

Gain 80

Read Height 1.00 mm

Results Analysis

The Luminescence Test procedure is described on page 125.

1. Determine if the plate’s battery is functioning properly. If A8 > (0.2 * A7), the
battery is good. Otherwise, it requires replacement.

A replacement battery is included with each new and recalibrated Harta
Luminometer Reference Microplate.

2. On the Harta plate’s calibration certificate, locate the NIST measurement for the A2
position. Convert it to attomoles: (A2 NIST measurement * 0.02884)

3. Calculate the signal-to-noise ratio: (A2–Mean of the buffer cells)/(3 * Standard
deviation of buffer cells)

4. Calculate the detection limit: A2 NIST measurement in attomoles/signal-to-noise
ratio
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Pass/Fail Criteria

l If the reader is equipped with the low-noise PMT, the detection limit must be <=75
amol to pass.

l If the reader is equipped with the red-shifted PMT, the detection limit must be <=500
amol to pass.

If you do not know which PMT is installed (#49984=low-noise PMT;
#49721=red-shifted PMT), please contact Technical Support.

Troubleshooting

If a test fails, try the suggestions below. If a test continues to fail, contact Technical
Support.

l Ensure that the reading is performed through a hole in the filter cube, not through a
glass filter.

l Verify that the filter cube definition in Gen5 matches the physical item.

l The optical probe(s)may need to be cleaned; contact Technical Support for
guidance.
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Fluorescence Testing

For models with fluorescence capability, two options are available for testing the
fluorescence system. One uses a solid state Fluorescence Test Plate (package PN
1400501*). The other uses liquid plates, the materials for which are available for purchase
(see Materials for Conducting Liquid Tests on page 6).

*Fluorescence Test Plate PN 7092092 cannot be used for these tests.

BioTek Fluorescence Test Plate

The Fluorescence Test Plate simplifies the process for conducting fluorescence intensity,
fluorescence polarization, and time-resolved fluorescence qualification tests on the
Synergy H1. The test plate is solid and therefore immune to the pipetting errors,
evaporation issues, and costs experienced with conventional Liquid Tests.

The test plate package includes Gen5 protocols* designed specifically for use with the test
plate. The protocols include embedded Microsoft Excel spreadsheets to automatically
calculate results and determine pass/fail. The protocols and their spreadsheets were fully
validated in accordance with BioTek Instruments' Product Validation policies and
procedures. *Gen5 version 2.06 or higher is required.

The package also contains a User Guide that describes the test methods, helps you get
started with using the plate, and provides important information for cleaning and
maintaining the test plate. The guide also provides troubleshooting tips and information on
the annual recalibration program.

Results Analysis

Refer to the Fluorescence Test Plate User Guide for descriptions of the data reduction
calculations for each test. The tests must meet the following criteria to pass:

Corners Test %CV < 3.0

Sensitivity Tests:

Filters, Top, SF Detection Limit <= 10 pM

Monochromators, Top, SF Detection Limit <= 20 pM

Monochromators, Bottom, SF Detection Limit <= 20 pM

Filters, Top, MUB Detection Limit <= 160 pg/mL

Monochromators, Top, MUB Detection Limit <= 160 pg/mL

Monochromators, Bottom, MUB Detection Limit <= 160 pg/mL

Linearity Test R2 >= 0.9500 confirms that the system is linear

Time-Resolved Fluorescence (TRF) Test Detection Limit <= 250 fM

Fluorescence Polarization (FP) Test Mean PHPR > 340 mP, STD PLPR < 5 mP
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Fluorescence Liquid Tests

Test Methods

l Corners: The Corners Test uses fluorescent compounds to verify that the plate
carrier is properly aligned in relation to the fluorescence probe(s). This test may be
conducted using either the top or bottom optics (as supported by your reader model).

l Fluorescence Intensity (Sensitivity): The Sensitivity Test measures a
fluorescent compound (Sodium Fluorescein or Methylumbelliferone) and buffer
solution to test the fluorescence reading capability of the instrument. The ability to
detect specific compounds at the required limit of detection ensures that the filters,
optical path, and PMT are all in working order. This test establishes the detection limit
of the instrument, which is described as the lowest concentration that will create a
signal that is statistically distinguishable from the buffer well. This test may be
conducted using either the top or bottom optics (as supported by your reader model).

l Linearity: The Linearity Test verifies that the system is linear, that is, signal changes
proportionally with changes in concentration. This test may be conducted using
either the top or bottom optics (as supported by your reader model).

l Fluorescence Polarization: The optional FP Test measures high- and low-polarized
samples to verify the instrument's ability to measure polarization of a liquid
fluorophore and confirm that the excitation and emission polarizers are properly
oriented in the instrument. This test is conducted using only the top optics.

l Time-Resolved Fluorescence: The optional TRF Test measures a fluorescent
compound (Europium) and buffer solution to test the time-resolved fluorescence
reading capability of the instrument. The ability to detect specific compounds at the
required limit of detection ensures that the filters, optical path, and PMT are all in
working order. This test establishes the detection limit of the instrument, which is
described as the lowest concentration that will create a signal that is statistically
distinguishable from the buffer well. This test is conducted using only the top optics.

Gen5 Protocol Parameters

The information in this section represents the recommended reading parameters for the
Gen5 protocols used with liquid testing. It is possible that your tests will require
modifications to some of these parameters, such as the Plate Type.

i The Plate Type setting in each Gen5 protocol should match the actual plate in use.
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Synergy H1 FI_T_SF.prt

Parameter Setting

Plate Type "Costar 96 black opaque" (#3915)

Read Step 1

Kinetic loop Run time 0:01:00, Interval 0:00:04 (16 reads)

Detection Method Fluorescence intensity

Read Type Endpoint / Kinetic

Optics Type Filters

Step Label "Sensitivity Read"

Read well D7

Filter Set 1 ("Green")

Excitation 485/20 nm

Emission 528/20 nm

Optics Position Top 510 nm

Gain Auto, Scale to High Wells, D7, 50000

Read Speed Normal

Delay after plate movement 350 msec

Measurements per data point 40

Lamp Energy Low (faster)

Read Height 7.00 mm

Read Step 2

Kinetic loop Run time 0:01:30, Interval 0:00:06 (16 reads)

Detection Method Fluorescence intensity

Read Type Endpoint / Kinetic

Optics Type Filters

Step Label "Sensitivity Read Buffer"

Read well C9, D9, E9

Filter Set 1 ("Green")

Excitation 485/20 nm

Emission 528/20 nm

Optics Position Top 510 nm

Gain Auto, Use first filter set gain from FIRST read
step

Read Speed Normal

Delay after plate movement 350 msec
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Measurements per data point 40

Lamp Energy Low (faster)

Read Height 7.00 mm

Read Step 3

Detection Method Fluorescence intensity

Read Type Endpoint / Kinetic

Optics Type Filters

Step Label "Corners Read"

Read well Full Plate (to support Gen5 v1.11)

Filter Set 1 ("Green")

Excitation 485/20 nm

Emission 528/20 nm

Optics Position Top 510 nm

Gain Auto, Scale to High Wells, A3, 50000

Read Speed Normal

Delay after plate movement 350 msec

Measurements per data point 40

Lamp Energy Low (faster)

Read Height 7.00 mm

Read Step 4

Detection Method Fluorescence intensity

Read Type Endpoint / Kinetic

Optics Type Filters

Step Label "Linearity Read"

Read well C1-F5

Filter Set 1 ("Green")

Excitation 485/20 nm

Emission 528/20 nm

Optics Position Top 510 nm

Gain Auto, Scale to High Wells, C1, 50000

Read Speed Normal

Delay after plate movement 350 msec

Measurements per data point 40

Lamp Energy Low (faster)

Read Height 7.00 mm
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Synergy H1 M_FI_T_SF.prt and Synergy H1 M_FI_B_SF.prt

Parameter Setting

Plate Type "Costar 96 black opaque" (Top)
"Greiner SensoPlate" (#655892) (Bottom)

Read Step 1

Kinetic loop Run time 0:01:00, Interval 0:00:04 (16 reads)

Detection Method Fluorescence

Read Type Endpoint / Kinetic

Optics Type Monochromators

Step Label "Sensitivity Read"

Read Well D7

Wavelengths 1

Excitation 485 nm

Emission 528 nm

Optics Position Top (or Bottom)

Gain Auto, Scale to High Wells, D7, 50000

Read Speed Normal

Delay after plate movement 350 msec

Measurements per data point 100

Lamp Energy Low (faster)

Read Height 7.00 mm (Top only)

Read Step 2

Kinetic loop Run time 0:01:30, Interval 0:00:06 (16 reads)

Detection Method Fluorescence

Read Type Endpoint / Kinetic

Optics Type Monochromators

Step Label "Sensitivity Read Buffer"

Read Well C9, D9, E9

Wavelengths 1

Excitation 485 nm

Emission 528 nm

Optics Position Top (or Bottom)

Gain Auto, Use first filter set gain from FIRST Read
Step

Read Speed Normal

Delay after plate movement 350 msec
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Parameter Setting

Measurements per data point 100

Lamp Energy Low (faster)

Read Height 7.00 mm (Top only)

Read Step 3

Detection Method Fluorescence intensity

Read Type Endpoint / Kinetic

Optics Type Filters

Step Label "Corners Read"

Read well Full Plate (to support Gen5 v1.11)

Filter Set 1 ("Green")

Excitation 485 nm

Emission 528 nm

Optics Position Top (or Bottom)

Gain Auto, Scale to High Wells, A3, 50000

Read Speed Normal

Delay after plate movement 350 msec

Measurements per data point 100

Lamp Energy Low (faster)

Read Height 7.00 mm (Top only)

Read Step 4

Detection Method Fluorescence intensity

Read Type Endpoint / Kinetic

Optics Type Filters

Step Label "Linearity Read"

Read well C1-F5

Filter Set 1 ("Green")

Excitation 485 nm

Emission 528 nm

Optics Position Top (or Bottom)

Gain Auto, Scale to High Wells, C1, 50000

Read Speed Normal

Delay after plate movement 350 msec

Measurements per data point 100

Lamp Energy Low (faster)
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Parameter Setting

Read Height 7.00 mm (Top only)

To create or edit the following protocol, you must have an H1M2 instrument connected
to the PC and turned on for the bandwidth fields to be visible.

Synergy H1 M2_FI_T_SF.prt and Synergy H1 M2_FI_B_SF.prt

Parameter Setting

Plate Type "Costar 96 black opaque" (Top)
"Greiner SensoPlate" (#655892) (Bottom)

Read Step 1

Kinetic loop Run time 0:01:00, Interval 0:00:04 (16 reads)

Detection Method Fluorescence

Read Type Endpoint / Kinetic

Optics Type Monochromators

Step Label "Sensitivity Read"

Read Well D7

Wavelengths 1

Excitation 485 nm/14 nm

Emission 528 nm/14 nm

Optics Position Top (or Bottom)

Gain Auto, Scale to High Wells, D7, 50000

Read Speed Normal

Delay after plate movement 350 msec

Measurements per data point 100

Lamp Energy Low (faster)

Read Height 7.00 mm (Top only)

Read Step 2

Kinetic loop Run time 0:01:30, Interval 0:00:06 (16 reads)

Detection Method Fluorescence

Read Type Endpoint / Kinetic

Optics Type Monochromators

Step Label "Sensitivity Read Buffer"

Read Well C9, D9, E9

Wavelengths 1

Excitation 485 nm/14 nm
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Parameter Setting

Emission 528 nm/14 nm

Optics Position Top (or Bottom)

Gain Auto, Use first filter set gain from FIRST Read
Step

Read Speed Normal

Delay after plate movement 350 msec

Measurements per data point 100

Lamp Energy Low (faster)

Read Height 7.00 mm (Top only)

Read Step 3

Detection Method Fluorescence intensity

Read Type Endpoint / Kinetic

Optics Type Filters

Step Label "Corners Read"

Read well Full Plate (to support Gen5 v1.11)

Filter Set 1 ("Green")

Excitation 485 nm/14 nm

Emission 528 nm/14 nm

Optics Position Top (or Bottom)

Gain Auto, Scale to High Wells, A3, 50000

Read Speed Normal

Delay after plate movement 350 msec

Measurements per data point 100

Lamp Energy Low (faster)

Read Height 7.00 mm (Top only)

Read Step 4

Detection Method Fluorescence intensity

Read Type Endpoint / Kinetic

Optics Type Filters

Step Label "Linearity Read"

Read well C1-F5

Filter Set 1 ("Green")

Excitation 485 nm/14 nm

Emission 528 nm/14 nm
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Parameter Setting

Optics Position Top (or Bottom)

Gain Auto, Scale to High Wells, C1, 50000

Read Speed Normal

Delay after plate movement 350 msec

Measurements per data point 100

Lamp Energy Low (faster)

Read Height 7.00 mm (Top only)

Synergy H1 FP.prt

Parameter Setting

Plate Type "Costar 96 black opaque" (#3915)

Synchronized Mode Plate mode with timing control

Detection Method Fluorescence polarization

Read Type Endpoint / Kinetic

Optics Type Filters

Read wells A6–H8

Filter Set 1 ("FP")

Excitation 485/20 nm

Emission 528/20 nm

Optics Position Top 510 nm

Gain Auto, Scale to High Wells, A8, 10000

Read Speed Normal

Delay after plate movement 350 msec

Measurements per data point 60

Lamp Energy Low (faster)

Read Height 7.00 mm

Synergy H1 TRF.prt

Parameter Setting

Plate Type "Costar 96 white opaque" (#3912)

Delay Step 3 minutes

Shake Step Linear, 30 seconds, default frequency

Read Step 1

Kinetic loop Run time 0:00:30, Interval 0:00:02 (16 reads)
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Parameter Setting

Detection Method Time-resolved fluorescence

Read Type Endpoint / Kinetic

Optics Type Filters

Step Label "Sensitivity Read"

Read well A8

Filter Set 1 ("TRF")

Excitation 360/40 nm

Emission 620/40 nm

Optics Position Top 400 nm

Gain Auto, Scale to High Wells, A8, 50000

Read Speed Normal

Delay after plate movement 350 msec

Measurements per data point 20

Lamp Energy Low (faster)

Delay before collecting data 300 µsec

Data collection time 1000 µsec

Read Height 7.00 mm

Read Step 2

Kinetic loop Run time 0:00:45, Interval 0:00:03 (16 reads)

Detection Method Time-resolved fluorescence

Read Type Endpoint / Kinetic

Optics Type Filters

Step Label "Sensitivity Read Buffer"

Read well A6, B6, C6

Filter Set 1 ("TRF")

Excitation 360/40 nm

Emission 620/40 nm

Optics Position Top 400 nm

Gain Auto, Use first filter set sensitivity from
FIRST Read Step

Read Speed Normal

Delay after plate movement 350 msec

Measurements per data point 20

Lamp Energy Low (faster)
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Parameter Setting

Delay before collecting data 300 µsec

Data collection time 1000 µsec

Read Height 7.00 mm

Synergy H1 FI_T_MUB.prt

Parameter Setting

Plate Type "Costar 96 black opaque" (#3915)

Read Step 1

Kinetic loop Run time 0:01:00, Interval 0:00:04 (16 reads)

Detection Method Fluorescence intensity

Read Type Endpoint / Kinetic

Optics Type Filters

Step Label "Sensitivity Read"

Read well D7

Filter Set 1 ("Blue")

Excitation 360/40 nm

Emission 460/40 nm

Optics Position Top 400 nm

Gain Auto, Scale to High Wells, D7, 80000

Read Speed Normal

Delay after plate movement 350 msec

Measurements per data point 40

Lamp Energy Low (faster)

Read Height 7.00 mm

Read Step 2

Kinetic loop Run time 0:01:30, Interval 0:00:06 (16 reads)

Detection Method Fluorescence intensity

Read Type Endpoint / Kinetic

Optics Type Filters

Step Label "Sensitivity Read Buffer"

Read well C9, D9, E9

Filter Set 1 ("Blue")

Excitation 360/40 nm

Emission 460/40 nm
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Parameter Setting

Optics Position Top 400 nm

Gain Auto, Use first filter set gain from FIRST Read
Step

Read Speed Normal

Delay after plate movement 350 msec

Measurements per data point 40

Lamp Energy Low (faster)

Read Height 7.00 mm

Read Step 3

Detection Method Fluorescence intensity

Read Type Endpoint / Kinetic

Optics Type Filters

Step Label "Linearity Read"

Read well C1-F5

Filter Set 1 ("Blue")

Excitation 360/40 nm

Emission 460/40 nm

Optics Position Top 400 nm

Gain Auto, Scale to High Wells, C1, 80000

Read Speed Normal

Delay after plate movement 350 msec

Measurements per data point 40

Lamp Energy Low (faster)

Read Height 7.00 mm

Synergy H1 M_FI_T_MUB.prt

Parameter Setting

Plate Type "Costar 96 black opaque" (#3915)

Read Step 1

Kinetic loop Run time 0:01:00, Interval 0:00:04 (16 reads)

Detection Method Fluorescence intensity

Read Type Endpoint / Kinetic

Optics Type Monochromators

Step Label "Sensitivity Read"
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Parameter Setting

Read well D7

Filter Set 1

Excitation 360 nm

Emission 460 nm

Optics Position Top

Gain Auto, Scale to High Wells, D7, 80000

Read Speed Normal

Delay after plate movement 350 msec

Measurements per data point 100

Lamp Energy Low (faster)

Read Height 7.00 mm

Read Step 2

Kinetic loop Run time 0:01:30, Interval 0:00:06 (16 reads)

Detection Method Fluorescence intensity

Read Type Endpoint / Kinetic

Optics Type Monochromators

Step Label "Sensitivity Read Buffer"

Read well C9, D9, E9

Filter Set 1

Excitation 360 nm

Emission 460 nm

Optics Position Top

Gain Auto, Use first filter set gain from FIRST Read
Step

Read Speed Normal

Delay after plate movement 350 msec

Measurements per data point 100

Lamp Energy Low (faster)

Read Height 7.00 mm

Read Step 3

Detection Method Fluorescence intensity

Read Type Endpoint / Kinetic

Optics Type Filters

Step Label "Linearity Read"
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Parameter Setting

Read well C1-F5

Filter Set 1

Excitation 360 nm

Emission 460 nm

Optics Position Top

Gain Auto, Scale to High Wells, C1, 80000

Read Speed Normal

Delay after plate movement 350 msec

Measurements per data point 100

Lamp Energy Low (faster)

Read Height 7.00 mm

To create or edit the following protocol, you must have an H1M2 instrument connected
to the PC and turned on for the bandwidth fields to be visible.

Synergy H1 M2_FI_T_MUB.prt

Parameter Setting

Plate Type "Costar 96 black opaque" (#3915)

Read Step 1

Kinetic loop Run time 0:01:00, Interval 0:00:04 (16 reads)

Detection Method Fluorescence intensity

Read Type Endpoint / Kinetic

Optics Type Monochromators

Step Label "Sensitivity Read"

Read well D7

Filter Set 1

Excitation 360 nm/14 nm

Emission 460 nm/14 nm

Optics Position Top

Gain Auto, Scale to High Wells, D7, 80000

Read Speed Normal

Delay after plate movement 350 msec

Measurements per data point 100

Lamp Energy Low (faster)
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Parameter Setting

Read Height 7.00 mm

Read Step 2

Kinetic loop Run time 0:01:30, Interval 0:00:06 (16 reads)

Detection Method Fluorescence intensity

Read Type Endpoint / Kinetic

Optics Type Monochromators

Step Label "Sensitivity Read Buffer"

Read well C9, D9, E9

Filter Set 1

Excitation 360 nm/14 nm

Emission 460 nm/14 nm

Optics Position Top

Gain Auto, Use first filter set gain from FIRST Read
Step

Read Speed Normal

Delay after plate movement 350 msec

Measurements per data point 100

Lamp Energy Low (faster)

Read Height 7.00 mm

Read Step 3

Detection Method Fluorescence intensity

Read Type Endpoint / Kinetic

Optics Type Filters

Step Label "Linearity Read"

Read well C1-F5

Filter Set 1

Excitation 360 nm/14 nm

Emission 460 nm/14 nm

Optics Position Top

Gain Auto, Scale to High Wells, C1, 80000

Read Speed Normal

Delay after plate movement 350 msec

Measurements per data point 100

Lamp Energy Low (faster)

Read Height 7.00 mm
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Results Analysis

The Fluorescence Liquid Test procedures begin on page 127.

Corners Test

1. Calculate the Mean of the 12 "corner" wells (A1–A3, A10–A12, H1–H3, and H10–
H12).

2. Calculate the Standard Deviation of the same 12 wells.

3. Calculate the %CV: (Standard Deviation/Mean)*100

The %CV must be <3.0 to pass.

Sensitivity Test

1. Calculate the Mean and Standard Deviation of the 16 reads for each of the buffer
wells (C9, D9, E9).

2. Among the three buffer wells, find the Median Standard Deviation and
corresponding Mean.

3. Calculate the Mean for the 16 reads of the SF (or MUB) Concentration well (D7).

4. Calculate the Signal-to-Noise Ratio (SNR) using the Mean SF (or MUB)
Concentration, Buffer Median STD with its corresponding Buffer Mean:

(<SF or MUB>Mean-BufferMean)/(3*BufferSTD)

5. Calculate the Detection Limit:

Sodium Fluorescein: Using the known concentration value of SF and the
calculated SNR: 1000/SNR

o Filter-based system, top optics: The Detection Limit must be <=10 pM (2
pg/mL) to pass.

o Monochromator-based system, top/bottom optics: The Detection Limit must be
<=20 pM (7.52 pg/mL) to pass.

Methylumbelliferone: Using the known concentration value of MUB and the
calculated SNR: 17.6/SNR

o Filter-based system, top optics: The Detection Limit must be <=0.160 ng/mL
to pass.

o Monochromator-based system, top optics: The Detection Limit must be
<=0.160 ng/mL to pass.

Linearity Test

1. Calculate the Mean of the four wells for each concentration in columns 1-5.

2. Perform linear regression using these values as inputs:
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Using Sodium Fluorescein

x y

1000 Mean of the 1000 pM wells

500 Mean of the 500 pM wells

250 Mean of the 250 pM wells

125 Mean of the 125 pM wells

62.5 Mean of the 62.5 pM wells

Using Methylumbelliferone

x y

100 Mean of the 100 nM wells

50 Mean of the 50 nM wells

25 Mean of the 25 nM wells

12.5 Mean of the 12.5 nM wells

6.25 Mean of the 6.25 nM wells

3. Calculate the R2 value; it must be >=0.9500 to pass.

Fluorescence Polarization (FP) Test

1. Using the raw data from the Parallel read:

o Calculate the Mean Blank (wells A6–H6).

o Calculate the Signal for each HPR well: Subtract the Mean Blank from its
measurement value.

o Calculate the Signal for each LPR well: Subtract the Mean Blank from its
measurement value.

2. Using the raw data from the Perpendicular read:

o Calculate the Mean Blank (wells A6–H6).

o Calculate the Signal for each HPR well: Subtract the Mean Blank from its
measurement value.

o Calculate the Signal for each LPR well: Subtract the Mean Blank from its
measurement value.

3. Calculate the G-Factor for each LPR well:

(Parallel LPR Signal*(1-0.02))/(Perpendicular LPR Signal*(1+0.02))

4. Calculate the Mean G-Factor.

5. Calculate the Polarization value in mP for each HPR well (“PHPR”):

(Parallel HPR Signal-Mean G Factor*Perpendicular HPR Signal)/(Parallel HPR
Signal+Mean G Factor*Perpendicular HPR Signal)*1000

6. Calculate the Mean PHPR, in mP.
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The Mean PHPR must be >340 mP to pass.

7. Calculate the Polarization value in mP for each LPR well (“PLPR”):

(Parallel LPR Signal-Mean G Factor*Perpendicular LPR Signal)/(Parallel LPR
Signal+Mean G Factor*Perpendicular LPR Signal)*1000

8. Calculate the Standard Deviation of the "PLPR", in mP.

The Standard Deviation of the PLPR must be <5 mP to pass.

Time-Resolved Fluorescence (TRF) Test

1. Calculate the Mean and Standard Deviation of the 16 reads for each of the buffer
wells (A6, B6, C6).

2. Among the three buffer wells, find the Median Standard Deviation and
corresponding Mean.

3. Calculate the Mean for the 16 reads of the Eu Concentration well (A8).

4. Calculate the Signal-to-Noise Ratio (SNR) using the Mean Eu Concentration and
Buffer Median STD with its corresponding Buffer Mean:

(Eu Mean - Buffer Mean)/(3 * Buffer STD)

5. Calculate the Detection Limit, in fM: 20000/SNR

The Detection Limit must be <=250 fM to pass.
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Troubleshooting

If a fluorescence liquid test fails, try the relevant suggestions below. If a test continues
to fail, print the results and contact Technical Support.

l Are the solutions fresh? Discard open/unused buffer and stock solutions after seven
days.

l Are the Excitation/Emission filters clean? Are they in the proper locations and in the
proper orientation in the filter cube or wheel?

l Are you using new/clean plates? If the base of a clear-bottom plate is touched, clean
the entire base with alcohol (95% ethanol) and then wipe with a lint-free cloth.
Before placing the plate in the instrument, blow the bottom of the plate with an
aerosol duster. If the test fails again, the optical probe(s) may need to be cleaned.
Contact Technical Support for instructions.

l Review the pipetting instructions to verify the plate was correctly prepared.

l Does the Plate Type setting in the Gen5 protocol match the plate you used?

l For injector models, spilled fluid inside the reader may be fluorescing, which can
corrupt your test results. If you suspect this is a problem, contact Technical Support
for assistance.

l When testing Fluorescence Polarization capability using a solid black plastic
microplate, if the standard deviation for the buffer wells is too high, try either moving
the buffer wells to another column, or using the Greiner SensoPlate. With some black
plastic plates, the wells in the center of the plate may be slightly distorted due to the
plate molding process, and this can affect the standard deviation.

l If the Corners Test continues to fail, the hardware may be misaligned. Contact
Technical Support.
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Injection System Testing

For models equipped with injectors and an external dispense module, BioTek has
developed a set of tests to ensure that the injection system performs to specification.

Test Method

The Accuracy Test is a measure of the mean volume per well for multiple dispenses. The
actual weight of the dispensed fluid is compared to the expected weight and must be within
a certain percentage to pass. Pass/Fail criteria depends on the per-well volume dispensed:
2.0% for 80 μL, 5.0% for 20 μL, and 20.0% for 5 μL.

The test uses a green dye test solution (available for purchase from BioTek, see page 6)
and one 96-well microplate per injector to test the three different volumes. The balance is
tared with the empty plate and the 80 μL dispense is performed for columns 1–4. The fluid
is weighed and the balance is tared again with the plate. This process is repeated for the 20
μL and 5 μL dispenses.

It is assumed that one gram is equal to one milliliter and the solutions used are at room
temperature. A three-place precision balance is used to weigh the plate.

The Precision Test is a measure of the variation among volumes dispensed to multiple
wells, and uses the green test dye solution. For each volume dispensed (80 μL, 20 μL, and 5
μL) to four columns, the %CV of 32 absorbance readings is calculated. Pass/Fail criteria
depends on the per-well volume dispensed: 2.0% for 80 μL, 7.0% for 20 μL, and 10.0% for
5 μL. Columns 1–4 are read at 405/750 nm and columns 5–12 at 630/750 nm.

The Accuracy and Precision tests are performed simultaneously and use the same plate.

Gen5 Parameters

The information in this section represents the recommended reading parameters for the
referenced Gen5 protocol(s). It is possible that your tests will require modifications to some
of these parameters, such as the Plate Type.

i The Plate Type setting in each Gen5 protocol should match the actual plate in use.

Synergy H1 Disp 1 Test.prt and Synergy H1 Disp 2 Test.prt (for use with models with
Absorbance capability)

Parameter Setting

Plate Type 96 WELL PLATE

Dispense Step Dispenser <1 or 2>
Wells A1–H4
Tip prime before this dispense step, 20 µL
Dispense 80 µL at 275 µL/sec

108 | Chapter 7: Instrument Qualification Process

BioTek Instruments, Inc.



Parameter Setting

Plate Out,In Comment: Weigh the plate (80 uL test). RECORD the weight, TARE
the balance. Place the plate back on the carrier. Click OK to
continue.

Dispense Step Dispenser <1 or 2>
Wells A5–H8
Tip prime before this dispense step, 20 µL
Dispense 20 µL at 250 µL/sec

Plate Out,In Comment: Weigh the plate (20 uL test). RECORD the weight, TARE
the balance. Place the plate back on the carrier. Click OK to
continue.

Dispense Step Dispenser <1 or 2>
Wells A9–H12
Tip prime before this dispense step, 5 µL
Dispense 5 µL at 225 µL/sec

Plate Out,In Comment: Weigh the plate (5 uL test). RECORD the weight, TARE
the balance. PIPETTE 150 µL/well of DI water into all 12 columns.
Place the plate back on the carrier. Click OK to perform the Read
steps.

Shake Step Linear, 15 seconds, default frequency

Read Step Detection Method: Absorbance
Read Type: Endpoint
Optics Type: Monochromator
Step label: 80 ul Read_Disp <1 or 2>
Wells: A1–H4
Wavelengths, 2: 405 nm, 750 nm
Speed: Normal

Read Step Detection Method: Absorbance
Read Type: Endpoint
Optics Type: Monochromator
Step label: 20 and 5 ul Read_Disp <1 or 2>
Wells: A5–H12
Wavelengths, 2: 630 nm, 750 nm
Speed: Normal

Data Reduction Define two Delta OD transformations:
405–750 nm for the 80 uL Read step, columns 1–4
630–750 nm for the 20 and 5 uL Read step, columns 5-12
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Synergy H1 Disp 1 Test No Read.prt and Synergy H1 Disp 2 Test No Read.prt (for
use with models without Absorbance capability)

Parameter Setting

Plate Type 96 WELL PLATE

Dispense Step Dispenser <1 or 2>
Wells A1..H4
Tip prime before this dispense step, 20 µL
Dispense 80 µL at 275 µL/sec

Plate Out,In Comment: Weigh the plate (80 uL test). RECORD the weight, TARE
the balance. Place the plate back on the carrier. Click OK to
continue.

Dispense Step Dispenser <1 or 2>
Wells A5..H8
Tip prime before this dispense step, 20 µL
Dispense 20 µL at 250 µL/sec

Plate Out,In Comment: Weigh the plate (20 uL test). RECORD the weight, TARE
the balance. Place the plate back on the carrier. Click OK to
continue.

Dispense Step Dispenser <1 or 2>
Wells A9..H12
Tip prime before this dispense step, 5 µL
Dispense 5 µL at 225 µL/sec

Plate Out,In Comment: Weigh the plate (5 uL test). RECORD the weight, TARE
the balance. PIPETTE 150 µL/well of DI water into all 12 columns.
Set the plate aside and click OK.

Read Step Define a brief Read step for a single well. The measurement value
will not be used. The step is only necessary because Gen5 requires
a Read step with dispense protocols.

Synergy H1 Disp Test Other Reader.prt (for use with a BioTek absorbance-capable
reader other than Synergy H1)

Parameter Setting

Shake Step <medium intensity> for 15 seconds

Read Step Detection Method: Absorbance
Read Type: Endpoint
Optics Type: <as appropriate for the reader type>
Step label: 80 ul Read
Wells: A1..H4
Wavelengths, 2: 405 nm, 750 nm
Speed: Normal
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Parameter Setting

Read Step Detection Method: Absorbance
Read Type: Endpoint
Optics Type: <as appropriate for the reader type>
Step label: 20 and 5 ul Read
Wells: A5..H12
Wavelengths, 2: 630 nm, 750 nm
Speed: Normal

Data Reduction Define two Delta OD transformations:
405-750 nm for the 80 ul Read step, columns 1-4
630-750 nm for the 20 and 5 ul Read step, columns 5-12

Results Analysis

The Injection System Test procedures begin on page 141.

When the experiment for one injector is complete, 32 delta OD values are reported for each
of the three dispense volumes. The pass/fail criteria for each set of 32 wells with the same
dispense volume is based on the calculated coefficient of variation (% CV) and Accuracy %
Error.

For each volume dispensed (80 μL, 20 μL, 5 μL), for each injector (1, 2):

1. Calculate the Standard Deviation of the 32 wells

2. Calculate the Mean of the 32 wells

3. Calculate the %CV: (Standard Deviation / Mean) x 100

4. Calculate the Accuracy % Error:

((ActualWeight–ExpectedWeight)/ExpectedWeight)* 100

Expected Weights for 32 wells: 80 μL (2.560 g), 20 μL (0.640 g), 5 μL (0.160
g). It is assumed that one gram is equal to one milliliter.

Dispense Volume To pass, %CV
must be:

To pass, Accuracy % Error
must be:

80 µL ≤ 2.0% ≤ 2.0%

20 µL ≤ 7.0% ≤ 5.0%

5 µL ≤ 10.0% ≤ 20.0%

If any tests fail, prime the fluid lines and rerun the tests. If the tests fail again, the
injectors may require cleaning; see Clean the Dispense Tubes and Injectors on page 65.
If tests continue to fail, contact Technical Support.
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Chapter 8

Instrument Qualification Procedures
This chapter contains the step-by-step procedures for verifying that the
Synergy H1 and its various sub-systems are performing to specification.

Instrument Qualification Process starting on page 75 introduces the
various test methods, describes the materials and relevant Gen5
protocols used to execute the tests, explains how to analyze test results,
and provides troubleshooting tips in the event of a failure.

Overview 114
IQ/OQ/PQ Description 115
Recommended Qualification Schedule 116
System Test 117
Absorbance Plate Tests 118
Absorbance Liquid Tests 120
Luminescence Test 125
Fluorescence Plate Tests 126
Fluorescence Liquid Tests 127
Injection System Tests 141



Overview

This chapter contains the recommended qualification procedures for all Synergy H1
models.

Every Synergy H1 is fully tested prior to shipment and should operate properly upon initial
setup. If you suspect that a problem occurred during shipment, if you have received the
equipment after returning it to the factory for service, and/or if regulatory requirements
dictate that you qualify the equipment on a routine basis, perform the procedures outlined
in this chapter.

See the Recommended Qualification Schedule on page 116 to determine which qualification
tests shall be conducted for your Synergy H1 model and to meet your site's regulatory
requirements.

A Product Qualification Package (PN 8040528) for the Synergy H1 is available for
purchase. The package contains test procedures, Gen5 protocols, checklists, and
logbooks for performing Installation Qualification, Operational Qualification,
Performance Qualification, and Maintenance.

If the gas controller module is used with the Synergy H1, refer to the Gas Controller User
Guide (PN 1211000) or Gas Controller Product Qualification Package (PN 1210512) for
qualification procedures.
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IQ/OQ/PQ Description

Installation Qualification confirms that the reader and its components have been
supplied as ordered and ensures that they are assembled and configured properly for your
lab environment.

l The recommended IQ procedure consists of setting up the instrument and its
components as described in the Installation chapter, and performing the System
Test. For models with injectors, a quick test with fluid is also performed, to ensure
that the dispense module is properly installed and there are no leaks.

l The IQ procedure should be performed before the reader is used for the first time.
The successful completion of the IQ procedure verifies that the instrument is installed
correctly.

Operational Qualification confirms that the equipment operates according to
specification initially and over time.

l The recommended OQ procedure consists of performing the System Test,
Absorbance Plate Test, a series of Fluorescence Tests, and, if the external dispense
module is used, Dispense Accuracy and Precision Tests.

l The OQ procedure should be performed initially (before first use) and then routinely;
the recommended interval is annually. It should also be performed after any major
repair or upgrade to the hardware or software.

l Although out-of-tolerance failures will be detected by the OQ tests, results should be
compared with those from the routine Performance Qualification tests and previous
OQ tests to monitor for trends.

l The successful completion of the OQ procedure, in combination with results that are
comparable to previous PQ and OQ tests, confirms that the equipment is operating
according to specification initially and over time.

Performance Qualification confirms that the reader consistently meets the
requirements of the tests performed at your laboratory.

l The recommended PQ procedure consists of performing the System Test, Absorbance
Plate Test, a series of Fluorescence Tests, and, if the external dispense module is
used, Dispense Accuracy and Precision Tests. Your facility’s operating policies may
also require that you routinely perform an actual assay, to confirm that the reader
will consistently give adequate results for the assays to be run on it.

l These tests should be performed routinely; the recommended interval is monthly or
quarterly, depending on the test. This frequency may be adjusted depending on the
trends observed over time.

l The successful completion of the PQ procedure confirms that the equipment is
performing consistently under normal operating conditions.
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Recommended Qualification Schedule

The schedule below defines the recommended intervals for qualifying a Synergy H1 used
two to five days a week. The actual frequency, however, may be adjusted depending on
your usage of the instrument and its various modules. This schedule assumes the reader is
properly maintained as outlined in theMaintenance chapter.

IQ OQ PQ

Tasks/Tests Initially
Initially/
Annually Monthly Quarterly

All models:

Installation, setup, and configuration of the
reader, host computer, and Gen5 software

ü

System Test ü ü ü

Models with absorbance capability:

Absorbance Plate Test ü ü

Absorbance Liquid Test 1 or Liquid Test 2* ü ü

(Optional) Absorbance Liquid Test 3 or 340 nm
Absorbance Plate Test (using PN 7260551)

ü ü

Models with fluorescence capability:

Corners, Sensitivity, Linearity (FI) Tests ü ü

Fluorescence Polarization (FP) Test ü ü

Time-Resolved Fluorescence (TRF) Test ü ü

Models with luminescence capability:

Luminescence Test ü ü

Models with injectors and an external dispense module:

Installation and setup of external dispense
module

ü

Injection System Test ü

Dispense Accuracy and Precision Test ü ü

* If you have Absorbance Test Plate PN 7260522, perform Liquid Test 1. Otherwise,
perform Liquid Test 2.

** Perform the FI tests (and FP and TRF if applicable for your reader model) using a Fluor-
escence Test Plate (PN 1400501) or the Fluorescence Liquid Test procedures described in this
chapter.
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System Test

Instrument System Test starting on page 76 describes this test and explains where to
find information on error codes and troubleshooting tips, as well as sample test reports
for Synergy H1.

Setup

If your assays use incubation, we recommend enabling temperature control for at least
37°C and allowing the incubator to reach its set point before running the System Test.
To access this feature, select System > Instrument Control and click the Pre-
Heating tab.

Test Procedure

1. From the Gen5 main screen, select System > Diagnostics > Run System Test.

The duration of the test depends on the reader model; it can take a few minutes
to complete.

If the test fails during execution, a message box will appear in Gen5. Close the
box; the System Test Report will contain the error code that was generated by
the failure.

2. When the test is complete, a dialog will appear, requesting additional information.
Enter any required information and then click OK.

3. The test report will appear; it will show either “SYSTEM TEST PASS” or “SYSTEM TEST
FAIL *** ERROR (error code) DETECTED.”

If the test failed, go to page 153 to look up the error code and determine its cause. If
the cause is something you can fix, turn off the reader, fix the problem, and then turn
the reader back on and retry the test. If the test continues to fail, or if the cause is not
something you can fix, contact Technical Support.

4. If required, print, sign, and date the report, and store it with your test
documentation.

5. If applicable, turn off the incubator.
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Absorbance Plate Tests

BioTek Absorbance Test Plates starting on page 77 describes the test methods and
provides troubleshooting tips in the event of test failure.

i The diagnostics feature in Gen5 versions 2.08 and higher is compatible with the 340
nm Absorbance Test Plate PN 7260551. If you are using an earlier Gen5 version, refer to
the test plate's instruction sheet to manually conduct the tests and analyze results.

Requirements

To perform this test, you will need:

l Absorbance Test Plate, PN 7260522

l (Optional) 340 nm Absorbance Test Plate, PN 7260551

l Current Absorbance Test Plate Calibration Certificate(s)

Setup

Before an Absorbance Test Plate can be used for qualification, you must enter information
from its Calibration Certificate into Gen5. Perform these steps initially, and then repeat
them annually after the test plate is recertified by BioTek:

1. Obtain the current Test Plate Calibration Certificate.

2. Start Gen5 and select System > Diagnostics > Test Plates > Add/Modify
Plates.

3. Click Add. The Absorbance Test Plate dialog appears.

4. Select the appropriate Plate Type and then enter the plate’s serial number.

5. Enter the Last Certification and Next Certification dates from the calibration label on
the Test Plate.

6. If the wavelength values in the top row of the grid in Gen5 are appropriate for your
tests, enter the OD Standard values from the Calibration Certificate into the grid.
Make sure you enter the correct value for each well/wavelength combination.

If you need to change the wavelength values, clickWavelength List. Add,
change, or delete the values as needed and click OK.

7. If applicable: Select the number of Peak Wavelength tests to run (up to 4), based on
the desired Expected Peak wavelengths provided on the Calibration Certificate. Enter
the Expected Peak value(s) from the Certificate and set the Test Range – and +
values.
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Depending on the manufacture date of the test plate, the glass type may be
Erbium, Holmium, or Didymium. Contact BioTek TAC if you are not sure
which glass type is used in your plate.

o If the C6 filter is Erbium or Holmium glass, the certificate contains two Spectral
Bandpass tables.

Synergy H1 has a bandpass wider than 5 nm for wavelengths above 285
nm and smaller than 4 nm for 230–285 nm; we recommend you use the
expected peak values in the 5.0 nm table.

Erbium: Any peak value in the table can be used.

Holmium: For best results use the expected peak values closest to 242, 279,
362, 417, and 538 nm.

o If the C6 filter is Didymium glass, the certificate provides a single peak
wavelength value. Enter this value into Gen5 and set the Test Range – and +
values so the range displayed in parenthesis is "(580 to 590)".

8. Review all of the values that you entered. When finished, click OK to save the
information.

Test Procedure

1. In Gen5, select System > Diagnostics > Test Plates > Run. If prompted, select
the desired Test Plate and click OK.

2. When the Absorbance Test Plate Options dialog appears, enter any required
information.

3. If applicable, check the Perform Peak Wavelength Test box.

4. Highlight the wavelength(s) to be included in this test. Select only those wavelengths
most appropriate for your use of the reader.

5. (Optional) Enter a comment.

6. Click Start Test.

7. Place the Absorbance Test Plate on the microplate carrier, with A1 in the proper
location.

8. Click OK to run the test.

9. When the test completes, the results report will appear. Scroll down through the
report; every result should show "PASS".

l Troubleshooting tips are provided on page 78.

l Test descriptions are provided on page 77.
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Absorbance Liquid Tests

Absorbance Liquid Tests starting on page 79 describes the test methods, lists the Gen5
protocol parameters, explains how to analyze the test results, and provides
troubleshooting tips in the event of test failure.

Absorbance Liquid Test 1

The tests in this section require specific microplates, solutions, and filters
or wavelengths. Your laboratory may require a deviation from some of
these tests. For example, you may wish to use a different plate or test
solution. If deviation from the tests as presented in this section is
required, perform the following steps the first time each test is run:

Perform the tests exactly as described here.

Rerun the tests using your particular plates, solutions, and so on.

If results are comparable, then the results from these tests will be
your baseline for future tests. Document your new test procedure
and save all test results.

Materials

Manufacturer part numbers are subject to change.

l New 96-well clear flat-bottom microplate (Corning Costar #3590 recommended)

l Stock Solution A or B, which may be formulated by diluting a dye solution available
from BioTek (A) or from the materials listed below (B)

l Gen5 protocol Synergy H1 Abs Test 1.prt described on page 80

Solution A

l BioTek QC Check Solution No. 1 (PN 7120779, 25 mL; PN 7120782, 125 mL)

l Deionized water

l 5-mL Class A volumetric pipette

l 100-mL volumetric flask

1. Pipette a 5-mL aliquot of BioTek QC Check Solution No. 1 into a 100-mL volumetric
flask.

2. Add 95 mL of DI water; cap and shake well. The solution should measure
approximately 2.000 OD when using 200 μL in a flat-bottom microwell.
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Solution B

l Deionized water

l FD&C Yellow No. 5 dye powder (typically 90% pure)

l Tween 20 (polyoxyethylene (20) sorbitan monolaurate) or BioTek wetting agent (PN
7773002) (a 10% Tween solution)

l Precision balance with capacity of 100 g minimum and readability of 0.001 g

l Weigh boat

l 1-liter volumetric flask

1. Weigh out 0.092 g of FD&C Yellow No. 5 dye powder into a weigh boat.

2. Rinse the contents into a 1-liter volumetric flask.

3. Add 0.5 mL of Tween 20, or 5 mL of BioTek’s wetting agent.

4. Fill to 1 liter with DI water; cap and shake well. The solution should measure
approximately 2.000 OD when using 200 μL in a flat-bottom microwell.

Test Procedure

i Be sure to use a new microplate. Debris, fingerprints, or scratches may cause
variations in readings.

1. Using freshly prepared stock solution (Solution A or B), prepare a 1:2 dilution using
deionized water (one part stock, one part deionized water; the resulting solution is a
1:2 dilution).

2. Pipette 200 μL/well of the stock solution into column 1.

3. Pipette 200 μL/well of the diluted solution into column 2.

4. Create a Gen5 experiment based on the Synergy H1 Abs Test 1 protocol and read
the plate. When prompted, rotate the plate 180 degrees and continue.

5. When the experiment is finished:

l Save the experiment. Refer to the instructions on page 82 to perform calculations
and determine pass/fail.

l Troubleshooting tips are provided on page 84.

l Test descriptions are provided on page 79.
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Absorbance Liquid Test 2

The recommended method for testing the instrument's alignment, repeatability, and
accuracy is to use Absorbance Test Plate PN 7260522 (see page 118). If the test plate is
not available, however, Liquid Test 2 can be used for these tests.

Materials

Manufacturer part numbers are subject to change.

l New 96-well clear flat-bottom microplate (Corning Costar #3590 recommended)

l Ten test tubes, numbered consecutively, set in a rack

l Calibrated hand pipette (Class A volumetric pipette recommended)

l Stock Solution A or B (see instructions for Liquid Test 1)

l 0.05% solution of deionized water and Tween 20

l Gen5 protocol Synergy H1 Abs Test 2.prt described on page 81

Test Procedure

1. Create a percentage dilution series, beginning with 100% of the original concentrated
stock solution (A or B) in the first tube, 90% of the original solution in the second
tube, 80% in the third tube, all the way to 10% in the tenth tube. Dilute using the
0.05% solution of deionized water and Tween 20. This solution can also be made by
diluting the BioTek wetting agent 200:1.

Tube Number 1 2 3 4 5 6 7 8 9 10

Volume of original concentrated
solution (mL)

20 18 16 14 12 10 8 6 4 2

Volume of 0.05% Tween solution
(mL)

0 2 4 6 8 10 12 14 16 18

Absorbance expected if original
solution is 2.000 OD at 200 µL

2.0 1.8 1.6 1.4 1.2 1.0 0.8 0.6 0.4 0.2

The choice of dilutions and the absorbance of the original solution can be
varied. Use this table as a model for calculating the expected absorbances of a
series of dilutions, given a different absorbance of the original solution.

2. Pipette 200 μL of the concentrated solution from Tube 1 into each well of the first
column, A1 to H1, of a new flat-bottom microplate.

3. Pipette 200 μL from each of the remaining tubes into the wells of the corresponding
column of the microplate (Tube 2 into wells A2 to H2, Tube 3 into wells A3 to H3, and
so on).
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4. Create a Gen5 experiment based on the Synergy H1 Abs Test 2 protocol and read
the plate. When prompted, rotate the plate 180 degrees.

5. When finished:

l Save the experiment. Refer to the instructions on page 82 to perform calculations
and determine pass/fail.

l Troubleshooting tips are provided on page 84.

l Test descriptions are provided on page 77.

Absorbance Liquid Test 3

Absorbance Liquid Test 3 is provided for sites requiring proof of linearity at 340 nm. This
test is optional because the Synergy H1 has good "front end" linearity throughout its
wavelength range. As an alternative, the 340 nm Absorbance Test Plate (PN 7260551)
may be used for this test.

Materials

Manufacturer part numbers are subject to change.

l New 96-well clear flat-bottom microplate (Corning Costar #3590 recommended)

l Calibrated hand pipette(s)

l Beakers and graduated cylinder

l Precision balance with readability to 0.010 g

l Buffer solution described below

l Gen5 protocol Synergy H1 Abs Test 3.prt described on page 81

Buffer Solution

l Deionized water

l Phosphate-Buffered Saline (PBS), pH 7.2–7.6, Sigma tablets, #P4417 (or equivalent)

l β-NADH Powder (β-Nicotinamide Adenine Dinucleotide, Reduced Form) Sigma bulk
catalog number N 8129, or preweighed 10-mg vials, Sigma number N6785-10VL (or
BioTek PN 98233). Store the powder according to the guidelines on its packaging.

1. Prepare a PBS solution from the Sigma tablets.

2. In a beaker, mix 50 mL of the PBS solution with 10 mg of the β-NADH powder and
mix thoroughly. This is the 100% Test Solution.

3. (Optional) Read a 150-μL sample of the solution at 340 nm; it should be within
0.700 to 1.000 OD. If low, adjust up by adding more powder. Do not adjust if
slightly high.
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Test Procedure

1. Prepare the 75% Test Solution by mixing 15 mL of the 100% Test Solution with 5
mL of the PBS Solution.

2. Prepare the 50% Test Solution by mixing 10 mL of the 100% Test Solution with 10
mL of the PBS Solution.

3. Carefully pipette the three solutions into a new 96-well microplate:

l 150 μL of the 100% Test Solution into all wells of columns 1 and 2

l 150 μL of the 75% Test Solution into all wells of columns 3 and 4

l 150 μL of the 50% Test Solution into all wells of column 5 and 6

4. Create a Gen5 experiment based on the Synergy H1 Abs Test 3 protocol and read
the plate.

l Save the experiment. Refer to the instructions on page 83 to perform calculations
and determine pass/fail.

l Troubleshooting tips are provided on page 84.

l Test descriptions are provided on page 79.
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Luminescence Test

Luminescence Testing starting on page 85 describes the test method, lists the Gen5
protocol parameters, explains how to analyze the test results, and provides
troubleshooting tips in the event of test failure.

Requirements

To perform this test, you will need:

l Harta Luminometer Reference Microplate, PN 8030015 (which includes microplate
carrier adapter PN 8042263)

l Gen5 protocols, described on page 85:

o Synergy H1 F-LumTest_Harta (filter-based system)

o Synergy H1 M-LumTest_Harta (monochromator-based system)

l For use only with the filter-based test, the following filter set defined in Gen5:

Filter Set Name: Open

Excitation: Plug

Mirror: <none>

Emission: Hole

Test Procedure

1. Turn on the Harta reference plate using the I/O switch on the back of the plate.

2. Check the battery by pressing the test button on the back of the plate and ensuring
that the test light turns on. The test light may be difficult to see in bright light;
change your angle of view or move to a darker environment if necessary. If the light
does not turn on, replace the battery.

3. Place the adapter on the reader's microplate carrier and then place the Harta
reference plate on top of the adapter.

4. In Gen5, create an experiment based on the Synergy H1 F-Lum-Test (filter-based)
protocol and initiate a plate read.

The experiment begins with a three-minute Delay step.

5. When the experiment is complete, calculate and evaluate results as described under
Results Analysis on page 87.

6. Repeat steps 4 and 5 using the Synergy H1 M-LumTest_Harta (monochromator-
based) protocol.

7. When finished, turn off the Harta reference plate to preserve battery life.

Synergy H1 Operator's Manual

Luminescence Test | 125



Fluorescence Plate Tests

BioTek Fluorescence Test Plate on page 89 introduces the test plate and references the
User Guide for the test methods. Use of the test plate is offered as an alternative to
conducting the fluorescence liquid tests described in the next section.

Requirements

Refer to the Getting Started section of the Fluorescence Test Plate User Guide for
information on the required materials and prerequisite tasks.

Test Procedure

The Qualification Tests section of the Fluorescence Test Plate User Guide contains a
procedure for cleaning the plate and then creating and running experiments based on
supplied Gen5 protocols.

As described in the User Guide, when each experiment is finished, Gen5 exports the
measurement data to a prepared Microsoft Excel .xls file. The worksheet(s) within that file
calculate results and determine pass or fail.

i For use with the Synergy H1, identify the reader-specific Gen5 protocols on the
USB flash drive that came with the test plate. Use only those protocols that apply to your
reader model and your organization's qualification requirements.
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Fluorescence Liquid Tests

Fluorescence Liquid Tests starting on page 90 describes the test methods, lists the Gen5
protocol parameters, explains how to analyze the test results, and provides
troubleshooting tips in the event of test failure.

The tests in this section require specific microplates, solutions, and filters
or wavelengths. Your laboratory may require a deviation from some of
these tests. For example, you may wish to use a different plate or test
solution. If deviation from the tests as presented in this section is
required, perform the following steps the first time each test is run:

Perform the tests exactly as described here.

Rerun the tests using your particular plates, solutions, and so on.

If results are comparable, then the results from these tests will be
your baseline for future tests. Document your new test procedure
and save all test results.

Materials

Kits containing the microplates and solutions required by the Liquid Tests
are available for purchase; see Materials for Conducting Liquid Tests on
page 6.

i Microplates should be clean and free from dust and bottom scratches. Use new
microplates from sealed packages.

Manufacturer part numbers are subject to change.

All tests:

l Deionized or distilled water

l Various beakers, graduated cylinders, and pipettes

l 95% ethanol (for cleaning clear-bottom plates)

l Aluminum foil

l (Optional, but recommended) 0.45-micron filter

l (Optional) Black polyethylene bag(s) to temporarily store plate(s)
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l Gen5 protocols listed below (as applicable for your reader model) and described in
detail under Gen5 Protocol Parameters starting on page 90

For the filter-based fluorescence system:

Synergy H1_FI_T_SF.prt Corners, Sensitivity, Linearity tests, Top
optics, Sodium Fluorescein (SF)

Synergy H1_FI_T_MUB.prt Sensitivity and Linearity tests, Top optics,
Methylumbelliferone (alternate/
supplemental test for Top optics)

Synergy H1_FP.prt Fluorescence Polarization (FP) test

Synergy H1_TRF.prt Time-Resolved Fluorescence (TRF) test

For themonochromator-based fluorescence system:

Synergy H1_M_FI_B_SF.prt Corners, Sensitivity, Linearity tests, Bottom
optics, Sodium Fluorescein (SF)

Synergy H1_M2_FI_B_SF.prt Corners, Sensitivity, Linearity tests, Bottom
optics, Sodium Fluorescein (SF)

Synergy H1_M_FI_T_SF.prt Corners, Sensitivity, Linearity tests, Top
optics, Sodium Fluorescein (SF)

Synergy H1_M2_FI_T_SF.prt Corners, Sensitivity, Linearity tests, Top
optics, Sodium Fluorescein (SF)

Synergy H1_M_FI_T_MUB.prt Sensitivity and Linearity tests, Top optics,
Methylumbelliferone (alternate/
supplemental test for Top optics)

Synergy H1_M2_F_T_MUB Sensitivity and Linearity tests, Top optics,
Methylumbelliferone (alternate/
supplemental test for Top optics)

l Filter set definitions, as applicable ("Green"=SF, "Blue"=MUB):

Filter Set Name Green

Excitation: Band Pass, 485/20

Mirror: Dichroic, Top 510 nm (440/505, 515/640)

Emission: Band Pass, 528/20

Filter Set Name Blue

Excitation: Band Pass, 360/40

Mirror: Dichroic, Top 400 nm (320/390, 410/800)

Emission: Band Pass, 460/40

Filter Set Name TRF

Excitation: Band Pass, 360/40
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Mirror: Dichroic, Top 400 nm (320/390, 410/800)

Emission: Band Pass, 620/40

Filter Set Name FP (enable 'Fluorescence Polarization Cube')

Excitation: Band Pass, 485/20

Mirror: Dichroic, Top 510 nm (440/505, 515/640)

Emission: Band Pass, 528/20
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Corners/Sensitivity/Linearity (FI) Tests:

The materials listed here are for use with Sodium Fluorescein.
Methylumbelliferone (MUB) may be used as an alternate or supplemental
method for conducting the FI tests for the Top optics; see page 137.

If using test kit PN 7160010 or 7160013 (see page 6) the buffer and SF are pre-
diluted.

l Buffer:

o NIST-traceable Sodium Borate Reference Standard (pH 9.18) (e.g., Fisher-
Scientific 1 L Sodium Borate Mfr. #159532, or equivalent), or

o Phosphate-Buffered Saline (PBS), pH 7.2–7.6 (e.g., Sigma tablets, Mfr.
#P4417, or equivalent) and pH meter or pH indicator strips with range 4–10

l Sodium Fluorescein Powder (1-mg vial, BioTek PN 98155)

l If testing both Top and Bottom optics (monochromator-based fluorescence only):

o A new, clean 96-well glass-bottom Greiner SensoPlate (Mfr. #655892); or a
clean Hellma Quartz 96-well titration plate (Mfr. #730.009.QG); or equivalent

l If testing only the Top optics:

o A new, clean 96-well solid black microplate, such as Corning Costar #3915, or
equivalent

l Excitation filter 485/20 nm installed

l Emission filter 528/20 nm installed

l 510 nm dichroic mirror installed

Fluorescence Polarization (FP) Test:

The FP Test may be conducted using the same plate as for the Top
Corners/Sensitivity/Linearity (FI) Tests.

l The recommended test solutions are available from Invitrogen Corporation in their
“FP One-Step Reference Kit” (#P3088) or BioTek (#7160014; see page 6). This kit
includes:

o (Green) Polarization Reference Buffer, 15 mL

o Green Low Polarization Reference, 4 mL

o Green High Polarization Reference, 4 mL

o The Invitrogen kit also includes two red polarization solutions, not used

l A new, clean, 96-well solid black microplate, such as Corning Costar #3915. A
Greiner SensoPlate can also be used.

l Excitation filter 485/20 nm installed
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l Emission filter 528/20 nm installed

l 510 nm dichroic mirror and polarizers installed

Time-Resolved Fluorescence (TRF) Test:

BioTek offers a pre-configured qualification TRF filter cube for purchase;
contact BioTek Customer Care and ask about part number 8040555.

l The recommended test solution (FluoSpheres carboxylate-modified microspheres,
0.2 μm europium luminescent, 2 μL) is available from Invitrogen Corporation
(#F20881) or BioTek (#7160011; see page 6)

l A new, clean 96-well solid white microplate, such as Corning Costar #3912

l 15-mL conical-bottom, polypropylene sample tube

l Excitation filter 360/40 nm installed

l Emission filter 620/40 nm installed

l 400 nm dichroic mirror installed

Test Solutions

Determine which tests to run for your reader model. Prepare the necessary test solutions
using the materials described on the previous pages.

Corners/Sensitivity/Linearity (FI) Tests:

If using BioTek’s sodium fluorescein powder (PN 98155), be sure to hold
the vial upright and open it carefully; the material may be concentrated
at the top. If a centrifuge is available, spin down the tube before opening.

When diluting the sodium fluorescein powder in buffer, it takes time for
the powder to completely dissolve. Allow the solution to dissolve for five
minutes, with intermittent vortexing, before preparing the titration dyes.

Wrap the vial containing the stock solution in foil to prevent exposure to
light. Discard unused solution after seven days. Discard any open,
unused buffer solution after seven days.

1. The Sodium Borate solution does not require further preparation; proceed to step 2.
If you are using PBS, prepare the solution:

l (Optional, but recommended) Using a 0.45-micron filter, filter 200 mL of deionized
or distilled water.

l Follow the manufacturer’s instructions on the PBS packaging to create 200 mL,
dissolving the necessary amount of PBS into the filtered water.
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l Stir the solution (preferably using a stir table) until the PBS is completely
dissolved.

l Check the pH; it should be between 7.2 and 7.6 at 25°C.

2. Prepare the sodium fluorescein stock solution:

l Add 2.0 mL of the buffer solution to the 1 mg Sodium Fluorescein (SF) vial. This
yields a 1.3288 mM stock solution.

l Ensure that the dye has completely dissolved and is well mixed.

3. Carefully prepare the dilutions. Label each with “SF” and the concentration:

Mix this SF solution: with buffer: to make:

0.53 mL of 1.3288 mM stock solution 13.47 mL 50.2 µM

110 µL of 50.2 µM SF 13.89 mL 400 nM

3.5 mL of 400 nM SF 10.50 mL 100 nM

0.46 mL of 100 nM SF 13.54 mL 3.3 nM Corners Test

4.24 mL of 3.3 nM SF 9.76 mL 1 nM Sensitivity/Linearity Tests

Fluorescence Polarization (FP) Test:

As described in the Materials section, the recommended test solutions are available from
Invitrogen Corporation (or BioTek). They do not require additional preparation.

Time-Resolved Fluorescence (TRF) Test:

As described in the Materials section, the recommended test solutions are available from
Invitrogen Corporation (or BioTek).

l Shake the FluoSpheres container vigorously for 30 seconds prior to pipetting.
Alternatively, sonicate or vortex the container.

l Mix 10 μL of FluoSpheres with 10 mL of deionized water, in a 15-mL conical-bottom,
polypropylene sample tube. This yields a 20-nM equivalent suspension.

l Shake the vial vigorously for 30 seconds prior to pipetting. Alternatively, sonicate or
vortex the container.

l Mix 10 μL of 20-nM suspension with 10 mL of deionized water, in a 15-mL conical-
bottom, polypropylene sample tube. This yields a 20-pM equivalent suspension.

l Refrigerate any unused portions of the FluoSpheres. The temperature must be
between +2°C to +6°C.

The prepared TRF plate can be kept for a maximum of seven days, if
covered and stored in the dark between +2°C to +6°C. Allow the plate to sit
at room temperature for approximately 15 minutes prior to use. Shake the
plate gently prior to the read.
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Test Procedure

1. If you have not already done so, prepare the solutions for the tests you plan to
perform. See instructions starting on page 131.

Refer to the pipette maps on the next few pages for the remaining steps.

2. Perform the Corners/Sensitivity/Linearity tests using the Top optics of the filter-
based fluorescence system:

l Pipette the solutions into a new 96-well solid black or glass-bottom plate.

l Create an experiment based on Synergy H1_FI_T_SF.prt and read the plate.

3. If your reader is equipped with Fluorescence Polarization capability:

l Pipette the solutions for the “FP” test into the same plate as used in step 2.

l Create an experiment based on Synergy H1_FP.prt and read the plate.

4. If your reader is equipped with the fixed-bandpass monochromator-based
fluorescence system, perform the Sensitivity/Linearity tests for that system:

l Create an experiment based on Synergy H1_M_FI_B_SF.prt (bottom optics)
and read the plate.

l Create an experiment based on Synergy H1_M_FI_T_SF.prt (top optics) and
read the plate.

5. If your reader is equipped with the variable-bandpass monochromator-based
fluorescence system, perform the Sensitivity/Linearity tests for that system:

l Create an experiment based on Synergy H1_M2_FI_B_SF.prt (bottom optics)
and read the plate.

l Create an experiment based on Synergy H1_M2_FI_T_SF.prt (top optics) and
read the plate.

6. If your reader is equipped with Time-Resolved Fluorescence capability:

l Pipette the solutions for the “TRF” test into a new 96-well solid white plate.

l Create an experiment based on Synergy H1_TRF.prt and read the plate.

6. Save the experiments. Refer to the instructions starting on page 104 to perform
calculations and determine pass/fail.

l Troubleshooting tips are provided on page 107.

l Test descriptions are provided on page 90.
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Pipette Maps

Seal the plates with foil or store them in black polyethylene bags until use. When using a
clear-bottom plate, if the base of the plate is touched, clean the entire base with alcohol
(95% ethanol) and then wipe with a lint-free cloth. Before placing the plate in the
instrument, blow the bottom of the plate with an aerosol duster.

Corners, Sensitivity, and Linearity (FI) Tests:

Refer to the illustration on the next page.

Using a single-channel pipette:

l Pipette 200 μL of the 3.3 nM SF solution into the “corner” wells.

l Pipette 200 μL of the buffer in the wells surrounding the SF. (Omit if using a solid
black plate or Greiner SensoPlate.)

l Pipette 200 µL of the 1 nM SF solution into well D7.

l Pipette 200 µL of the buffer solution into wells C9, D9, and E9.

Using a multi-channel pipette with just four tips installed:

l Pipette 150 μL of the buffer into wells C2-F5. Discard the tips.

l Pipette 150 μL of the 1 nM SF solution into column 1.

l Pipette 150 μL of the 1 nm SF solution into column 2. Mix the wells using the pipette.
Do not discard the tips.

l Aspirate 150 μL from column 2 and dispense into column 3. Mix the wells using the
pipette. Do not discard the tips.

l Aspirate 150 μL from column 3 and dispense into column 4. Mix the wells using the
pipette. Do not discard the tips.

l Aspirate 150 μL from column 4 and dispense into column 5. Mix the wells using the
pipette. Do not discard the tips.

l Aspirate 150 μL from column 5. Discard the solution and the tips.
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1 2 3 4 5 6 7 8 9 10 11 12

Corners A 3.3 nM 3.3
nM

3.3
nM

BUF BUF 3.3
nM

3.3
nM

3.3
nM

B BUF BUF BUF BUF BUF BUF BUF BUF

C 150
µL:
1 nM

0.5
nM

0.25
nM

0.125
nM

0.0625
nM

BUF

Sensitivity
/Linearity

D 1 nM 0.5
nM

0.25
nM

0.125
nM

0.0625
nM

200
µL:
1 nM

BUF

E 1 nM 0.5
nM

0.25
nM

0.125
nM

0.0625
nM

BUF

F 1 nM 0.5
nM

0.25
nM

0.125
nM

0.0625
nM

G BUF BUF BUF BUF BUF BUF BUF BUF

Corners H 3.3 nM 3.3
nM

3.3
nM

BUF BUF 3.3
nM

3.3
nM

3.3
nM

Fluorescence Polarization (FP) Test:

The plate used for testing Corners/Sensitivity/Linearity of the Top optics can
also be used for this test.

l Pipette 200 μL of the (green) polarization buffer (BUF) into wells A6–H6.

l Pipette 200 μL of the green high polarization reference (HPR) into wells A7–B7.

l Pipette 200 μL of the green low polarization reference (LPR) into wells A8–H8.

1 2 3 4 5 6 7 8 9 10 11 12

A BUF HPR LPR

B BUF HPR LPR

C BUF LPR

D BUF LPR

E BUF LPR

F BUF LPR

G BUF LPR

H BUF LPR
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Time-Resolved Fluorescence (TRF) Test:

l Pipette 200 μL of deionized water (DI) into wells A6, B6, C6.

l If you have not already done so, shake the vial of 20 pM europium suspension
vigorously for 30 seconds prior to pipetting. Alternatively, sonicate or vortex the vial.

l Pipette 200 μL of the 20 pM europium suspension (Eu) into well A8.

1 2 3 4 5 6 7 8 9 10 11 12

A DI Eu

B DI

C DI

D

E

F

G

H
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Alternate/Supplemental Tests Using Methylumbelliferone (MUB)

(Optional) As an alternative to using Sodium Fluorescein, Methylumbelliferone (MUB) can
be used to perform the Sensitivity/Linearity tests for the top optics.

Materials

Kits containing the microplates and solutions required by the Liquid Tests
are available for purchase; see Materials for Conducting Liquid Tests on
page 6.

Manufacturer part numbers are subject to change.

If your reader is equipped with the filter- and monochromator-based
fluorescence systems, the same microplate is used to test both systems.

l Methylumbelliferone (MUB) (10-mg vial, PN 98156)

l Carbonate-Bicarbonate buffer (CBB) capsules (Sigma #3041)

l 100% methanol (PMN 98161)

l A new, clean 96-well solid black plate, such as Corning Costar #3915 or equivalent. A
Greiner SensoPlate (Mfr. #655892) may also be used.

l Excitation filter 360/40 installed

l Emission filter 460/40 nm installed

l 400 nm dichroic mirror installed

l Deionized or distilled water

l Various beakers, graduated cylinders, and pipettes

l 95% ethanol (for cleaning clear-bottom plates)

l Aluminum foil

l (Optional, but recommended) 0.45-micron filter

l (Optional) Black polyethylene bag(s) to temporarily store plate(s)

l Gen5 protocols listed below (as applicable for your reader model) and described in
detail under Gen5 Protocol Parameters starting on page 90:

o Synergy H1_FI_T_MUB.prt (filter-based system)

o Synergy H1_M_FI_T_MUB.prt (fixed-bandpass monochromator-based
system)

o Synergy H1_M2_FI_T_MUB.prt (variable-bandpass monochromator-based
system)
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Test Solutions

Filter solutions to remove particulates that could cause erroneous
readings. Do not allow dust to settle on the surface of the solution; use
microplate covers or seals when not reading the plate.

Wrap the vial containing the MUB stock solution in foil to prevent
exposure to light.

Discard any open, unused solutions after seven days.

1. Prepare the buffer (CBB) solution:

l (Optional, but recommended) Using a 0.45-micron filter, filter 200 mL of deionized
or distilled water.

l Open and dissolve the contents of two CBB capsules (do not dissolve the outer
gelatin capsule) into 200 mL of the water.

l Stir the solution (preferably using a stir table) until the CBB is completely
dissolved.

2. Prepare the MUB stock solution:

l Add 1 mL of 100% methanol to the 10-mg vial of MUB.

l Make sure all of the dye has completely dissolved and is well mixed. This yields a
10 mg/mL stock solution.

l Wrap the solution in aluminum foil to prevent exposure to light.

3. Prepare the dilutions. Label each with “MUB” and the concentration.

Mix this MUB solution: with: to make:

0.5 mL of 10 mg/mL stock solution 4.5 mL of 100% methanol 1 mg/mL

0.88 mL of 1 mg/mL solution 4.12 mL of CBB 176 µg/mL

0.1 mL of 176 µg/mL solution 9.9 mL of CBB 1.76 µg/mL

0.5 mL of 1.76 µg/mL solution 4.5 mL of CBB 176 ng/mL

1 mL of 176 ng/mL solution 9 mL of CBB 17.6 ng/mL
(100 nM)
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Test Procedure

1. If you have not already done so, prepare the test solution; see instructions on page
138.

Refer to the pipette map on the next page for the remaining steps.

2. Perform the Sensitivity/Linearity tests using the Top optics of the filter-based
fluorescence system:

l Pipette the solutions into a new 96-well solid black or glass-bottom plate.

l Create an experiment based on Synergy H1_FI_T_MUB.prt and read the plate.

3. If your reader is equipped with the fixed-bandpass monochromator-based
fluorescence system, perform the Sensitivity/Linearity tests for that system:

l Create an experiment based on Synergy H1_M_FI_T_MUB.prt and read the
plate.

3. If your reader is equipped with the variable-bandpass monochromator-based
fluorescence system, perform the Sensitivity/Linearity tests for that system:

l Create an experiment based on Synergy H1_M2_FI_T_MUB.prt and read the
plate.

4. Within each experiment, open the Plate menu and export the data to the embedded
Power Export spreadsheet. Each spreadsheet will report pass or fail for the test(s)
performed. Print and store with your test records.

4. Save the experiments. Refer to the instructions starting on page 104 to perform
calculations and determine pass/fail.

l Troubleshooting tips are provided on page 107.

l Test descriptions are provided on page 90.
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Pipette Map

Using a single-channel pipette:

l Pipette 200 µL of the 17.6 ng/mL (100 nM) MUB solution into well D7.

l Pipette 200 µL of the buffer solution into wells C9, D9, and E9.

Using a multi-channel pipette with just four tips installed:

l Pipette 150 μL of the buffer into wells C2-F5. Discard the tips.

l Pipette 150 μL of the 17.6 ng/mL (100 nM) MUB solution into column 1.

l Pipette 150 μL of the 17.6 ng/mL (100 nM) MUB solution into column 2. Mix the wells
using the pipette. Do not discard the tips.

l Aspirate 150 μL from column 2 and dispense into column 3. Mix the wells using the
pipette. Do not discard the tips.

l Aspirate 150 μL from column 3 and dispense into column 4. Mix the wells using the
pipette. Do not discard the tips.

l Aspirate 150 μL from column 4 and dispense into column 5. Mix the wells using the
pipette. Do not discard the tips.

l Aspirate 150 μL from column 5. Discard the solution and the tips.

1 2 3 4 5 6 7 8 9 10 11 12

A

B

C 100 nM 50 nM 25 nM 12.5 nM 6.25 nM BUF

D 100 nM 50 nM 25 nM 12.5 nM 6.25 nM MUB
100 nM

BUF

E 100 nM 50 nM 25 nM 12.5 nM 6.25 nM BUF

F 100 nM 50 nM 25 nM 12.5 nM 6.25 nM

G

H
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Injection System Tests

Injection System Testing starting on page 108 describes the test methods, lists the
Gen5 protocol parameters, explains how to analyze the test results, and provides
troubleshooting tips in the event of test failure.

Materials

Manufacturer part numbers are subject to change.

Absorbance reader with capability of reading at 405, 630, and 750 nm. The reader must
have an accuracy specification of ±1.0% ±0.010 OD or better and a repeatability
specification of ±1.0% ±0.005 OD or better.

The Synergy H1 may be used if it is equipped with Absorbance capabilities and
has passed the Absorbance Plate Test or Absorbance Liquid Test 1.

Microplate shaker (if the absorbance reader does not support shaking)

Precision balance with capacity of 100 g minimum and readability of 0.001 g

50–200 μL hand pipette and disposable tips

Deionized water

Supply bottles

250-mL beaker

New 96-well, clear, flat-bottom microplates

Green Test Dye Solution (PN 7773003) undiluted, or one of the alternate test solutions
provided on the next page

100-mL graduated cylinder and 10-mL pipettes (if not using the Green Test Dye
Solution)

Gen5 protocols listed below (as applicable for your reader model) and described in detail
under Gen5 Parameters starting on page 108:

For models with Absorbance capabilities:

Synergy H1 Disp 1 Test.prt
Synergy H1 Disp 2 Test.prt

For models without Absorbance capabilities:

Synergy H1 Disp 1 Test No Read.prt
Synergy H1 Disp 2 Test No Read.prt

and, if you will use Gen5 with another BioTek absorbance-capable reader:

Synergy H1 Disp Test Other Reader.prt
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Alternate Test Solutions

If you do not have the Green Test Dye Solution (PN 7773003), prepare a dye solution
using one of the following methods:

80 μL of test solution with 150 μL of deionized water should read between 1.300
and 1.700 OD at 405/750 nm. The solutions should be at room temperature.

Using BioTek's Blue and Yellow Concentrate Dye Solutions:

Item Quantity

Concentrate Blue Dye Solution
(PN 7773001, 125 mL)

4.0 mL

QC (Yellow) Solution
(PN 7120782, 125 mL)

5.0 mL

Deionized water 90.0 mL

Using FD&C Blue and Yellow Dye Powder:

Item Quantity per Liter

FD&C Blue No. 1 0.200 grams

FD&C Yellow No. 5 0.092 grams

Tween 20 1.0 mL

Sodium Azide N3Na 0.100 gram

Deionized water make to 1 liter

Test Procedure for Models with Absorbance Capability

1. Prime both dispensers with 4000 μL of deionized or distilled water.

2. Remove the inlet tubes from the supply bottles. Prime both dispensers with the
Volume set to 2000 μL. This prevents the water from diluting the dye.

3. Fill a beaker with at least 20 mL of the green dye solution. Prime both dispensers with
2000 μL of the solution. When finished, remove the priming plate from the carrier.

4. Create an experiment based on the Synergy H1 Disp 1 Test protocol.

5. Place a new 96-well microplate on the balance and tare the balance.

6. Place the plate on the microplate carrier.

Running a dispense protocol with no plate on the carrier will
contaminate the reading chamber with spilled fluid.
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When each dispense step is finished, you will weigh the plate, record the
weight, tare the balance with the plate on it, and then place the plate back
on the carrier for the next step.

7. Initiate a plate read. Gen5 will prompt you to empty the tip priming trough.

8. When ready, proceed with the experiment. The sequence is as follows:

l 80 μL/well is dispensed to columns 1–4.

l When prompted, remove the plate and weigh it. Record the weight and tare the
balance. Place the plate on the carrier.

l 20 μL/well is dispensed to columns 5–8.

l When prompted, remove the plate and weigh it. Record the weight and tare the
balance. Place the plate on the carrier.

l 5 μL/well is dispensed to columns 9–12.

l When prompted, remove the plate and weigh it. Record the weight.

l Manually pipette 150 μL of deionized or distilled water into all 12 columns, on top
of the green test dye solution.

l Place the plate on the carrier for the shake and read steps.

9. When the experiment is complete, save the file with an identifying name.

10. Remove the plate from the carrier and set it aside.

11. Repeat the procedure using the Synergy H1 Disp 2 Test protocol and a new
microplate.

12. When the tests are complete:

l Prime both dispensers with at least 5000 µL of deionized water to flush out the dye
solution.

l Refer to the instructions on page 111 to perform calculations and determine
pass/fail.

l Test descriptions are provided on page 108.
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Test Procedure for Models without Absorbance Capability

If you are not using a BioTek absorbance reader for this procedure, prepare your reader
to perform two reads with the following characteristics:

80 µL Read 20 and 5 µL Read

Primary Wavelength: 405 nm 630 nm

Reference Wavelength: 750 nm 750 nm

Plate Columns: 1–4 5–12

1. Prime both dispensers with 4000 μL of deionized or distilled water.

2. Remove the inlet tubes from the supply bottles. Prime both dispensers with the
Volume set to 2000 μL. This prevents the water from diluting the dye.

3. Fill a beaker with at least 20 mL of the green dye solution. Prime both dispensers with
2000 μL of the solution. When finished, remove the priming plate from the carrier.

4. Create an experiment based on the Synergy H1 Disp 1 Test No Read protocol.

5. Place a new 96-well microplate on the balance and tare the balance.

6. Place the plate on the microplate carrier.

Running a dispense protocol with no plate on the carrier will
contaminate the reading chamber with spilled fluid.

When each dispense step is finished, you will weigh the plate, record the
weight, tare the balance with the plate on it, and then place the plate back
on the carrier for the next step.

7. Initiate a plate read. Gen5 will prompt you to empty the tip priming trough.

8. When ready, proceed with the experiment. The sequence is as follows:

l 80 μL/well is dispensed to columns 1–4.

l When prompted, remove the plate and weigh it. Record the weight and tare the
balance. Place the plate on the carrier.

l 20 μL/well is dispensed to columns 5–8.

l When prompted, remove the plate and weigh it. Record the weight and tare the
balance. Place the plate on the carrier.

l 5 μL/well is dispensed to columns 9–12.

l When prompted, remove the plate and weigh it. Record the weight.

l Manually pipette 150 μL of deionized or distilled water into all 12 columns, on top
of the green test dye solution.

l Carefully set the plate aside.
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9. Close the experiment without saving it.

If you are not using a BioTek absorbance reader, read the plate using the
parameters described in the table above. Perform the calculations and
dettermine pass/fail according to the instructions on page 111.

10. If you are using a BioTek absorbance reader, configure Gen5 to communicate with
the reader.

11. Create an experiment based on the Other Reader protocol and read the plate.

12. When the experiment is complete, save the file with an identifying name.

13. Remove the plate from the carrier and set it aside.

14. Repeat the procedure using the Synergy H1 Disp 2 Test No Read protocol and a
new microplate.

15. When the tests are complete:

l Prime both dispensers with at least 5000 µL of deionized water to flush out the dye
solution.

l Refer to the instructions on page 111 to perform calculations and determine
pass/fail.

l Test descriptions are provided on page 108.
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Appendix A

Specifications
This appendix contains BioTek's published specifications for the Synergy
H1.

General Specifications 148
Absorbance Specifications 149
Fluorescence Specifications 150
Luminescence Specifications 151
Dispense/Read Specifications 152



General Specifications

Microplates

The Synergy H1 accommodates standard 6-, 12-, 24-, 48-, 96-, and 384-well microplates
with 128 x 86 mm geometry, and the BioTek Take3 and Take3Trio Micro-Volume Plates.

Maximum Plate Height:

l Absorbance mode: plates up to 0.8" (20.30 mm) high

l Fluorescence, monochromator-based mode: plates up to 0.89" (22.6 mm) high

l Fluorescence (filter-based)/Luminescence modes: plates up to 0.89" (22.6 mm) high

Hardware and Environmental

Light Source Xenon flash light source, not user-changeable

20W max. average power for Absorbance and monochromator-
based Fluorescence (FI)

5W max. average power for TRF and filter-based Fluorescence
(FI/FP)

Dimensions Approximately 18.25" D x 14.75" W x 13" H (46.4 cm D x 37.5
cm W x 33 cm H)

Note: For dimensions that include installation with a BioStack,
refer to the BioStack Operator's Manual

Weight For a model equipped with all available modules, excluding the
power supply and dispense module, <55 lbs. (24.95 kg)

Environment Operational temperature, 64° to 104°F (18° to 40°C)

Humidity 10% to 85% relative humidity (non-condensing)

Power Supply 24-volt external power supply compatible with 100–240 V~;
±10%@50–60 Hz

Power Consumption SH1M2 models: 250w
H1 models: 130w

Incubation Maximum incubation temperature 45°C (70°C for models with
70°C support, indicated in the instrument system test report).

Uniformity ±0.5°C at 37°C, tested with Innovative Instruments,
Inc. temperature test plate

Top and bottom incubation controlled via software-adjustable
gradient
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Absorbance Specifications

For the performance specifications described in this section, the gain on optics test
should be <= 8.

Optics

Wavelength Range 230 to 999 nm

Wavelength Bandpass <4 nm (230–285 nm), <8 nm (>285 nm)

Measurement Range 0.000 to 4.000 OD

Resolution 0.001 OD

Increment 1 nm

Wavelength Accuracy ±2 nm

Wavelength Precision 0.2 nm (standard deviation)

Wavelength Repeatability ± 0.2 nm

Performance

Specifications apply from 250–999 nm

Accuracy

Using certified neutral density glass

96-well plate, normal read speed

0–2 OD: ±1% ±0.010 OD, delay after plate movement=100 ms
2–2.5 OD: ±3% ±0.010 OD, delay after plate movement=100 ms

384-well plate, normal read speed

0–2 OD: ±2% ±0.010 OD, delay after plate movement=100 ms
2–2.5 OD: ±5% ±0.010 OD, delay after plate movement=100 ms

96-well and 384-well plate, sweep read speed

0–1 OD: ±1% ±0.010 OD

Linearity

By liquid dilution

96-well plate, normal read speed

0–2 OD: ±1% ±0.010 OD, delay after plate movement=100 ms
2–2.5 OD: ±3% ±0.010 OD, delay after plate movement=100 ms

384-well plate, normal read speed
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0–2 OD: ±2% ±0.010 OD, delay after plate movement=100 ms
2–2.5 OD: ±5% ±0.010 OD, delay after plate movement=100 ms

96-well and 384-well plate, sweep read speed

0–1 OD: ±1% ±0.010 OD

Repeatability

Using certified neutral density glass

Measured by one standard deviation (8 measurements/data point)

96-well and 384-well plate, normal read speed

0–2 OD: ±1% ±0.005 OD, delay after plate movement=100 ms
2–2.5 OD: ±3% ±0.005 OD, delay after plate movement=100 ms

96-well and 384-well plate, sweep read speed

0–1 OD: ±2% ±0.010 OD

Fluorescence Specifications

The Synergy H1 measures fluorescence from the top and bottom with monochromators,
and from the top with filters. The following sets of requirements apply to 96-well plates.

Monochromator-Based Fluorescence

Excitation Range 250–700 nm (with low-noise PMT)
250–900 nm (with red-shifted PMT)

Emission Range 250–700 nm (with low-noise PMT)
300–700 nm for emission scans (up to 900 nm with red-shifted PMT)

Bandpass Fixed: ≤18 nm (Excitation and Emission)

Variable: From 9 nm to 50 nm in 1 nm increments (both excitation
and emission)

Performance

Sodium Fluorescein in phosphate buffered saline (PBS)

DL ≤20 pM, top or bottom read
Excitation 485nm, Emission 528nm

Methylumbelliferone (MUB) in carbonate-bicarbonate buffer (CBB)

DL ≤0.16 ng/mL, top read
Excitation 360 nm, Emission 460 nm

Propidium Iodide (PI) in PBS
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DL ≤62.5 ng/mL, bottom read
Excitation 485 nm, Emission 645 nm

Filter-Based Fluorescence

Fluorescence Intensity

Sodium Fluorescein in phosphate buffered saline (PBS)

DL ≤10 pM, top read
Excitation 485/20 nm, Emission 528/20 nm, 510 nm mirror

Methylumbelliferone (MUB) in carbonate-bicarbonate buffer (CBB)

DL ≤0.16 ng/mL, top read
Excitation 360/40 nm, Emission 460/40 nm, 400 nm mirror

Time-Resolved Fluorescence

Europium

DL ≤ 250 fM, top read
Excitation 360/40 nm, Emission 620/40 nm, 400 nm mirror
Integration Time 20 to 16,000 µs, Delay 0 to 16,000 µs, Granularity 1-µs steps

Fluorescence Polarization

Sodium Fluorescein

5 mP standard deviation at 1 nM sodium fluorescein
Excitation 485/20 nm, Emission 528/20 nm, 510 nm mirror
Excitation range 330–700 nm (UV-transparent polarizing filter)
Emission range 400–700 nm

Luminescence Specifications

≤ 75 amol/well DL ATP in a 96-well plate (low-noise PMT), 30 amol typical

≤ 500 amol/well DL ATP in a 96-well plate (red-shifted PMT)
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Dispense/Read Specifications

Applies only to models equipped with injectors

Plate Type Both injectors dispense to standard height 6-, 12-, 24-, 48-, 96-,
and 384-well microplates

Detection Method Absorbance, Fluorescence (FI, FP, TRF), Luminescence

Volume Range 5–1000 µL with a 5–20 µL tip prime

Accuracy ±1 µL or 2.0%, whichever is greater

Precision ≤2.0% for volumes of 50–200 µL
≤4.0% for volumes of 25–49 µL
≤7.0% for volumes of 10–24 µL
≤10.0% for volumes of 5–9 µL
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Appendix B

Error Codes
This appendix lists and describes Synergy H1 error codes that may
appear in Gen5.
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Overview

When a problem occurs during operation with the Synergy H1, an error code appears in
Gen5. Error codes typically contain four characters, such as “4168,” and in most cases are
accompanied by descriptive text, such as “PMT overload error.” With many errors, the
instrument will beep repeatedly; press the carrier eject button to stop this alarm.

Some problems can be solved easily by the user, such as “2B0A: Priming plate not
detected” (place a priming plate on the carrier). Some problems can be solved only by
trained BioTek service personnel. This appendix lists the most common and easily resolved
error codes that you may encounter.

Error codes beginning with “A” (e.g., A100) indicate conditions that require immediate
attention. If this type of code appears, turn the instrument off and on. If the System Test
does not conclude successfully, record the error code and contact BioTek’s Technical
Assistance Center.

If an error code appears in Gen5, you may want to run a System Test for diagnostic
purposes. In Gen5, select System > Diagnostics > Run System Test.

Contact Info: BioTek Service/TAC

Use this appendix to diagnose problems and solve them if possible. If you need further
assistance, contact BioTek’s Technical Assistance Center.

Phone: 800-242-4685 (toll free in the U.S.) or 802-655-4740 (outside the U.S.)

Fax: 802-654-0638

E-Mail: tac@biotek.com

For errors that are displayed during operation of the Synergy H1 with the BioStack
Microplate Stacker, refer to the BioStack Operator’s Manual.
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Error Codes

This table lists the most common and easily resolved error codes that you may encounter.
If an error code appears in Gen5, look for it here. If you find the code, follow the
suggestions provided for solving the problem. If you cannot find the code or if you are
unable to solve the problem, please contact BioTek’s Technical Assistance Center. The
Gen5 Help system also provides troubleshooting tips.

Code Description and possible remedy

2353 Filter block not found on filter/mirror slider

Verify that the filter block is correctly installed and that it matches
the Gen5 optics library.

2B0x Dispenser syringe 1 or 2 (respectively) did not home

x=1–3

Generally, this error indicates the syringe was not properly
installed. Make sure the syringe’s thumbscrews are properly
threaded. (Refer to Install the Dispense Module starting on page 15
for instructions.) Restart the reader.

2B0A Priming plate not detected

Place the priming plate on the carrier.

2B04 Dispenser syringe 1 or 2 (respectively) failed position
verify

Generally, this error indicates the syringe was not properly
installed. Make sure the syringe’s thumbscrews are properly
threaded. (Refer to Install the Dispense Module starting on page 15
for instructions.) Restart the reader.

37x0/47x0

38x0/48x0

39xy/49xy

Noise Test Errors

Offset Test Errors

Dark Range Errors

x=0, 1; y=0–6

This series of System Test errors may indicate too much light inside
the chamber. Make sure the plate carrier door and the front hinged
door are properly closed. For models with the dispense module, if
the dispense tubes are not connected to the reader, re-install the
light shield that shipped with the instrument (or cover the hole with
black tape). Restart the reader.
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Code Description and possible remedy

4xxx PMT overload well error at <well #xxx>

This error typically means that the fluid in a well has oversaturated
the PMT (i.e., the well is too bright). Try lowering the gain in the
read step.

To identify the well:

Wells are counted starting at A1, moving left-to-right, row-by-row.
The row and column of the well can be extracted from the well
number code by applying the following formula (example uses 8 x
12 geometry, 96-well plate):

1. Convert the ASCII hex string to a decimal equivalent. Ex: “057”
indicates 57 hex, yielding a well code of 87 decimal.

2. Row = (well code) / (columns in plate), rounded up to a whole
number. Ex: 87/12 = 7.25, indicating row 8 (or H).

3. Column = (well code) - ((row-1) * (columns in plate)). Ex: 87 -
((8 - 1) * 12) = column 3.

NOTE: If this code is returned during an area scan, it indicates the
scan point corresponding to the row/column equivalent in the
currently defined scan map, NOT the actual well where the error
occurred.

4Exy Detector saturated (too much light). Relative Fluorescing Units
(RFU) reached (99999).

x=0, 1; y=0–6

This error can indicate one of several scenarios. It is possibly due to
incorrect chemistry, e.g., the fluorescence standards dispensed to
the plate exceed expectations.

Try lowering the gain/sensitivity in your Read step(s).

For models with the dispense module, the internal chamber may
require cleaning (contact BioTek TAC).

If a 4E18 error is detected during monochromator-based
fluorescence, the luminescence probe may be picking up stray
light. Try installing a plug in the filter cube. Restart the reader.
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Code Description and possible remedy

4Fxy Fluorescence signal out of range

x=0, 1; y=0–6

Verify that the Gen5 Fluor/Lum wavelengths table matches the
actual filter installed in the filter cube. Verify that there is no filter
wavelength overlap between the emission/excitation positions.

Verify that the microplate door is fully closing, and the instrument
cover is properly installed and sealed.

Try lowering the Gain in your Read step(s).

The reading chamber may be contaminated by a spill that is
fluorescing; see theMaintenance chapter.

5003/5103 Filter cube did not home

Generally, this error indicates the filter cube is not seated properly
in the reader. Remove it, ensure each filter or plug is properly
positioned and reinstall it securely. Restart the reader.

5403 Filter cube failed positional verify

Generally, this error indicates the filter cube is not seated properly
in the reader. Remove it, ensure each filter or plug is properly
positioned and reinstall it securely. Restart the reader.

55xy <Motor> not homed successfully

xy=axis

This error indicates that an axis failed a previous verify function and
now needs to be homed. Verify that the shipping brackets have
been removed. Check for any obstructions that may prevent the
carrier, syringes, or filter cube from moving normally. Restart the
reader.

Synergy H1 Operator's Manual
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Code Description and possible remedy

570x Axis obstruction error

This error indicates that a moving part is being obstructed. Verify
that:

the tip priming trough, microplate, plate lid, or other object has not
become dislodged in the reading chamber

the Plate Type selection in the Gen5 procedure is correct for the
plate in use, and the Plate Height measurement is correct

the filter cube is correctly installed

nothing is preventing the dispenser syringes from moving

For some plate type and read probe combinations, it might not be
possible to define the entire area scan matrix offered by Gen5 for
some perimeter wells, due to the physical limitations of carrier
travel. Redefine the area scan to include a smaller matrix or select
wells in a different row or column.

5A0x Plate carrier hit obstruction and lost steps

x=0, 1

Verify that the microplate is properly and securely seated in the
carrier, and nothing is obstructing carrier movement inside the
reading chamber.

Verify that the Plate Type defined in the Gen5 Protocol matches the
plate you are using.

This error can also occur if the plate type is correct but the lid was
left on the plate. If you wish to read the plate with a lid on it, create
a new plate type in Gen5 and add the height of the lid to the Plate
Height. Note: Gen5 version 2.01 introduces a separate “Plate Lid
adds” parameter.

5B00 Plate carrier needs to be ejected from the reading chamber

The carrier is inside the read chamber and the probe needs to move
down for the requested operation. Press the carrier eject button.
(This may occur if read was aborted and “home all axis” not
performed.)

This error can also occur if the carrier is inside and the newly-
defined plate height is different from the most-recently specified
plate height. To resolve this error, eject the carrier prior to running
the experiment.
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Appendix C

Instrument Dimensions for Robotic
Interface

This appendix shows the location of the microplate carrier in reference
to the exterior surfaces of the Synergy H1 and the mounting holes on
the bottom. Use the illustrations to facilitate system setup with a robotic
instrument, such as the BioStack Microplate Stacker. Dimensions are in
inches.



Figure C-1: Top view
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Figure C-2: Bottom view

The arrows point to special mounting holes for alignment caps for operation
with the BioStack; note that the model shown is not gas-ready.
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Figure C-3: Left side view

BioStack users: Special alignment hardware is included in the BioStack’s alignment kit
for correct positioning with the Synergy H1. Refer to the Installation chapter in the
BioStack Operator’s Manual for instructions.
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Appendix D

Sample Reports
This appendix contains sample System Test and Absorbance Plate Test
reports for the Synergy H1.



                              Gen5 System Test Report

Reader:                       Synergy H1  (Serial Number: 215EM01)
Basecode:                     P/N 8040200  (v2.18)
Gen5 Version:                 3.11.19
Date and Time:                6/29/2021 2:19:36 PM
User:                         validation
Company:                      
Comments:                     

Test Results

SYSTEM TEST PASS

Operator ID:______________________________________________________________

Notes:____________________________________________________________________

__________________________________________________________________________

                         SYSTEM SELF TEST

8040200  Version 2.18     215EM01    S1   S2
                                    1110 0110
                                    DMF      

Voltage Reference Test     Min    Low   High    Max
   Mono System Flash      1384   1719   2285   3063
   Filter System Flash    2331   2915   3500
   Switched 24V Power     1872

ABSORBANCE

Optics Test         Ref   Meas   Gain  Resets  R/G
   #1:230                        2.17    4    1.843
    Tested                       2.21    4    1.812
      Light       13305  39708
      Dark        10630  10653
      Delta        2675  29055
   #2:280                        2.61    8    3.061
    Tested                       2.56    8    3.123
      Light       12936  39443
      Dark        10634  10658
      Delta        2302  28785
   #3:405                        2.02    8    3.967
    Tested                       2.02    8    3.967
      Light       12818  39811



      Dark        10619  10645
      Delta        2199  29166
   #4:450                        2.13    8    3.748
    Tested                       2.13    8    3.748
      Light       12848  39708
      Dark        10622  10647
      Delta        2226  29061
   #5:490                        1.31    8    6.092
    Tested                       1.32    8    6.061
      Light       12732  39783
      Dark        10600  10628
      Delta        2132  29155
   #6:630                        1.87    8    4.279
    Tested                       1.87    8    4.279
      Light       12641  39804
      Dark        10615  10641
      Delta        2026  29163
Noise Test          Ref   Meas
   Gain 1.00
      Max         10612  10633
      Min         10609  10633
      Delta           3      0
   Gain 1.00
      Max         10610  10634
      Min         10610  10633
      Delta           0      1

FLUORESCENCE/LUMINESCENCE

Monochromator PCB
   Reset offset           1776 counts  
   Bias current offset     1.5 counts   PASS  
   Offset voltage         1737 counts   PASS  
   750V measurement       33.5 counts   PASS  
   750V noise                5 counts  
   750V offset            1738 counts  
   Bias current        0.00001 nA
   1000V current       0.02817 nA
   Reference bias          6.0 counts   PASS  
   Reference offset      10588 counts   PASS  
   Reference noise         0.2 counts   PASS  

Filter PCB
   Reset offset           1782 counts  
   Bias current offset     0.0 counts   PASS  
   Offset voltage         1740 counts   PASS  
   750V measurement       26.9 counts   PASS  
   750V noise               10 counts  
   750V offset            1741 counts  



   Bias current        0.00000 nA
   1000V current       0.02812 nA
   Reference bias         -0.4 counts   PASS  
   Reference offset      10580 counts   PASS  
   Reference noise         0.3 counts   PASS  

Filter Fluorescence
Top Probe                            
   Reference       400V   500V   600V   
      Gain         1.97   1.15   1.00
      Light       11688  11680  12010
      Dark        10596  10583  10580
      Delta        1092   1097   1430

Mono Fluorescence - Optics Test
Top Probe             662V        
   Sensitivity:41   Ref   Meas 
   #1:300
      Light       18064   7983
      Dark        10632   1736
      Delta        7432   6247
      Max          7532   6316
      Min          7355   6207
      StdDev         60     39
   #2:485
      Light       38936  24939
      Dark        10632   1738
      Delta       28304  23201
      Max         28733  23497
      Min         28131  23028
      StdDev        192    152
Bottom Probe          662V        
   Sensitivity:50   Ref   Meas 
   #1:300
      Light       18057   5491
      Dark        10632   1738
      Delta        7425   3753
      Max          7529   3795
      Min          7325   3715
      StdDev         67     26
   #2:485
      Light       38986  27564
      Dark        10632   1735
      Delta       28354  25829
      Max         28620  26048
      Min         28101  25665
      StdDev        180    113

CALIBRATION



Carrier - Top Mono Fluorescence
   Upper Left       x= -104   y= 8640
   Lower Left       x= -100   y= 2428
   Lower Right      x= 9668   y= 2432
   Upper Right      x= 9668   y= 8648
   Delta 1          -104 - -100=   -4
   Delta 2          9668 - 9668=   +0
   Delta 3          8648 - 8640=   +8
   Delta 4          2432 - 2428=   +4

Carrier - Bottom Mono Fluorescence
   Upper Left       x= 1884   y=10492
   Lower Left       x= 1884   y= 4280
   Lower Right      x=11652   y= 4284
   Upper Right      x=11652   y=10500
   Delta 1          1884 - 1884=   +0
   Delta 2         11652 -11652=   +0
   Delta 3         10500 -10492=   +8
   Delta 4          4284 - 4280=   +4

Carrier - Absorbance
   Upper Left       x= 1900   y= 8600
   Lower Left       x= 1900   y= 2392
   Lower Right      x=11668   y= 2396
   Upper Right      x=11668   y= 8608
   Delta 1          1900 - 1900=   +0
   Delta 2         11668 -11668=   +0
   Delta 3          8608 - 8600=   +8
   Delta 4          2396 - 2392=   +4

Carrier - Top Luminescence
   Upper Left       x= -856   y= 6616
   Lower Left       x= -848   y=  400
   Lower Right      x= 8920   y=  408
   Upper Right      x= 8916   y= 6624
   Delta 1          -856 - -848=   -8
   Delta 2          8916 - 8920=   -4
   Delta 3          6624 - 6616=   +8
   Delta 4           408 -  400=   +8

Carrier - Top Filter Fluorescence
   Upper Left       x=-3656   y= 6628
   Lower Left       x=-3656   y=  416
   Lower Right      x= 6116   y=  420
   Upper Right      x= 6116   y= 6636
   Delta 1         -3656 --3656=   +0
   Delta 2          6116 - 6116=   +0
   Delta 3          6636 - 6628=   +8
   Delta 4           420 -  416=   +4



Carrier - Injectors
   Upper Left       x= 2208   y= 6640
   Lower Left       x= 2212   y=  428
   Lower Right      x=11980   y=  432
   Upper Right      x=11980   y= 6648
   Delta 1          2208 - 2212=   -4
   Delta 2         11980 -11980=   +0
   Delta 3          6648 - 6640=   +8
   Delta 4           432 -  428=   +4

Carrier - Test Sensors
   Middle Sensor    x=20656
   Tested             20656
   Delta                 +0

Probe Height          26.19 mm

Filter/Mirror Slider   4452

Mono Probe Changer     3132
   Backlash              52

Excitation Monochromator
   Absorbance          B=-0.00190387  C=+0.25798810
   305LP Edge          +775.88
   Tested              +775.51

Emission Monochromator
   Top Fluorescence    B=-0.00221300  C=+0.74141258
   Bottom Fluorescence B=-0.00189087  C=+0.61020762

INCUBATION

Temperature Setpoint: 37.0     Current Average: 36.9      A/D Test: PASS  

Zone 1: 37.3   Min: 37.3   Max: 37.6     Range: PASS    Thermistor: PASS  
Zone 2: 37.3   Min: 37.2   Max: 37.6     Range: PASS    Thermistor: PASS  
Zone 3: 36.4   Min: 36.2   Max: 36.5     Range: PASS    Thermistor: PASS  
Zone 4: 36.5   Min: 36.2   Max: 36.5     Range: PASS    Thermistor: PASS  

0000

Dispenser 1: 005.0,010.0,020.0,040.0,080.0,200.0
Dispenser 2: 005.0,010.0,020.0,040.0,080.0,200.0
Filter Cube: Blue/Green
   Filter Set 1: Blue   Ex: 360/40  Mirror: Top 400 nm  Em: 460/40
   Filter Set 2: Green  Ex: 485/20  Mirror: Top 510 nm  Em: 528/20
 



Reviewed/Approved By: _______________________________________   Date: 
________________

For Technical Support

In the U.S.:
BioTek Instruments, Inc.
    Tel: 800 242 4685
    Fax: 802 654 0638

In Europe:
    BioTek Instruments GmbH
    Tel: 49(0)7136-9680
    Fax: 49(0)7136-968-111

All Others:
    Tel: 802 655 4740
    Fax: 802 654 0638

email: TAC@biotek.com
Product support center: http://www.biotek.com/service



                              Gen5 System Test Report

Reader:                       Synergy H1  (Serial Number: 207EM02)
Basecode:                     P/N 1910200  (v1.02)
Gen5 Version:                 3.11.19
Date and Time:                5/17/2021 10:00:24 AM
User:                         fsyjamy
Company:                      
Comments:                     

Test Results

SYSTEM TEST PASS

Operator ID:______________________________________________________________

Notes:____________________________________________________________________

__________________________________________________________________________

                         SYSTEM SELF TEST

1910200  Version 1.02     207EM02            S1   S2   S3
                                            0110 0000 0000
                                             MF            70C

Voltage Reference Test     Min    Low   High    Max
   Mono System Flash      1395   1730   2296   3073
   Filter System Flash    2326   2909   3493
   Switched 24V Power     1854

ABSORBANCE

Optics Test         Ref   Meas   Gain  Resets  R/G
   #1:260                        1.97    4    2.030
    Tested                       1.94    4    2.062
      Light       13569  39583
      Dark        10684  10607
      Delta        2885  28976
   #2:280                        2.70    4    1.483
    Tested                       2.67    4    1.499
      Light       13527  39743
      Dark        10729  10638
      Delta        2798  29105
   #3:405                        1.67    4    2.390
    Tested                       1.71    4    2.343
      Light       13314  39946



      Dark        10669  10598
      Delta        2645  29348
   #4:450                        1.56    4    2.562
    Tested                       1.59    4    2.515
      Light       13282  39818
      Dark        10663  10593
      Delta        2619  29225
   #5:490                        2.00    8    3.998
    Tested                       2.03    8    3.936
      Light       13189  39634
      Dark        10606  10580
      Delta        2583  29054
   #6:630                        2.78    8    2.873
    Tested                       2.85    8    2.811
      Light       13174  39813
      Dark        10623  10601
      Delta        2551  29212
Noise Test          Ref   Meas
   Gain 1.00
      Max         10874  10663
      Min         10874  10662
      Delta           0      1
   Gain 1.00
      Max         10876  10664
      Min         10875  10664
      Delta           1      0

FLUORESCENCE/LUMINESCENCE

Monochromator PCB
   Reset offset           1675 counts  
   Bias current offset    -1.4 counts   PASS  
   Offset voltage         1631 counts   PASS  
   750V measurement       41.7 counts   PASS  
   750V noise               10 counts  
   750V offset            1632 counts  
   Bias current       -0.00080 nA
   1000V current       0.02279 nA
   Reference bias          1.8 counts   PASS  
   Reference offset      10572 counts   PASS  
   Reference noise         0.3 counts   PASS  

Filter PCB
   Reset offset           1674 counts  
   Bias current offset    -2.4 counts   PASS  
   Offset voltage         1620 counts   PASS  
   750V measurement       58.1 counts   PASS  
   750V noise               14 counts  
   750V offset            1621 counts  



   Bias current       -0.00149 nA
   1000V current       0.04165 nA
   Reference bias          0.7 counts   PASS  
   Reference offset      10588 counts   PASS  
   Reference noise         0.2 counts   PASS  

Filter Fluorescence
Top Probe                            
   Reference       400V   500V   600V   
      Gain         1.58   1.00   1.00
      Light       11603  11684  12243
      Dark        10603  10588  10588
      Delta        1000   1096   1655

Mono Fluorescence - Optics Test - 662V
Top Probe
   Bandpass            17nm          40nm          
   Sensitivity:34   Ref   Meas    Ref   Meas 
   #1:300
      Light       18639   4271  18813   8121
      Dark        10677   1631  10615   1630
      Delta        7962   2640   8198   6491
      Max          8083   2660   8311   6572
      Min          7872   2618   7998   6349
      StdDev         67     13     96     70
   #2:485
      Light       37303  12110  36083  23087
      Dark        10677   1631  10615   1630
      Delta       26626  10479  25468  21457
      Max         26908  10551  25873  21648
      Min         26337  10356  25130  21282
      StdDev        204     61    264    127
Bottom Probe
   Bandpass            17nm          40nm          
   Sensitivity:41   Ref   Meas    Ref   Meas 
   #1:300
      Light       18581   3355  18876   6170
      Dark        10676   1632  10615   1631
      Delta        7905   1723   8261   4539
      Max          7997   1742   8314   4580
      Min          7841   1701   8195   4457
      StdDev         56     12     37     39
   #2:485
      Light       37250  11288  35994  21853
      Dark        10676   1630  10615   1630
      Delta       26574   9658  25379  20223
      Max         26739   9724  25836  20562
      Min         26372   9604  25031  20032
      StdDev        120     39    246    179



CALIBRATION

Carrier Corners - Top Mono Fluorescence
   Upper Left       x= -128   y= 8676
   Lower Left       x= -124   y= 2472
   Lower Right      x= 9644   y= 2480
   Upper Right      x= 9640   y= 8688
   Delta 1          -128 - -124=   -4
   Delta 2          9640 - 9644=   -4
   Delta 3          8688 - 8676=  +12
   Delta 4          2480 - 2472=   +8

Carrier Corners - Bottom Mono Fluorescence
   Upper Left       x= 1872   y=10576
   Lower Left       x= 1876   y= 4372
   Lower Right      x=11644   y= 4380
   Upper Right      x=11640   y=10588
   Delta 1          1872 - 1876=   -4
   Delta 2         11640 -11644=   -4
   Delta 3         10588 -10576=  +12
   Delta 4          4380 - 4372=   +8

Carrier Corners - Absorbance
   Upper Left       x= 1892   y= 8652
   Lower Left       x= 1896   y= 2444
   Lower Right      x=11660   y= 2452
   Upper Right      x=11656   y= 8660
   Delta 1          1892 - 1896=   -4
   Delta 2         11656 -11660=   -4
   Delta 3          8660 - 8652=   +8
   Delta 4          2452 - 2444=   +8

Carrier Corners - Top Mono Luminescence
   Upper Left       x= -876   y= 6668
   Lower Left       x= -872   y=  464
   Lower Right      x= 8900   y=  476
   Upper Right      x= 8892   y= 6684
   Delta 1          -876 - -872=   -4
   Delta 2          8892 - 8900=   -8
   Delta 3          6684 - 6668=  +16
   Delta 4           476 -  464=  +12

Carrier Corners - Top Filter Fluorescence
   Upper Left       x=-3696   y= 6676
   Lower Left       x=-3692   y=  472
   Lower Right      x= 6080   y=  484
   Upper Right      x= 6076   y= 6688
   Delta 1         -3696 --3692=   -4
   Delta 2          6076 - 6080=   -4



   Delta 3          6688 - 6676=  +12
   Delta 4           484 -  472=  +12

Carrier Corners - Injectors
   Upper Left       x= 2184   y= 6676
   Lower Left       x= 2188   y=  472
   Lower Right      x=11956   y=  480
   Upper Right      x=11952   y= 6688
   Delta 1          2184 - 2188=   -4
   Delta 2         11952 -11956=   -4
   Delta 3          6688 - 6676=  +12
   Delta 4           480 -  472=   +8

Carrier - Test Sensors
   Middle Sensor    x=20652
   Tested             20668
   Delta                +16

Probe Height          26.19 mm

Filter/Mirror Slider   4508

Mono Probe Changer     3212
   Backlash              44

Excitation Monochromator
   Slit Wheel          -916
   305LP Edge          +780.26
   Tested              +781.66
   Absorbance          B=-0.00125598  C=+0.12074328

Emission Monochromator
   Slit Wheel          -1074
   Top Fluorescence    B=-0.00027775  C=+1.00933635
   Bottom Fluorescence B=-0.00013618  C=+0.67990345

INCUBATION

Setpoint: 70.0  Programmed Offset: +0.0  Current Average: 69.9  A/D Test: PASS

Zone 1: 69.8  Min: 69.7  Max: 69.9   Range: PASS  Thermistor: PASS  
Zone 2: 69.8  Min: 69.7  Max: 69.9   Range: PASS  Thermistor: PASS  
Zone 3: 69.8  Min: 69.7  Max: 69.9   Range: PASS  Thermistor: PASS  
Zone 4: 70.0  Min: 69.7  Max: 70.0   Range: PASS  Thermistor: PASS  

0000

Dispenser 1: 005.0,010.0,020.0,040.0,080.0,200.0
Dispenser 2: 005.0,010.0,020.0,040.0,080.0,200.0



Filter Cube: Blue/Green
   Filter Set 1: Blue   Ex: 360/40  Mirror: Top 400 nm  Em: 460/40
   Filter Set 2: Green  Ex: 485/20  Mirror: Top 510 nm  Em: 528/20
 

Reviewed/Approved By: _______________________________________   Date: 
________________

For Technical Support

In the U.S.:
BioTek Instruments, Inc.
    Tel: 800 242 4685
    Fax: 802 654 0638

In Europe:
    BioTek Instruments GmbH
    Tel: 49(0)7136-9680
    Fax: 49(0)7136-968-111

All Others:
    Tel: 802 655 4740
    Fax: 802 654 0638

email: TAC@biotek.com
Product support center: http://www.biotek.com/service



                              Absorbance Test Plate Results

Reader:                       Synergy H1  (Serial Number: 207EM02)
Basecode:                     P/N 1910200  (v1.02)
Date and Time:                5/17/2021 11:18:41 AM
Absorbance Plate:             7 Filter Test Plate (P/N 7260522) - S/N 210508
Last Plate Certification:     September 2020
Next Plate Certification Due: September 2021
User:                         Todd
Comments:                     

Peak Absorbance Results

Well        C6          C6          C6          
Reference   279         362         643         
Tolerance   3           3           3           
Read        280         362         643         
Result      PASS        PASS        PASS        

Alignment Results

Wells       A1          A12         H1          H12         
Read        0.001       0.001       0.001       0.001       
Tolerance   0.015       0.015       0.015       0.015       
Result      PASS        PASS        PASS        PASS        

Wavelength = 450 nm

Accuracy Results

Wells       C1          E2          G3          H6          F5          D4          
Reference   0.137       0.574       1.077       1.639       1.910       2.489       
Min Limit   0.114       0.543       1.035       1.586       1.852       2.369       
Max Limit   0.160       0.605       1.119       1.692       1.968       2.609       
Read 1      0.140       0.577       1.078       1.642       1.915       2.491       
Result      PASS        PASS        PASS        PASS        PASS        PASS        

Repeatability Results

Wells       C1          E2          G3          H6          F5          D4          
Read 1      0.140       0.577       1.078       1.642       1.915       2.491       
Min Limit   0.133       0.566       1.062       1.621       1.891       2.412       
Max Limit   0.146       0.588       1.094       1.663       1.939       2.571       
Read 2      0.139       0.577       1.078       1.641       1.915       2.491       
Result      PASS        PASS        PASS        PASS        PASS        PASS        

Wavelength = 750 nm

Accuracy Results



Wells       C1          E2          G3          H6          F5          D4          
Reference   0.144       0.471       0.878       1.333       1.270       1.652       
Min Limit   0.121       0.442       0.840       1.286       1.225       1.599       
Max Limit   0.167       0.500       0.916       1.380       1.315       1.705       
Read 1      0.146       0.472       0.877       1.332       1.270       1.651       
Result      PASS        PASS        PASS        PASS        PASS        PASS        

Repeatability Results

Wells       C1          E2          G3          H6          F5          D4          
Read 1      0.146       0.472       0.877       1.332       1.270       1.651       
Min Limit   0.140       0.462       0.864       1.314       1.252       1.629       
Max Limit   0.153       0.482       0.891       1.350       1.287       1.672       
Read 2      0.146       0.472       0.877       1.332       1.270       1.650       
Result      PASS        PASS        PASS        PASS        PASS        PASS        
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